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1 Introduction 
1.1 About This Guide and Related Documentation 

This document is intended for MOTOTRBO radio network administrators as well as 
dispatchers responsible for the TRBOnet dispatch console operations. It provides 
guidance on the installation, configuration, and maintenance of the TRBOnet Server 
and Dispatch Console applications. 

1.2 About TRBOnet 
TRBOnet is a suite of professional applications for MOTOTRBO digital two-way radio 
networks. TRBOnet manages voice and data communication paths across network 
endpoints. It provides a unified graphical dispatcher workbench interface for the 
entire range of workforce fleet management tasks. 

1.3 Contacts 

Region Phone Email & Support 

EMEA +44 203 608 0598 
info@trbonet.com — general and 
commercial inquiries 

support@trbonet.com — technical 
support 

http://kb.trbonet.com — online 
knowledge base  

Americas +1 872 222 8726 

APAC +61 28 607 8325 

 
 

mailto:info@trbonet.com
mailto:support@trbonet.com
http://kb.trbonet.com/
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2 Hardware and Software Requirements 
TRBOnet Server/Agent with IP connection only 

Voice Channels 4 8 16 24 24+ 

CPU Intel Core i3 Intel Core i5 Intel Core i7, 4 Cores Intel Core i7, 6 
Cores 

Contact 
technical 
support 

Memory 2 GB 4 GB 4 GB 8 GB 

HDD 300 MB for installation files, +1 MB per 1 minute of voice recording 

Sound Card No 

Supported OS 

Windows 7/8.x/10, Windows Server 2008/2012/2016 

Note: Windows Server 2008/2012/2016 requires Desktop Experience 
Role/Feature installed. 

Software .NET Framework 4.6.x, MS SQL Server 2008 R2 or higher 
 

TRBOnet Server /Agent with Control Stations 

Control Stations 1 2+ 

CPU Intel Core i5 

Memory 2 GB 

HDD 300 MB for installation files, +1 MB per 1 minute of voice recording 

Sound Card Integrated sound card can be used. 

Multi-channel Sound Card required; 
Recommended: 
1. M-Audio Delta 1010 LT 
2. Roland OCTA CAPTURE Hi-SPEED USB 
Audio Capture 

Additional Devices Cable connector Motorola PMKN4016 

Supported OS Windows 7/8.x/10 

Software .NET Framework 4.6.x, MS SQL Server 2008 R2 or higher 
 

Dispatch Console 

CPU Intel Core i3 

Memory 4 GB 

HDD 70 MB for installation files 

Sound Card Yes 

Display 1280x1024 minimum resolution, 1600x900 recommended resolution 

Additional Devices Speakers and microphone, or headset; Imtradex devices are recommended 

Supported OS Windows 7/8.x/10 

Software .NET Framework 4.6.x 

http://www.m-audio.com/products/en_us/Delta1010LT.html
http://www.rolandus.com/products/details/1127
http://www.rolandus.com/products/details/1127
http://trbonet.com/pdf_files/TRBOnet_Cable_Connector_v2.zip
http://www.imtradex.com/en/Products/Dispatch-places-911/


System Architecture Overview 

3 

3 System Architecture Overview 
3.1 TRBOnet Server and Console 

The TRBOnet software is designed as a client-server architecture, 
where TRBOnet Server is PC-based and runs as a Windows service on a network 
computer, stores data in an MS SQL database, and allows client connections from 
Web Consoles, Dispatch Consoles, and Mobile Clients. The TRBOnet service can be 
located on a dedicated remote PC, a local PC (along with the Dispatch Console), or 
on a virtual machine. 
In addition, remote software agents, such as TRBOnet Agent, and/or hardware 
agents, such as TRBOnet Swift A200, can be connected to TRBOnet Server providing 
additional voice and data communications paths to and from remote sites. Such 
configurations can be used when radio equipment can't be connected directly to 
TRBOnet Server due to IP network limitations (see section 3.3, IP Backend Network 
Requirements). 
TRBOnet Dispatch Console is a PC-based voice dispatch and data application for 
MOTOTRBO™ professional digital two-way radio systems. 

TRBOnet
Dispatch Console

TRBOnet
Web Console

Local 
Radio Infrastructure

WAN/LAN

Remote
Radio Infrastructure

TRBOnet Server

TRBOnet Agent
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3.2 MOTOTRBO Radio Systems 
3.2.1 Single Site conventional system 

A Single Site conventional system is a digital conventional two-way MOTOTRBO 
system that includes one digital repeater and allows you to transmit voice and data 
via two conventional channels. Radio groups and radio units are assigned to these 
conventional radio channels. 

3.2.2 IP Site Connect 
An IP Site Connect (IPSC) system is a digital conventional two-way MOTOTRBO 
system that provides two wide-area channels to increase your communications RF 
coverage area. It is possible to connect up to 15 repeaters (each geographical 
location of a repeater is called a "site") into one system using an IP connection, 
which allows increasing the coverage area for voice and data transmissions. The 
main objective of an IPSC system is to provide a stable connection between the 
radio units and control centers regardless of the distance. 

Dispatcher 1 Dispatcher 2 Dispatcher 3

LAN/WAN

Site 1 Site 2 Site 3

Master Repeater 1 Peer Repeater 2 Peer Repeater 3

TRBOnet
Server
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3.2.3 Capacity Plus 
Capacity Plus (also known as Capacity Plus Single Site) is a digital trunked two-way 
MOTOTRBO system that is designed for high volume communications at a single 
site location. The system is designed to provide communications among a large 
number of users within a building, a set of buildings, or a single geographical region. 
This system type allows you to effortlessly increase the number of channels for both 
voice and data transmission between the radio units and control centers. As this 
system type is trunked instead of standard conventional, radio units are always 
automatically forwarded to a free channel rather than being programmed to remain 
on a single slot, thereby utilizing/sharing the available unused/free RF resources 
(channels) among different users. The main objective of Capacity Plus is to support 
more simultaneous voice and data transmissions within one capacious system. 

Dispatcher 1

Dispatcher 2

Dispatcher 3

LAN/WAN

Talk Group 2

Talk Group 1

TRBOnet
Server

Voice Repeater 2 

Master Voice Repeater 1 

Voice Repeater 3 

Data Repeater 4 

Data Repeater 5 
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3.2.4 Linked Capacity Plus (LCP) 
Linked Capacity Plus (also known as Capacity Plus Multi Site) is a digital trunked 
multisite two-way MOTOTRBO system that enables you to accommodate both high 
volume and wide area communications. This system design allows you to connect 
via IP up to 15 Linked Capacity Plus sites located in one geographical region (for 
example, City of Charlotte) or in larger geographically separated territories (for 
example, covering the Florida Keys from Miami to Key West). This system type allows 
you to increase the RF coverage area and the number of channels for voice and data 
transmission between the radio units and control centers. The main objective of 
Linked Capacity Plus is to support more simultaneous voice and data transmissions 
regardless of the distance. 

TRBOnet
Server

Dispatcher 1

Dispatcher 2

Dispatcher 3

LAN/WAN

Site 1

Voice Repeater 1 Voice Repeater 2 Data Repeater 3 Data Repeater 4

Router + Switch

Router + Switch

Site 2

Voice Repeater 5 Voice Repeater 6 Data Repeater 7 Data Repeater 8

Router + Switch

Control 
Station 1

Control 
Station 2

Control 
Station N  
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3.2.5 Connect Plus 
Connect Plus is a digital trunked multisite two-way MOTOTRBO system that enables 
you to accommodate high volume, wide area communication that’s required for 
your business allowing you to connect via IP multiple sites located in one 
geographical region or in larger geographically separated territories. This system 
type allows you to increase the RF coverage area and the number of channels for 
voice and data transmission between the radio units and control centers. Radio units 
are always automatically forwarded to the control channel. The main objective of 
Connect Plus is to support more simultaneous voice and data transmissions 
regardless of the distance as well as to provide a more structural addressing of the 
transmissions provided by XRC controller and XRT gateway. 

Dispatcher 2

Dispatcher 3

TRBOnet
Server*

Talk Group 1

Talk Group 2

Talk Group 3

Talk Group 4

* TRBOnet Server requires connections to only one XRT 9000 Controller and one XRC 9000 Controller in the system

LAN/WAN

XRC 9000 XRC 9000

Voice Repeater 1

XRT 9000
Router 1

Data Repeater 2

Voice Repeater 3

Data Repeater 4

Router 2

Dispatcher 1
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3.2.6 Capacity Max 
Capacity Max is MOTOTRBO's next-generation trunking solution. Built on the DMR 
Tier III Mode of Operation, it delivers smooth scalability, low cost of ownership and 
reliable operation. 

 

3.3 IP Backend Network Requirements 
Before planning any IP connected MOTOTRBO system, read System Planner (chapter 
4.6.3.2 Characteristics of Backend Network). 

• Delay/Latency 
The amount of time it takes for voice to leave the source repeater and arrive at 
the destination repeater. The delay should be less than 60 ms. It can be up to 
90 ms, but requires changes in CPS for both radio units and repeaters. 

• Jitter 
The variation of the packet inter-arrival time. It should be less than 60 ms. 

• Packet Loss 
In the case of voice, the ongoing call ends if six consecutive packets do not 
arrive within 60 ms of their expected arrival time. In the case of data, the 
repeater waits for the expected number of packets (as per the data header) 
before ending the call. 

• Bandwidth 
Refer to System Planner for bandwidth calculations, but roughly, it requires 96 
kbps for each repeater connection and should be summed up for all repeaters. 

If the IP backend network does not satisfy MOTOTRBO requirements, it will degrade 
audio quality significantly, including dropped voice calls. 
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3.3.1 Linked Capacity Plus Specific Requirements 
• Addresses and Ports 

A static IP Address and UDP Port for the master repeater must be made 
available to all peer devices on the Linked Capacity Plus system. 
 When a peer device registers with the master repeater, the network supplies 

the return IP address and UDP port of the peer device to the master 
repeater. The IP address and UDP port must then be made available to all 
other MOTOTRBO™ LCP devices on the system. 
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4 TRBOnet PLUS and Dependencies Installation 
4.1 Preparing and Updating the Base OS 

TRBOnet runs on Windows 7/8/10. In the case of Windows 7, make sure that the 
latest Service Pack is installed. 
For the TRBOnet PLUS Compatibility Table, see 
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=73 

4.2 Installing Microsoft SQL Server 
Download and install Microsoft SQL Server 2008 R2 or higher. 
You can download and install either a full-featured MS SQL Server or an Express 
edition of MS SQL Server. The Express edition of MS SQL Server is free, however, it 
has some technical restrictions (maximum database size of 10 GB, RAM usage, and 
other restrictions). 
For example, Microsoft SQL Server 2008 R2 SP2 - Express Edition (which is free) is 
available at: 
http://www.microsoft.com/en-us/download/details.aspx?id=30438 

Note: We recommend that you download a version of SQL Server with 
Tools. 

Select the 32-bit or 64-bit version depending on the underlying OS. Accept the 
defaults for the setup. 
See also section 5.2.1.1, Windows Authentication on page 16. 

4.3 Installing .NET Components 
Windows 8 and later, as well as Windows Server 2012 and later, include the required 
.NET 4.6 components as part of the operating system. 
The .NET Framework redistributables are available from Microsoft at: 
https://www.microsoft.com/en-us/download/search.aspx?q=.net%20framework 

4.4 Installing TRBOnet PLUS 
• Contact Neocom Software to obtain the latest installation package of the 

TRBOnet PLUS software, unzip, and run the setup file as a local administrator. 
• When the TRBOnet PLUS Setup wizard appears, click Next. 
• On the End User License Agreement page, accept the terms of the license, 

and then click Next. 

http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=73
http://www.microsoft.com/en-us/download/details.aspx?id=30438
https://www.microsoft.com/en-us/download/search.aspx?q=.net%20framework
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• On the Choose Setup Type page, click one of the following options: 
 TRBOnet Dispatch Console 

Choose this option to install only TRBOnet Dispatch Console on your 
computer. 

 TRBOnet Server and Dispatch Console 
Choose this option to install both TRBOnet Server and 
TRBOnet Dispatch Console at once on your computer. 

 Custom 
Choose this option to select from the list one or more components to be 
installed. 

 

For example, you may install only TRBOnet Server Instance: 
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• Accept the defaults for the rest of the setup and complete the installation. 
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5 TRBOnet Server 
To start TRBOnet Server, click the corresponding shortcut on the desktop, 
or click Start > All Programs > Neocom Software > TRBOnet Server x.x 

5.1 License Information 
The TRBOnet software requires a valid license in order to operate. Depending on the 
License Type (see next section), the license can be obtained via TRBOnet's website or 
from a Neocom representative. 

5.1.1 License Types 
There are three license types available for TRBOnet PLUS: 

License 
Type Demo Trial Commercial 

Validity 60 days By Request Permanent (non-expiring) 

Quantity of 
Control 
Stations and 
Radio Units 

Up to 2 control stations 
or 1 IP repeater 
connection 

10 Radio Units 

By Request According to Customer order 

Features Limited functionality By Request According to Customer order 

How to 
obtain 

It can be downloaded 
from the web page. 

Assigned to server’s 
Hardware ID. 

For more details on 
Hardware ID, see 
the article at 
http://kb.trbonet.com/
public.pl?Action=Public
FAQZoom;ItemID=31.  

Assigned to server’s Hardware ID. 

Assigned to the serial numbers of 
master repeaters and control 
stations. To retrieve serial 
numbers, use Control Station's 
codeplug (do not rely on a serial 
number printed on the device’s 
label). 

For more information on the license and renewals, contact our technical support at info@trbonet.com 

To see how the Hardware ID and control stations and/or repeaters are assigned in 
your license, open the INFO file delivered with the license file (for example, in 
Notepad): 

http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=31
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=31
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=31
mailto:info@trbonet.com
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1. Your license is assigned to the Hardware ID. 
2. Your license is assigned to the serial numbers of master repeaters and control 

stations. 

5.1.2 Moving TRBOnet Server to a Different Server PC 
If there is a need to use TRBOnet Server on a different server PC, please contact your 
Neocom sales representative for further instructions. 

5.1.3 Using Spare Repeaters 
If the plan is to use spare repeaters, for example, as replacement for damaged ones, 
communicate the total number of repeaters when ordering a license. 
For example, 3 repeaters will be actively used with TRBOnet Server and 1 spare 
repeater. Communicate the following repeaters limitation: 3 active 1 spare and 
provide the serial numbers of all 4 repeaters when placing an order (also include the 
spare repeater’s serial number). 

5.1.4 License Manager 
• In the Configuration pane on the left, select License. 

In the right pane, you can see the text of your current license. 
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To apply the new license: 

1. Click the License Manager link in the right pane. 
The License Manager wizard appears. 

2. Click Next. 
3. Click the ellipsis (…) button on the right-hand side of the License file box. 

The Open dialog box appears. 
4. Locate the license file you received from our technical support and click Open. 

The full path of the license file appears in the License file box. 
5. Click Next. 
6. Click Finish to close the wizard. 
7. Click Apply and then confirm to restart TRBOnet Server. 

Note: To use a single license for multiple TRBOnet software 
instances, you need TRBOnet License Server. For detailed 
instructions on how to use TRBOnet License Server, refer to 
TRBOnet License Server Configuration Guide. 

5.2 TRBOnet Server Database 
• In the Configuration pane, select Database. 

 

• In the Database pane, specify the following database-related settings: 
 SQL Server 

Enter the location of the Microsoft SQL Server name and instance. For 
example, in the screenshot above, the default instance name of Microsoft 
SQL Server Express installed on the local computer is shown. 

 Database 
Enter the name of the TRBOnet database. 

 Authentication 
Select the authentication method for the TRBOnet database. The default 
method is Windows Authentication. See also section 5.2.1, Database 
Authentication Methods (page 16). 
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 Login and Password 
Enter a valid SQL Server login and password if the SQL Server 
Authentication is selected for the database. 

 Specify the path for database archives 
Select this option, and in the corresponding Path box enter the full path of 
the custom folder for database backups. Or, click the ellipsis (…) button and 
in the 'Browse For Folder' dialog box locate the appropriate path. 

 Use custom folder for audio files 
Select this option, and in the corresponding Path box enter the full path of 
the custom folder for audio recordings of the voice calls/sessions. Or, click 
the ellipsis (…) button. 

 

• In the 'Path to Audio Files' dialog box, select the Root Folder, and in the 
File Path Template box enter the information (by clicking the 
appropriate links below: Year, Month, Day, etc.) that will be used to 
generate the file/path name. 

Note: If you don't specify folder paths for the database archives 
and audio files, TRBOnet Server will use the following 
default paths: 
%ProgramData%\Neocom Software\TRBOnet PLUS\Backups - for 
database archives. 
%ProgramData%\Neocom Software\TRBOnet PLUS\Audio - for 
audio. 

• When you finish configuring the required database parameters, click 
Create Database. 

• After you create or upgrade a database, click Apply and then confirm to 
restart TRBOnet Server. 

5.2.1 Database Authentication Methods 
5.2.1.1 Windows Authentication 

• From the Authentication drop-down list, select Windows. 
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To provide access permissions for TRBOnet Server to connect to MS SQL Server, 
create an account with sysadmin privileges. 
During the installation process, MS SQL Server 2008 automatically grants sysadmin 
privileges to the NT Authority\SYSTEM account. 
In the case of MS SQL Server 2012 and higher versions, add the 
NT Authority\SYSTEM account to the Administrators group during the installation 
process. If the database owner privileges are required to work with TRBOnet 
Database, you need to assign the sysadmin role to the Local System account. For 
instructions on how to install and configure MS SQL Server 2012, see 
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=72 

5.2.1.2 SQL Server Authentication 
• From the Authentication drop-down list, select SQL Server. 

 

To connect to SQL Server using SQL Server Authentication, create an SQL login 
with sysadmin privileges in the SQL Server in use. For detailed instructions on how 
to create an SQL login, see 
http://technet.microsoft.com/en-us/library/aa337562.aspx 

http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=72
http://technet.microsoft.com/en-us/library/aa337562.aspx
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5.3 TRBOnet Server Service 
• In the Configuration pane, select Service. 

 

• In the Service pane, specify the following service-related parameters: 
 Choose the required logon type: 

Logon as Local System 
Choose this option to use an account with local system administrator 
privileges to run the service as a Windows service (Recommended); 
Logon as User 
Choose this option to use a different account to run the service as a 
Windows service. This account must allow the user to run services in 
Windows, have read and write access to the Neocom Software folder and 
subfolders in the "%ProgramFiles%" (or, "%ProgramFiles(x86)%" for 64-
bit OS) and "%ProgramData%" folders. For example, using such an 
account may be required in the following cases: 
1. An Active Directory domain network is used, and the current Windows 

user is not allowed to use a Local System account to launch services on 
the local PC due to domain policy restrictions. 

2. MS SQL Server is installed on a remote PC, and Windows 
Authentication (see section 5.2.1.1, page 16) has been selected to 
connect to the database. 

 Click Install Service. 
 Click the Start Service link that appears in the right pane. 

5.4 Network Parameters 
• In the Configuration pane, select Network. 
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• In the Network pane, specify the following network-related parameters: 
 Network interface 

From the drop-down list, select the network interface that will be used to 
communicate between the Server and Dispatch Consoles. Click  to 
refresh the list of network interfaces available on your PC. 

Note: If both TRBOnet Server and Dispatch Console are installed 
on the same PC, then select 127.0.0.1 (Loopback 
Pseudo-Interface). 

 Command port 
Enter the port number to be used by a Dispatch Console to connect to the 
Server (4021, by default). 

 First VoIP port 
Enter the number of the first VoIP port for audio communications between 
the Server and Dispatch Consoles (4022, by default). Each additional 
Dispatch Console will establish a connection on the next available port 
number. 

 VoIP protocol 
From the drop-down list, select the VoIP protocol type for communications 
between the Server and Dispatch Consoles: 
• All - UDP will be used first; if unavailable, TCP will be used; 
• TCP - slower but more reliable (set by default); 
• UDP - faster but data packets can be lost; some routers may drop 

UDP packets. 
 Data protocol 

From the drop-down list, select the protocol to exchange data other than 
voice between the Server and Dispatch Consoles (TCP, by default). 
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 Use broadcast mode for audio 
Selecting this option will help to optimize network load and minimize 
transmission delays. The "load" on the network will be reduced as the 
Server will utilize a single audio transmission to a group of Dispatch 
Consoles instead of sending multiple audio streams to each individual 
Dispatch Console. This method of transmission will also minimize the 
transmission delays if there's a large number of Dispatch Consoles or the 
Server is busy processing other features. 

Note: When the broadcast mode is set, a Dispatch Console 
cannot run on the same machine as TRBOnet Server, and a 
warning message will appear when you select this option. 

• Broadcast port 
Enter the port number to be used to broadcast audio (5000, by default). 

 Use proxy server 
Select this option to enable an alternative proxy server for TRBOnet 
Dispatch Software to access Internet. 
• Click the Configure link to specify the alternative server settings: 

 

• Use an alternative server 
Select this option to enable an alternative proxy server. 
 Address 

Enter the proxy server IP address. 
 Port 

Enter the proxy server port number. 
• Use authentication 

Select this option to use authentication to connect to the alternative 
proxy server. 
 Login 

Enter the login for the authentication, if needed. 
 Password 

Enter the password for the authentication, if needed. 
• After you configure the proxy server settings, click OK. 
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 Encrypt data over network 
Select this option to guarantee the security of data transfer between 
TRBOnet Server and Dispatch Console, and/or TRBOnet Agent. It is 
recommended that this option be used when a connection between system 
components is established via the Internet or other public networks. 

5.5 Reports 
• In the Configuration pane, select Reports. 

 

• In the Reports pane, select the Save scheduled reports check box and specify 
the following parameters: 
 Path 

Click the ellipsis (…) button and locate the folder on the PC where you wish 
to save reports generated by the TRBOnet software. 

 Format 
From the drop-down list, select the format for the reports (PDF or Excel). 

5.6 Backup Configuration 
TRBOnet Server supports a redundant (secondary/backup) configuration which 
allows automatic switching from the primary to the redundant (secondary/backup) 
server in case of failure of the primary server. Dispatch Console operation will not be 
interrupted. 

• In the Configuration pane, select Redundancy. 
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• In the Redundancy pane, select the Redundant server mode option. 
• Redundancy Mode 

Select a mode for the backup server from the drop-down list. 
For details, see sections Error! Reference source not found. and Error! 
Reference source not found. on page Error! Bookmark not defined.. 

• To add a main server, click Add. 

 

• IP Address 
Type the IP address of the main server. 

• Port 
Enter the same port number as specified for the Command port. 

5.7 Service Management 
The Service Management pane allows you to specify various parameters for the 
Check Radio, Location, Telemetry, TMS, and Indoor services. 

• In the Configuration pane, select Service Management. 
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• In the Service Management pane, specify the following service-related 
parameters: 

5.7.1 Automatic "Check Radio" Service 
The Automatic "Check Radio" service group includes the following registration-
related parameters: 

• Auto request presence timeout 
Enter the time interval that will be used by the server to regularly check a radio 
unit if there has been no activity. A radio is considered inactive (or, offline) if it 
does not send any GPS, Text, ARS, or Voice messages. If you do not have a 
dedicated channel for data revert, use the following table: 

Number of 
radio units 

Presence timeout 
(minutes) 

Number of 
radio units 

Presence timeout 
(minutes) 

up to 10 5 30 to 40 17 

10 to 20 9 40 to 50 21 

20 to 30 13 over 50 120 

• ARS refresh timeout 
Enter the value of the parameter that determines how often a radio unit will 
send ARS packets. It is recommended that a value of 30 minutes be used for 
this interval. This value may be changed depending on the system load. 

• Ignore unregistered Radios 
Select this option so that unregistered radio units will be ignored and thus 
won't appear in Dispatch Console. 
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5.7.2 Location Service 
The Location Service group includes the following location-related parameters: 

• Dispatch Console update interval 
Enter the time interval that will be used to send GPS data packages from the 
Server to Dispatch Consoles. The lower the value, the more data traffic will be 
present on the network. Adjust this value based on the network bandwidth. 
The lower the bandwidth, the higher the update interval. 

• Automatic error correction 
Select this option to enable automatic error correction to detect and correct 
invalid GPS data. 
Click the Configure link to specify the GPS parameters to be corrected: 

 

Discard GPS data if 

 Speed greater than 
Select this option and enter the maximum possible speed of your vehicles. 
As a result, the coordinates with speeds that exceed the maximum limit will 
be discarded. 

 Location accuracy worse than 
Select this option and enter the largest distance for the accuracy of the GPS 
receiver. As a result, the coordinates with distances that exceed the 
maximum limit will be discarded. 

 GPS time error greater than 
Select this option and enter the largest allowable time error, in minutes. As 
a result, the coordinates with time errors that exceed the maximum limit will 
be discarded. 

 Coordinates have duplicates 
Select this option to remove duplicate coordinates from the GPS data. 

 Consider speed zero if less than 
Select this option and enter the low-speed threshold. Speeds below this 
threshold will be considered as zero by the server. 

• Send the latest GPS data to dispatchers on alert 
Select this option so that dispatchers receive the latest GPS data when an alert 
occurs. Then choose one of the following options: 
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 For the last X minutes 
Choose this option and enter the time, in minutes, to be used as the last 
time period for the latest GPS data. 

 GPS points 
Choose this option and enter the number of GPS points to be used for the 
latest GPS data. 

5.7.3 Telemetry Service 
The Telemetry Service group includes the following telemetry-related parameters: 

• Request for the status of GPIO when a radio unit is powered on 
Select this option to enable the server to request the status of a radio unit's 
telemetry information when the radio is powered on. 

5.7.4 Text Messaging Service 
The Text Messaging Service group includes the following message-related settings: 

• Text Message format 
From the drop-down list, select one of the pre-defined formats for text 
messages, or select the Custom format. 

• Custom Format 
Enter your own format for text messages in this box if you have selected 
'Custom' from the list above. The Custom Format will default to 
{Sender} | {Text}. There are four choices: {Sender}, {Text}, {Date}, and {Time}. 
Another example would be: {Date} | {Time} | {Text}. 

• Max. message length 
Enter the maximum number of characters that TRBOnet will send per text 
message. The recipient of the text message may not be able to receive the 
maximum number of characters due to its design limitations. Therefore, it may 
only display a partial text message. 

• Split long message into multiple messages 
Select this option to allow single messages to be split into multiple messages 
based on the Max. message length setting. 

5.7.5 Indoor Service 
The Indoor Service group includes the following indoor-related parameters: 

• Remove offline radio from beacon 
Select this option so that an offline radio is not shown on its associated 
beacon. 

• Ignore beacon position on alarm if GPS is fixed (only K-TERM) 
Select this option so that beacon positioning is ignored in case of alarm when 
a radio transmits valid GPS data. 

Note: This feature relates only to K-TERM beacons. 

5.8 Advanced Settings 
• In the Configuration pane, select Advanced Settings. 
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• In the Advanced Settings pane, specify the following advanced parameters: 
 Language 

From the drop-down list, select the interface language for TRBOnet Server. 
 Logging level 

From the drop-down list, select the logging level that determines the 
granularity of log messages in the System Log. The choices are: None, Low, 
Normal, and High. 

Note: This information is used by technical support for 
troubleshooting purposes, so it is recommended that this 
value be kept unchanged (Normal). 

 Administrator Account 
From the drop-down list, select either Enabled or Disabled. If you select 
Disabled, the administrator won't be able to log in to the Dispatch Console. 
• Reset password 

Click this link to reset the administrator password to the default value. 
 Audio Recording format 

From the drop-down list, select the format to be used to store audio 
recordings. The available formats are WAV and TNA. 

Note: The TNA format is a proprietary audio format that contains 
additional information about radio calls, such as radio ID, 
start time, end time, and other parameters. This format 
provides more details about call participants and allows 
easy navigation within recorded audio files. 

 Audio Recording codec 
From the drop-down list, select the audio codec to be used to compress the 
audio files. 

 Measurement system 
From the drop-down list, select either Metric or US units. 
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 Latitude/Longitude format 
From the drop-down list, select the format of Latitude/Longitude pairs. 

 TX Passive timeout 
Enter the time that text and voice messages will be stored and later sent 
when the channel becomes available (no longer busy). "Unlimited" is 
recommended. 

 Voice Mail timeout 
Enter the time duration where TRBOnet Server will continue to try to send 
Voice Mail messages to a recipient. "Unlimited" is recommended. 

 Text Message Passive timeout 
Enter the time duration where the TRBOnet Server will continue to try to 
send Text messages to a recipient. "Unlimited" is recommended. 

5.8.1 Geocoding Servers 
Geocoding servers resolve GPS coordinates to street addresses for reporting 
purposes and other needs, for example, 'GPS activity for period' reports. Online 
geocoding services, such as Google or Nominatim, can be used and are the standard 
default services in TRBOnet. However, their use may be limited by the number of 
requests. Furthermore, you can add custom geocoding servers to the system. 
You can configure geocoding servers in three ways depending on whether the 
Server and/or Dispatch Console have Internet access and on your local geocoding 
server settings: 

1. The Dispatch Console has Internet access and the Server has no Internet 
access. The Server can connect to preconfigured (Google and Nominatim) 
and/or local corporate geocoding servers via the Dispatch Console. 

2. The Server has Internet access and Dispatch Console has no Internet access. 
The Dispatch Console can connect to preconfigured (Google and Nominatim) 
and/or local corporate geocoding servers via the Server (follow the 
instructions below). 

3. You have your own Geocoding server in the local network. In this case, you 
can configure data resolving in both the Server and the Dispatch Console. 

5.8.1.1 Configuring Geocoding Servers 
• In the Configuration pane, select Geocoding Servers. 
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• In the Geocoding Servers pane, specify the following geocoding-related 
parameters: 
 Use MapPoint location resolving 

Select this option to get street addresses from MapPoint, and enter the 
MapPoint Application ID. MapPoint is a service from Microsoft that is 
used to transform coordinates into street addresses. 

 Google and Nominatim 
These are pre-configured geocoding servers, which allow resolving GPS 
coordinates to street addresses and street addresses to GPS coordinates. 

Note: These geocoding servers can't be deleted from the system. 

 Click Add to add a geocoding server to the system. 

 

• Server Name 
Enter the name of your geocoding server. 

• Get address by coordinates 
Select this option to resolve GPS coordinates to street addresses. 
In the box below, enter the server address with the appropriate 
parameters. 
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Note: Keep in mind that the {lat} and {lon} variables are 
mandatory to allow TRBOnet Dispatch Console to retrieve 
GPS coordinates from the radio unit. 

Click Test to check the connection to the geocoding server. Enter a pair 
of GPS coordinates and see if the resolved street address appears. 

• Get coordinates by address 
Select this option to resolve street addresses to GPS coordinates (for 
example, for the Search by Address feature). 
In the box below, enter the server address with the appropriate 
parameters. 

Note: Keep in mind that the {address} variable is mandatory to 
allow TRBOnet Dispatch Console to search map objects by 
address. 

Click Test to check the connection to the geocoding server. Enter an 
address and see if you get the list of map objects corresponding to the 
address entered. 

 Use the Up ( ) and Down ( ) buttons to move the selected geocoding 
server up and down in the priority list of geocoding servers. When 
requesting GPS data via the geocoding servers configured in TRBOnet 
Server, GPS data is requested from the geocoding servers according to the 
priority level. The geocoding server at the top of the list has the highest 
priority level. In case the first geocoding server is unavailable, data will be 
requested from the second geocoding server in the list, and so forth down 
the list of geocoding servers. 
The administrator must ensure that the geocoding servers in the list are 
able to resolve GPS data. 

 Request a place name upon receiving GPS coordinates 
Select this option to resolve GPS coordinates to street addresses 
immediately by a GPS event. Note that street addresses and GPS 
coordinates are automatically (without user intervention) stored in the 
TRBOnet database to optimize the response time for street address 
requests (for example, GPS reports) and to reduce geocoding server load. 
These street addresses and GPS coordinates will be stored without user 
intervention whenever GPS are resolved to street addresses via a request to 
a Geocoding Server. 

5.9 Radio Networks 
By enabling the Radio Networks feature, the TRBOnet Server is able to be connected 
to a radio system. Otherwise, you should use Remote agents. 

• In the Configuration pane, select Radio Networks. 
• In the Radio Networks pane, select Enable Radio Networks. 

Or, in the Configuration pane, right-click Radio Networks and choose Use 
Radio Networks. 
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• In the Configuration pane, you can select TRBOnet Cloud. 

Note: TRBOnet Cloud is a customizable feature. Please contact 
your regional Business/Sales Managers for further details. 

• In the Configuration pane, select Digital Systems. 
• In the Digital Systems pane, select or make sure Enable Digital Systems is 

selected. 

 

• In the Digital Systems pane, specify the following parameters: 
 CAI Network 

The CAI (Common Air Interface) Network is a value that is combined with 
the Radio ID to produce the individual radio's air interface network IP 
address. All radios must use the same CAI Network ID to be able to 
exchange data. It is recommended that the default value of 12 is used. 
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 CAI Group Network 
The CAI Group Network is a value that is combined with the Group ID to 
produce the group's air interface network IP address. The CAI Group 
Network ID forms the first or most significant byte of each group's network 
IP address. All radios must use the same CAI Group Network ID to be able 
to exchange data (225, by default). 

Note: The values of these two parameters must match those 
configured for the radio units via the MOTOTRBO CPS. 

5.9.1 Digital System Elements 

 

All radio system elements based on MOTOTRBO services are represented in the 
Registered Digital Systems table, including their type (Control Station, Repeater, 
and others), IP Address, and Radio ID (1): 

• To add an element to the system, click Add and select the element type from 
the drop-down menu (2). 

5.9.2 Services 
• In the Configuration pane, under Digital Systems, select Services: 
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• In the Services pane, specify the following Digital System Services-related 
parameters: 
 Automatic Registration Service (ARS) 

Select this option to enable the ARS service for the radios. When the radio 
powers up, it automatically registers with the server. This feature is used 
with data applications, that is, any data traffic on this channel is associated 
with an application server such as MOTOTRBO Text Messaging or 
MOTOTRBO Location Services. 
• Port 

Enter the local port number for the ARS service (4005, by default). 
 Telemetry service (TLM) 

Select this option to enable the Telemetry service, which is the wireless 
transmission and reception of measured quantities for remotely monitoring 
environmental conditions or equipment parameters. 
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• Port 
Enter the local port number for the Telemetry service (4008, by default). 

 Text Messaging service (TMS) 
Select this option to enable the Text Messaging service which is used to 
exchange text messages between the radios and the dispatchers. 
• Port 

Enter the local port number for the Text Messaging service (4007, by 
default). 

 Location service (GPS / Indoor) 
Select this option to enable the Location service. The radio can send its 
coordinates when it is in Global Positioning or iBeacon coverage area. 
• Port 

This is the local port number for the Location service (4001), which 
cannot be modified. 

 Text Messaging service DMR 
Select this option to enable the DMR-based Text Messaging service. 
• Port 

Enter the local port number for the DMR-based Text Messaging service 
(5016, by default). 

 Indoor service (K-TERM) 
Select this option to enable the Indoor Location service. 
• Port 

Enter the local port number for the Indoor service (3022, by default). 
 Indoor LAN Service (K-TERM) 

Select this option to enable the Indoor LAN service. 
• Port 

Enter the local port number for the Indoor LAN service (3001, by default). 
 Tallysman Sprite service 

Select this option to enable the service for autonomous event and 
aggregated event reporting to provide significant reduction in GPS data 
overhead. 
• Port 

Enter the local port number for the Tallysman Sprite service (4004, by 
default). 

 FS 5000 location service (GPS) 
Select this option to enable the FS 5000 location service, which is a service 
for transmitting GPS data packages. This service uses FS 5000 Option Board. 
• Port 

Enter the local port number for the FS 5000 location service (4004, by 
default). 
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 Swift.Tracker v.1 service 
Select this option to enable the service to transmit coordinates and data 
packages via a radio channel using the Swift.Tracker TR001 device. 
• Port 

Enter the local port number for the Swift.Tracker v.1 service (4004, by 
default). 

 Swift.Tracker v.1 service (GSM channel) 
Select this option to enable the service to transmit coordinates and data 
packages via a radio channel and a reserved GSM channel using the 
Swift.Tracker TR001 device. 
• Port 

Enter the local port number for the Swift.Tracker v.1 service with a GSM 
channel (4080, by default). 

 Swift.Tracker v.2 service 
Select this option to enable the service to transmit coordinates and data 
packages via a radio channel using the Swift.Tracker TR001 device (version 
2). 
• Port 

Enter the local port number for the Swift.Tracker v.2 service (4104, by 
default). 

 Swift.Tracker v.2 service (GSM channel) 
Select this option to enable the service to transmit coordinates and data 
packages via a radio channel and a reserved GSM channel using the 
Swift.Tracker TR001 device (version 2). 
• Port 

Enter the local port number for the GSM channel of the Swift.Tracker v.2 
service with a GSM channel (4180, by default). 

 Extended Text Messaging service 
Select this option to enable the Extended Text Messaging service to include 
sending detailed preconfigured templates with the help of TRBOnet 
Dispatch Software. 
• Port 

Enter the local port number for the Extended Text Messaging service 
(4010, by default). 

 Telemetry service NOVOX 
Select this option to enable the Telemetry service based on NOVOX devices. 
• Requests port 

Enter the local port number to listen for requests (8090, by default). 
• Events port 

Enter the local port number to listen for events (8091, by default). 
 G4S RS232 service 

Select this option to enable the custom developed G4S RS232 service. 
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• Port 
Enter the local port number for the G4S RS232 service (4004, by default). 

 Zebra printer service 
Select this option to enable the service for printing Job Tickets. A Zebra 
printer is connected to a radio via Bluetooth. The radios should be 
Bluetooth-enabled. 
• Port 

Enter the local port number for Zebra printer service (4072, by default). 
 Forward Data service 

Select this option to enable the Forward Data service. This feature is used to 
forward "raw data" via the COM port from one device to another. 
• Port 

Enter the local port number for Forward Data service (4011, by default). 

5.9.3 Adding a Control Station 
• In the Digital Systems pane, click Add. 

Or, in the Configuration pane, right-click Digital Systems. 
• In the drop-down menu, click Add Control Station. 

 

• In the Control Station pane, specify the following control station-related 
parameters: 
 Name 

Enter a name for the control station. This name will be displayed in the 
Dispatch Console in the Voice Dispatch Radio Interface pane. It will be the 
name at the top of the PTT box. 

 Radio ID 
This is the Radio ID of the radio unit connected as a control station. 
(for Capacity Plus and Linked Capacity Plus systems, the maximum value is 
65535). 
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Note: This box is populated automatically once you have 
successfully tested the control station by clicking the Test 
button. 

 IP Address 
Enter, or select from the list, the IP Address of the control station network 
interface. 

Note: This value is can be taken from the radio's configuration in 
MOTOTRBO CPS, in Network>Accessory IP. 

 Test 
Click this button to check the connection to the control station. If the test is 
successful, you'll see the information on the control station you are 
connected to, such as radio ID, serial number, firmware version, and other 
relevant information. 

 Mode 
From the drop-down list, select the connection mode for the control station 
being configured. For more details, see section 5.9.3.1, Control Station 
Connection Modes (page 36). 

 System Identifier 
Enter the system identifier with which the control station is used within a 
Capacity Plus or Linked Capacity Plus system. Note that the system 
identifier should be the same for all control stations used in a (Linked) 
Capacity Plus system. 

 Use the radio for RX data only (GPS Revert or Data Revert) 
Select this option to configure the radio channel so that it will only receive 
data, thus having no transmission capability. 

 Playback device 
From the drop-down list, select the playback device on the PC that will be 
used to transfer audio data to the connected control station. 

 Recorder device 
From the drop-down list, select the recording device on the PC that will be 
used to receive audio data from the control station connected via a line-in 
jack. 

5.9.3.1 Control Station Connection Modes 

Single Control Station 
The Single Station mode is the simplest connection mode for receiving and 
transmitting voice and data through a conventional channel using one control 
station at this particular frequency. 
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IP Site Connect 
The IPSC is a digital conventional two way MOTOTRBO system that allows you to 
extend the area of your communications by providing 2 wide area channels per 
repeater. It is possible to connect up to 15 repeaters in one system using IP 
connection. 
The Server Connection Modes are as follows: 

1. TRBOnet Server is connected to a repeater with two time slots in the "IP 
Site Connect" mode. The Server can transmit and receive over IP. 

2. TRBOnet Server has no IP connection to a repeater. Two control stations 
are required to transmit and receive voice and data, that is, one control 
station per time slot. 
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Common Channel 
The Common Channel is a mode where it is possible to use multiple simplex base 
stations operating at the same frequency with overlapping communication zones. 
This mode allows the customer to provide radio coverage to large areas when there 
is only one frequency and additional frequencies are unavailable. While in this mode, 
the coverage area is being extended only for the dispatcher, and specifically when 
operating at one and the same frequency. When a radio unit initiates a call, the 
signal that can potentially be received by several base stations will be filtered on the 
server side so that repeated audio playback and recording is prohibited. 
The signal filtering is performed based on the "first packet", that is, only the signal 
coming first to the server is played back and recorded, while the remaining signals 
are discarded. 
When a dispatcher initiates a call to a specific base station, the signals received by 
the neighboring base stations will be discarded to prevent dispatchers from listening 
to their own call at the time of transmission. The dispatcher is not recommended to 
place a simultaneous call to all base stations to avoid interference to the subscribers. 
The recommended way to use this mode is as follows: each base station is 
configured with its own color code, and radio units are equipped with option boards 
having a Geo-roaming feature, and each geographic area is assigned its own radio 
channel with the corresponding color code. 
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Capacity Plus TRBOnet 
Capacity Plus TRBOnet is a limited option. All voice and data are received via IP. At 
least one control station is required for outgoing voice and data session at a time. 
Private calls and SIP calls require dedicated control stations unless NAI protocol is 
used. 
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Capacity Plus MOTOTRBO 
Capacity Plus MOTOTRBO is a digital trunked two-way MOTOTRBO system that 
allows you to accommodate high volume communication. It is designed to organize 
stable connection in a few groups within one building or a set of buildings. This 
system type allows you to increase the number of channels for voice and data 
transmission between the subscribers and control centers. The subscribers are 
always automatically forwarded to a free channel. The main objective of Capacity 
Plus MOTOTRBO is to support more simultaneous voice and data transmissions 
within one capacious system. 
In the Capacity Plus MOTOTRBO mode you can configure voice and data control 
stations to transmit and receive data over the air as it is displayed in System Planner. 
Keep in mind that two data control stations are required per each data repeater – 
one per time slot. TRBOnet Dispatch Software provides you an option to utilize an IP 
connection to receive voice and data. 
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5.9.3.2 Advanced Settings 
• In the Configuration pane, under the corresponding Control Station, select 

Advanced Settings. 

 

• In the Advanced Settings pane, specify the following control station-related 
advanced settings: 
 Automatically reset alarm mode 

Select this option to reset alarm mode on the control station radio 
automatically. It is recommended to enable this option. 

 Automatically handle call alert 
Select this option to automatically redirect call alerts from the control 
station radio to the Dispatch Console. 

 Emergency Call/Alarm indication 
Select this option so that audio and visual indication is given by the control 
station radio when an emergency Call/Emergency Alarm is received. 

 Use front microphone (for PTT key up) 
Select this option to use a remote control of the PTT button via a remote 
speaker microphone on the radio. 

 Always transmit when the PTT is pressed ("Impolite" channel access) 
Select this option so that when the PTT button is pressed, the radio will 
start transmitting regardless of whether the channel is free or not (that is 
any transmission in progress will be interrupted). 

 Use serial port for PTT key up 
Select this option to use a remote control of the PTT button via the serial 
port of the PC, and select the serial port from the drop-down list. 

 TX Timeout 
Enter the time, in seconds, to be used as a voice session limit. When a 
dispatcher starts any voice session in the Dispatch Console, the ongoing 
transmission will be interrupted after this TX Timeout expires. 

 Signaling system 
From the drop-down list, select the signaling system. 
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• MDC 1200 signaling is a Motorola data system using audio frequency 
shift keying (ASFK) using a 1,200 baud data rate. A general option setting 
for the system is to enable or disable an acknowledgement (ACK) data 
packet. 

• SELECT 5 (5 Tone Signaling System). In the 5 Tone Signaling Systems, 
each radio has a unique numeric identity (for example, 12345). To signal 
the number 12345, a sequence of 5 tones is sent. Sequences of audible 
tones of a very short duration are sent between radios. Most 5 tone 
sequences take less than half a second to send. Available for Voice Calls, 
Check Radio, Call Alert, and Enable/Disable Radio. 
Click the Configure link and specify desired SELECT 5 settings. 

 

 Allow CSBK Data 
Select this option so that GPS data is sent in a single CSBK. 

5.9.3.3 Audio Paths 
The Audio Paths are talk paths of the system to make and receive Voice Calls; in 
general, they are talk groups. TRBOnet Server requires that all audio paths of a radio 
system be registered in its configuration. If an audio path is not registered, the 
TRBOnet operator will not be able to receive and transmit to the corresponding talk 
group. 

Note: Audio paths are available only when one of the following modes is 
selected: Capacity Plus, Linked Capacity Plus, Connect Plus, or 
Capacity MAX. 

• In the Configuration pane, under the corresponding Control Station, select 
Audio Paths. 
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• In the Audio Paths pane, specify the following Audio Path-related settings: 
 To add an audio path to the system, click Add. 
 Make sure the check box in the first column is selected to make and receive 

voice calls from the selected subscriber. 
 From the drop-down list, select the Call Type for the audio path. The 

available call types are All Call, Group Call, and Private Call. 
 Enter the Group ID, which is an ID of the talk group the dispatcher can 

make calls to. The Group ID is not applicable for Private Calls and All Calls. 
 In the Site column, select either Local or Wide. The value Wide means that 

the audio path will be to all sites in the system and not just to the local site. 

5.9.4 Adding a MOTOTRBO Repeater 
• In the Digital Systems pane, click Add. 

Or, in the Configuration pane, right-click Digital Systems. 
• In the drop-down menu, click Add MOTOTRBO System. 
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• In the Repeater pane, specify the connection parameters. 
To ensure your connection parameters match the actual configuration of your 
radio network, you may need to use Motorola CPS or Config Advisor tools to 
determine the values. Contact your radio network administrator, if you do not 
have this information. 

 

 System Name 
Enter a name for the repeater. This name will be displayed in the Dispatch 
Console. 

 TRBOnet Peer ID 
Enter a Peer ID for TRBOnet Server. The Peer ID must be unique among the 
repeaters in the radio system. 

Note: Motorola recommends that this value be less than 200. 

 TRBOnet Radio ID 
Enter the Radio ID, which is a gateway for voice and data. The Radio ID 
must be unique in the radio system (for Capacity Plus and Linked Capacity 
Plus systems, the maximum value is 65535). 

 TRBOnet Local Port 
Enter the local port number that will be used by TRBOnet Server to 
establish a connection to the repeater. Use unique port numbers for each 
repeater connection if there are several repeaters connected. 

 Master IP Address 
Enter the Ethernet IP address of the master repeater. 

Note: This value is programmed for a repeater via MOTOTRBO 
CPS, in Link Establishment>Master IP. 

 Master UDP Port 
Enter the UDP port number of the master repeater. 
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Note: This value is programmed for a repeater via MOTOTRBO 
CPS, in Link Establishment>Master UDP Port. 

 Authentication Key 
Enter the repeater's authentication key (if any). 

Note: This value is programmed for a repeater via MOTOTRBO 
CPS, in Link Establishment>Authentication Key. 

 System Type 
From the drop-down list, select the system type. 

 Test 
Click this button to check the connection to your master repeater. If the test 
is successful, you'll see the information on the repeater you are connected 
to, such as the serial number, firmware version, and other relevant 
information. 

 System Identifier 
Enter the system identifier if a Capacity Plus or Linked Capacity Plus system 
is used with one or more control stations. Use the same system identifier as 
you have specified for the corresponding control stations. 

 Use NAI Voice 
Select this option to connect to the repeater via NAI (Network Application 
Interface) for Voice transfer. 

 Use NAI Data (MNIS and DDMS) 
Select this option to connect to the repeater via NAI (Network Application 
Interface) for Data transfer. 
• MNIS 

MOTOTRBO Network Interface Service is a Windows application which 
acts as a data gateway between the data applications and the radio 
system. Data messages are routed through the MNIS. 

• DDMS 
Device Discovery and Mobility Service is a service for tracking the 
presence of radio subscribers in the radio network and transmitting the 
data to the server. 

5.9.4.1 Advanced Settings 
• In the Configuration pane, under the corresponding Repeater, select 

Advanced settings. 
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• In the Advanced Settings pane, specify the following repeater-related 
advanced settings: 
Voice Call Hang Time (ms): 
 Group Call 

This value sets the duration the repeater reserves the channel after the end 
of a group call transmission. During this time, only members of the group 
that the channel is reserved for can transmit. 

 Private Call 
This value sets the duration a radio keeps the private call setup after a user 
releases the PTT button. This is to avoid setting up the call again each time 
a user presses the PTT button to transmit. During this time, other radios can 
still transmit since the channel is essentially idle. After the hang timer 
expires, the radio transmits using the TX Contact Name parameter specified 
for this channel in MOTOTRBO CPS. 

 Emergency Call 
This value sets the duration the repeater reserves the channel after the end 
of an emergency call transmission. During this time, only members of the 
Group that the channel is reserved for can transmit. 

Note: The values of the above three parameters must be taken 
from the corresponding parameter values programmed for 
the repeater via MOTOTRBO CPS in General Settings. 

 TX Preamble 
Enter the value of the TX Preamble. The TX Preamble is a string of bits 
added in front of a data or control message (Text Messaging, Location 
Messaging, Registration, Radio Check, Private Call, and other message 
types) before transmission. The acceptable range is 0 - 8640 ms. The 
recommended value is 120 ms. 
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 TX Timeout 
Enter the time, in seconds, to be used as a voice session limit. When the 
dispatcher starts any voice session in the Dispatch Console, transmission 
will be interrupted after this TX Timeout expires. 

 Phone system 
From the drop-down list, select the system for phone calls: 
• Motorola Phone System 

This system uses a special call type with the parameters specified for a 
radio unit in MOTOTRBO CPS. The Motorola Phone System is 
recommended for IP Site Connect mode to minimize Radio response 
time. For more details on programming Motorola Radios, see Appendix 
B: SIP Setup for Motorola Phone System (page 334). 

• TRBOnet Phone System (TX Interrupt) 
This is a phone call system based on the private call type using TX 
Interrupt feature. This phone system is available for radio systems with 
control stations. 

 Allow CSBK Data 
Select this option so that GPS data is sent in a single CSBK. 

Note: This feature is available only when the MNIS Data Service is 
enabled for the repeater. 

5.9.4.2 Privacy 
• In the Configuration pane, under the corresponding Repeater, select Privacy. 

 

• In the Privacy pane, specify the following privacy-related settings: 
 Privacy Type 

From the drop-down list, select one of the privacy types: None, Basic, or 
Enhanced. 

 Basic Privacy Key ID 
Enter the Privacy Key ID available for the Basic privacy type. 
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 Enhanced Algorithm 
From the drop-down list, select one of the enhanced algorithms if you are 
going to use additional encryption. 

 Enhanced Privacy Keys 
Here you add enhanced privacy keys for the selected enhanced algorithm. 
• Click Add and specify the required ID, name, and value for the privacy 

key being added. 

5.9.4.3 DDMS Service 
The DDMS, or Device Discovery and Mobility Service is a service for tracking the 
presence of radio subscribers in the radio network and transmitting the data to the 
server. 

• In the Configuration pane, under the corresponding Repeater, select 
DDMS service. 

 

• In the DDMS service pane, specify the following DDMS service-related 
settings: 
 Use DDMS service 

Select this option to enable the DDMS service for the server. 
 Local Port 

Enter the number of the local port to be used on a PC with TRBOnet 
Dispatch Software for DDMS service. 

 Service IP Address 
Enter the IP Address of the PC with the DDMS service installed and running. 

 Service port 
Enter the service port number. 

Note: This value is programmed for a DDMS service via 
MOTOTRBO DDMS Administrative Client, in 
Interfaces>Watcher Settings>PortWatcher. 
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 Authentication Port 
Enter the authentication server port number. 

Note: This value is programmed for a DDMS service via 
MOTOTRBO DDMS Administrative Client, in 
Interfaces>Authentication Server Settings> 
AuthenticationServerPort. 

 Radio ID list 
Enter the list of radios to be monitored. 

 Redundant services 
Here you see the list of redundant DDMS services for failover purposes. 
• Click Add and specify the required parameters for the DDMS service 

being added. 
• Click Test to test if the selected DDMS service is available. 
• Use the Up ( ) and Down ( ) buttons to move a selected DDMS 

service up and down in the priority list of DDMS services. 

5.9.4.4 MNIS Data Service 
The MNIS, or Motorola Network Interface Service, is a Windows application which 
acts as a data gateway between the data applications and the radio system. Data 
messages are routed through the MNIS. 

• In the Configuration pane, under the corresponding Repeater, select 
MNIS data service. 

 

• In the MNIS data service pane, specify the following MNIS data service-
related settings: 
 Use Data Gateway 

Select this option to enable the MNIS data service for the server. 
 Service is on a local host 

Select this option if the MNIS data service will be used on the local PC. 
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 IP Address 
Enter the IP Address used by the MNIS to communicate with the PC. 

Note: This value is programmed for a MNIS data service via 
MOTOTRBO MNIS Configuration Utility, and can be 
retrieved from General>Tunnel Network>Tunnel IP Address. 

 Control port 
Enter the number for the MNIS control port. 

Note: This value is programmed for a MNIS data service via 
MOTOTRBO MNIS Configuration Utility, in 
Advanced>Network>MNIS Control Interface TCP Port. 

 MNIS Service 
Select this option, and from the drop-down list select the available MNIS 
service. 

 Redundant services 
Here you see the list of redundant MNIS data services for failover purposes. 
• Click Add and specify the required parameters for the MNIS data service 

being added. 
• Click Test to test if the selected MNIS data service is available. 
• Use the Up ( ) and Down ( ) buttons to move a selected MNIS data 

service up and down in the priority list of MNIS data services. 

Advanced Settings 
• In the Configuration pane, under MNIS data service, select Advanced 

settings. 

 

• In the Advanced settings pane, you can specify settings that relate to the 
remote MNIS data service: 
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 Add network routes to the local Windows routing table 
Select this option to allow TRBOnet Server to add network routes to the 
local Windows routing table so that data can be sent to the remote MNIS 
data service. 

 Add port forwarding rules to the remote MNIS service 
Select this option to allow TRBOnet Server to add forwarding rules to the 
remote MNIS data service. 

 Send data to group over control port 
Select this option so that data will be sent via the specified control port. 

 Radio Range 
Specify the range of radios to be monitored by the MNIS service. 

 

5.9.4.5 Slots 

Note: The slots are available only when IP Site Connect is selected in the 
Repeater pane. 

• In the Configuration pane, under the corresponding Repeater, select Slot #1 
or Slot #2. 

 

• In the Slot #1 (or Slot #2) pane, specify the following slot-related parameters: 
 Name 

Enter a name for the slot. This name will be displayed in the Dispatch 
Console. 

 Messaging Delay 
From the drop-down list, select the inter-repeater messaging delay based 
on the IP network configuration. 
• Normal 

The inter-repeater messaging delay is 60 ms. 
• High 

The inter-repeater messaging delay is 90 ms. 
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 Use the slot for RX data only (GPS Revert or Data Revert) 
Select this option to configure the slot so that it will only receive data, thus 
having no transmission capability. 

 Use Privacy 
Select this option to use Privacy for the slot. 

Note: This option is available only if the Basic or Enhanced 
Privacy Type have been selected in Repeater's Privacy 
settings. 

 Privacy Key 
From the drop-down list, select the privacy key. 

Note: This option is available only if the Enhanced Privacy Type 
has been selected in Repeater's Privacy settings). 

 Allow TX interrupt 
Select this option to allow interrupting dispatcher transmissions by radios 
that are Transmit Interrupt capable. 

Note: This feature is available only when the Use NAI Voice 
option is cleared in the Repeater pane. 

 Always transmit when the PTT is pressed ("Impolite" channel access) 
Select this option so that when the PTT button is pressed, the dispatcher 
will start transmitting regardless of whether the channel is free or not (that 
is any transmission in progress will be interrupted). 

Note: This feature is not available in Capacity Plus and Linked 
Capacity Plus systems. 

 Data Call confirmed 
Select this option to enable data packets in data calls (ARS, GPS, and Text 
Message) on the current slot to be confirmed. 

Note: This feature is available only when both the Use NAI Voice 
and Use NAI Data (MNIS and DDMS) options are cleared 
in the Repeater pane. 

 Private Call Confirmed 
Select this option to set Private calls on the current slot as confirmed. By 
default, Private calls are unconfirmed. 

 Emergency Alarm Ack 
Select this option so that the Dispatch Console is allowed to acknowledge 
an emergency alarm received via this slot. 

 Emergency Call/Alarm Indication 
Select this option so that audio and visual indication is given for an 
emergency call/emergency alarm received via this slot. 
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5.9.4.6 Local Slots 
While on a local slot, voice or data are not transmitted between sites in IPSC 
systems. Due to MOTOTRBO limitations TRBOnet Server can only receive 
information from local slots, but cannot transmit by IP connection to such slots. 

Note: Local slots are available only when IP Site Connect is selected, and 
the Use NAI Voice option is selected in the Repeater pane. 
If the Use NAI Voice option is cleared, local slots will be available 
only through dedicated control stations. 

• In the Configuration pane, under the corresponding Repeater, select 
Local Slots. 

 

• In the Local Slots pane, specify the following Local Slot-related settings: 
 To add a Local Slot to the system, click Add. 
 Select the option in the first column to enable the selected local slot. 
 Enter a Name for the local slot. This name will be displayed in the Dispatch 

Console. 
 Enter the Peer ID of the repeater. 

Note: This value can be taken from the repeater's configuration in 
MOTOTRBO CPS, in General Settings>Radio ID. 

 From the drop-down list, select the Peer Slot. 
 To configure the selected local slot, click Configure: 
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 Specify the desired local slot settings similar to those for a common 
repeater slot. 

5.9.4.7 Audio Paths 
The Audio Paths are talk paths of the system to make and receive Voice Calls; in 
general, they are talk groups. TRBOnet Server requires that all audio paths of a 
Capacity Plus system be registered in its configuration. If an audio path is not 
registered, the TRBOnet operator will not be able to receive and transmit to the 
corresponding talk group. 

Note: Audio paths are available only when Capacity Plus or Linked 
Capacity Plus are selected. 

• In the Configuration pane, under the corresponding Repeater, select 
Audio Paths. 

 

• In the Audio Paths pane, specify the following Audio Path-related settings: 
 To add an audio path to the system, click Add. 
 Make sure the check box in the first column is selected to make and receive 

voice calls from the selected subscriber. 
 From the drop-down list, select the Call Type for the audio path. The 

available call types are All Call, Group Call, and Private Call. 
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 Enter the Group ID, which is an ID of the talk group the dispatcher can 
make calls to. The Group ID is not applicable for Private Calls and All Calls. 

 Enter the Site ID of the site the audio path will belong to in a Linked 
Capacity Plus system. Or, leave zero value in this column. In this case, the 
Site ID will be displayed as Wide, meaning that the audio path will belong 
to all sites in the system. 

 To configure the selected audio path, click Configure. 
 Specify the desired audio path settings similar to those for a common 

repeater slot. 

5.9.5 Adding a TRBOnet Swift Agent 
The TRBOnet Swift Agent functions as a gateway to receive and transmit voice and 
data. 

• In the Digital Systems pane, click Add. 
Or, in the Configuration pane, right-click Digital Systems. 

• In the drop-down menu, click Add TRBOnet Swift Agent. 

 

• In the TRBOnet Swift Agent pane, specify the following Swift Agent-related 
parameters: 
 Name 

Enter a name for the Swift Agent. This name will be displayed in the 
Dispatch Console. 

 Radio ID 
This is the Radio ID of the control station connected to the Swift Agent. 
(for Capacity Plus and Linked Capacity Plus systems, the maximum value is 
65535). 

Note: This box is populated automatically once you have 
successfully tested the Swift Agent by clicking the Test 
button. 
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 IP Address 
Enter the IP Address of the Swift Agent network interface. 

 Port 
Enter the port number of the Swift Agent connection (8002, by default). 

 Test 
Click this button to check the connection to the Swift Agent. If the test is 
successful, you'll see the information on the Swift Agent you are connected 
to, such as Serial number, Firmware version, and other relevant information. 

 Mode 
From the drop-down list, select the connection mode for the Swift Agent 
being configured. For more details, see section 5.9.3.1, Control Station 
Connection Modes (page 36). 

 System Identifier 
Enter the system identifier if the control station is used with a Capacity Plus 
or Linked Capacity Plus system. Note that the system identifier should be 
the same for all control stations used in the radio system. 

 Use the radio for RX data only (GPS Revert or Data Revert) 
Select this option to configure the radio channel so that it will only receive 
data, thus having no transmission capability. 

 VoIP port 
Enter the port number for audio communications (4000, by default). 

Note: This setting is used for older firmware versions of TRBOnet 
Swift Agent. 

 Audio Format 
From the drop-down list, select the format to transmit audio data. 

5.9.5.1 Advanced Settings 
• In the Configuration pane, under the corresponding TRBOnet Swift Agent, 

select Advanced Settings. 
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• In the Advanced Settings pane, specify the following Swift Agent-related 
advanced settings: 
 Automatically reset alarm mode 

Select this option to reset alarm mode on the control station radio 
automatically. It is recommended to enable this option. 

 Emergency Call/Alarm indication 
Select this option so that audio and visual indication is given by the Control 
Station radio when an Emergency Call/Emergency Alarm is received. 

 Always transmit when the PTT is pressed ("Impolite" channel access) 
Select this option so that that when the PTT button is pressed, the radio will 
start transmitting regardless of whether the channel is free or not (that is 
any transmission in progress will be interrupted). 

Note: This feature is not available in Capacity Plus and Linked 
Capacity Plus systems. 

 TX Timeout 
Enter the time, in seconds, to be used as a voice session limit. When a 
dispatcher starts any voice session in the Dispatch Console, transmission 
will be interrupted after this TX Timeout expires. 

 PTT Mode 
From the drop-down list, select the mode of pressing the PTT on the radio. 

 Signaling system 
From the drop-down list, select the signaling system. 
• MDC 1200 signaling is a Motorola data system using audio frequency 

shift keying (ASFK) using a 1,200 baud data rate. A general option is to 
enable or disable an acknowledgement (ACK) data packet. 

• SELECT 5 (5 Tone Signaling System). In the 5 Tone Signaling Systems, 
each radio has a unique numeric identity (for example, 12345). To signal 
the number 12345, a sequence of 5 tones is sent. Sequences of audible 
tones of a very short duration are sent between radios. Most 5 tone 
sequences take less than half a second to send. Available for Voice Calls, 
Check Radio, Call Alert, and Enable/Disable Radio. 

5.9.5.2 Redundancy 
A Redundant TRBOnet Swift Agent will be used when a connection to the Main 
TRBOnet Swift Agent is lost. 

• In the Configuration pane, under the corresponding TRBOnet Swift Agent, 
select Redundancy. 
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• In the Redundancy pane, specify the following Redundant Agent-related 
settings: 
 Click Add and specify the desired parameters for the Redundant Agent 

being added. 
• IP Address 

Enter the IP Address of the Swift Agent that will be used as a Redundant 
Swift Agent. 

• Port 
Enter the port number that will be used for connections between the 
server and the Redundant Swift Agent (8002, by default). 

• Click Test to check the connection to the Redundant Swift Agent. 
If the test is successful, you'll see the information on the Swift Agent you 
are connected to, such as Serial number, Firmware version, and other 
relevant information. 

• Local Port 
Enter the port number that will be used for connections from the 
Redundant Swift Agent. The value 0 (default) means that a random port 
will be used. 

5.9.6 Adding an XRC Controller 
The XRC Controller is a site controller that provides a channel for transferring data 
between sites and managing data flow. 

• In the Digital Systems pane, click Add. 
Or, in the Configuration pane, right-click Digital Systems. 

• In the drop-down menu, click Add XRC Controller. 
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• In the Controller pane, specify the following XRC controller-related 
parameters: 
 Name 

Enter a name for the XRC controller. This name will be displayed in the 
Dispatch Console. 

 IP Address 
Enter the IP Address of the XRC controller network interface. 

 Click Test to check the connection to the controller. 
 System Identifier 

Enter the system identifier. Note that the system identifier should be the 
same through all the controllers in a Connect Plus system. 

 Radio ID list 
Enter a list of the radios to receive data from according to the following 
rules: 
• To receive data from all radios in the system, leave this box blank. 
• To receive data from multiple radios, separate each Radio ID by a 

comma, for example, 105,106,111, and so on. 
• To receive data from a range of radios, enter the range using the 

following example: 105-111. 

Note: In the Radio ID list, enter Radio IDs only, without 
mentioning Radio Names and/or the word "Radio". 

5.9.6.1 Advanced Settings 
• In the Configuration pane, under the corresponding XRC Controller, select 

Advanced Settings. 
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• In the Advanced Settings pane, specify the following XRC controller-related 
advanced settings: 
 Automatic Registration service (ARS) provides an automated data 

application registration for the radio. When the radio powers up, it 
automatically registers with the server. This feature is used with data 
applications, that is any data traffic on this channel is associated with an 
application server, such as MOTOTRBO Text Messaging or MOTOTRBO 
Location Service. This option is selected by default and cannot be cleared. 
• Controller port 

Enter the controller's port number for ARS service (4005, by default). 
• Local port 

Enter the local port of the PC with TRBOnet Dispatch Software. The value 
0 (default) means that a random port will be used. 

 Location service (GPS) 
Select this option to enable Location service on the controller. The radio can 
send its coordinates when it is in Global Positioning coverage area. GPS 
settings can be configured in the Service Management pane (see section 
5.7.2, Location Service). 
• Controller port 

Enter the controller's port number for Location service (4001, by default). 
• Local port 

Enter the local port of the PC with TRBOnet Dispatch Software (4001, by 
default). 

• Use adaptive GPS trigger 
Select this option to use the adaptive GPS polling interval. 

 Text Messaging service (TMS) 
Select this option to enable text message transmission on the controller. 
• Port 

Enter the controller's port number for Text Messaging service (4007, by 
default). 



  

60 TRBOnet PLUS — User Manual 

• Local port 
Enter the local port of the PC with TRBOnet Dispatch Software (4007, by 
default). 

• Dispatcher ID 
Enter the Dispatcher ID. The Dispatcher ID should belong to TRBOnet 
Server account in a Connect Plus system. 

 Multi Gate Connection 
Select this option to use a multi-gate connection and enter the 
corresponding Subscribe ID. 

5.9.6.2 Redundancy 
A redundant XRC controller will be used when a connection to the main XRC 
controller is lost. 

• In the Configuration pane, under the corresponding XRC Controller, select 
Redundancy. 

 

• In the Redundancy pane, specify the following redundant XRC controller-
related settings: 
 Click Add and specify the desired parameters for the redundant XRC 

controller being added. 
• IP Address 

Enter the IP Address of the XRC controller that will be used as a 
redundant XRC controller. 

• Controller Port 
Enter the port number of the redundant XRC controller for incoming 
connections (4005, by default). 

• Click Test to check the connection to the redundant XRC Controller. 
If the test is successful, you'll see the information on the XRC controller 
you are connected to, such as serial number, firmware version, and other 
relevant information. 
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• Local Port 
Enter the port number that will be used for incoming connections from 
the redundant XRC controller. The value 0 (default) means that a random 
port will be used. 

5.9.7 Adding an XRT Controller 
The XRT controller functions as a voice gateway connected to each XRC controller in 
a Connect Plus system. 

• In the Digital Systems pane, click Add. 
Or, in the Configuration pane, right-click Digital Systems. 

• In the drop-down menu, click Add XRT Controller. 

 

• In the Controller pane, specify the following XRT Controller-related 
parameters: 
 System Name 

Enter a name for the XRT Controller. This name will be displayed in the 
Dispatch Console. 

 Radio ID 
Enter the individual virtual radio ID. The virtual Radio ID is required to do 
the following: 
• Make all types of voice calls from XRT Controller to radios, dispatchers 

and groups. 
• Send commands (for example, Remote Monitor). 

 Start Local Port 
Enter the local port of the PC with TRBOnet Server. The value 0 (default) 
means that a random port will be used. 

XRT Controller Info: 
 Controller IP Address 

Enter the IP Address of the XRT controller network interface. 
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 Controller TCP Port 
Enter the port number of the XRT controller to be used for connections via 
TCP (10001, by default). 

 Click Test to check the connection to the XRT controller. 
 User Name 

Enter the user name. For the user name, refer to the XRT controller 
configuration. 

 Password 
Enter the password for the user. For the password, refer to the XRT 
controller configuration. 

Note: The user name and password should belong to the same 
TRBOnet Connect Plus account and be appropriately 
configured. 

 System Identifier 
Enter the system identifier. Note that the system identifier should be the 
same through all the controllers in a Connect Plus system. 

 Monitor Voice sessions (without audio) 
This is the Billing feature. Select this option to monitor only PTT press 
events. 

5.9.7.1 Privacy 
• In the Configuration pane, under the corresponding XRT Controller, select 

Privacy. 

 

• In the Privacy pane, specify the following Privacy-related settings: 
 Privacy Type 

From the drop-down list, select one of the privacy types: None, Basic, or 
Enhanced. 

 Basic Privacy Key ID 
Enter the Privacy Key ID available for the Basic Privacy Type. 
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 Enhanced Algorithm 
From the drop-down list, select one of the enhanced algorithms if you are 
going to use additional encryption. 

 Enhanced Privacy Keys 
Here you add enhanced privacy keys for the selected enhanced algorithm. 
• Click Add and specify the required ID, Name, and Value for the privacy 

key being added. 

5.9.7.2 Data Path 
The Data Paths are used to transmit data in a Connect Plus system. 

• In the Configuration pane, under the corresponding XRT Controller, select 
Data Path. 

 

• In the Data Path pane, specify the following data path-related settings: 
 Data Service 

From the drop-down list, select the data service to be used to transfer data. 
 Radio ID 

Enter the Radio ID of the data service. 

5.9.7.3 Audio Paths 
The Audio Paths are talk paths of the system to make and receive voice calls; in 
general, they are talk groups. TRBOnet Server requires that all audio paths of a 
Connect Plus system be registered in its configuration. If an audio path is not 
registered, the TRBOnet operator will not be able to receive and transmit to the 
corresponding talk group. 

• In the Configuration pane, under the corresponding XRT Controller, select 
Audio Paths. 
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• In the Audio Paths pane, specify the following Audio Path-related settings: 
 To add an Audio Path to the system, click Add. 
 Make sure the check box in the first column is selected to make and receive 

Voice Calls from the selected subscriber. 
 From the drop-down list, select the Call Type for the audio path. The 

available call types are All Call, Group Call, and Private Call. 
 Enter the Source ID for Private Calls. In general, this is TRBOnet’s Radio ID. 

If more than one Radio ID is specified in a Connect Plus system (for 
example, for different dispatchers), the corresponding talk paths should be 
added for all of them. 

 Enter the Target ID for Group Calls. This is the Radio ID of the talk group to 
make a call to. The Target ID is not applicable for Private Calls and All Calls. 

5.9.7.4 Redundancy 
A Redundant XRT Controller will be used when a connection to the Main XRT 
Controller is lost. 

• In the Configuration pane, under the corresponding XRT Controller, select 
Redundancy. 
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• In the Redundancy pane, specify the following Redundant XRT Controller-
related settings: 
 Click Add and specify the desired parameters for the Redundant XRT 

Controller being added. 
 Controller IP Address 

Enter the IP Address of the XRT Controller that will be used as a Redundant 
XRT Controller. 

 Controller TCP Port 
Enter the port number of the Redundant XRT Controller to be used for 
connections via TCP (10001, by default). 

 Start Local Port 
Enter the local port of the PC with TRBOnet Dispatch Software. The value 0 
(default) means that a random port will be used. 

 Click Test to check the connection to the Redundant XRT Controller. 
If the test is successful, you'll see the information on the XRT Controller you 
are connected to, such as Serial number, Firmware version, and other 
relevant information. 

5.9.8 Adding a Selex Repeater 
The Selex repeater is configured as a stand-alone repeater which supports 
connections to MOTOTRBO™ radios to transmit voice and data in digital, analog, 
and mixed modes. 

• In the Digital Systems pane, click Add. 
Or, in the Configuration pane, right-click MOTOTRBO. 

• In the drop-down menu, click Add SELEX Repeater. 

 

• In the Selex pane, specify the following Selex Repeater-related parameters: 
 Name 

Enter a name for the Selex Repeater. This name will be displayed in the 
Dispatch Console. 
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 Radio ID 
Enter the Radio ID for the Selex Repeater (for Capacity Plus systems, the 
maximum value is 65535). 
The Radio ID is an individual ID that uniquely identifies the radio. This ID is 
used by other calling radios when addressing the radio, for instance, when 
making a private call or sending a text message. 

 Repeater Mode 
From the drop-down list, select the mode. The available modes are Digital, 
Analog, Mixed, and Tier III. 

5.9.8.1 Advanced Settings 
• In the Configuration pane, under the corresponding Selex, select Advanced 

Settings. 

 

• In the Advanced Settings pane, specify the following Selex Repeater-related 
advanced settings: 
 Keep Alive Interval 

Enter the time interval, in seconds, for TRBOnet Server to check the 
connection to the Selex repeater (10, be default). 

 TX Timeout 
Enter the time, in seconds, to be used as a voice session limit. When a 
Dispatcher starts any Voice Session in the Dispatch Console, transmission 
will be interrupted after this TX Timeout expires (60, be default). 

5.9.8.2 Slots 
The Selex repeater has two available slots (in Digital or Mixed mode) to transmit 
voice and data. 

• In the Configuration pane, under the corresponding Selex, select Slot #1 or 
Slot #2. 
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• In the Slot #1 (or Slot #2) pane, specify the following slot-related parameters: 
 Name 

Enter a name for the slot. This name will be displayed in the Dispatch 
Console. 

 TRBOnet IP Address 
Enter the IP Address of the PC with TRBOnet Dispatch Software. Enter the 
Port number (6080, by default). 

 SELEX IP Address 
Enter the IP Address of the Selex Repeater (refer to the repeater 
configuration). Enter the Port number (6080, by default). 

 Click Test to check the connection to the repeater. 
 Use the gateway for RX data only (GPS Revert or Data Revert) 

Select this option to configure the channel so that it will only receive data, 
thus having no transmission capability. 

 Use Encryption 
Select this option to encrypt voice and data traffic over IP. 

 Always transmit when the PTT is pressed ("Impolite" channel access) 
Select this option so that that when the PTT button is pressed, the radio will 
start transmitting regardless of whether the channel is free or not (that is 
any transmission in progress will be interrupted). 

Note: This feature is not available in Capacity Plus and Linked 
Capacity Plus systems. 

 Data Call Confirmed 
Select this option to enable individual packets in data calls (ARS, GPS, and 
Text Message) on the current slot to be confirmed. 

 Private Call Confirmed 
Select this option to set Private calls on the current slot as confirmed. 
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5.9.8.3 Tier III and Audio Paths 
The Selex repeater can be used in a Tier III mode. To configure this mode, do the 
following: 

• While in the Selex pane, select Tier III from the Repeater Mode drop-down 
list. 

• In the Configuration pane, under the corresponding Selex, select Tier III. 

 

• In the Tier III pane, specify the following Tier III-related parameters: 
 Use Encryption 

Select this option to encrypt voice and data traffic over IP. 
 Always transmit when the PTT is pressed ("Impolite" channel access) 

Select this option so that that when the PTT button is pressed, the radio will 
start transmitting regardless of whether the channel is free or not (that is 
any transmission in progress will be interrupted). 

Note: This feature is not available in Capacity Plus and Linked 
Capacity Plus systems. 

 To configure Audio Paths: 
• In the Configuration pane, under the corresponding Selex, select 

Audio Paths. 

Note: Make sure the Tier III mode has been selected as a 
Repeater Mode for the Selex repeater. 
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• In the Audio Paths pane, specify the following Audio Path-related settings: 
 To add an Audio Path to the system, click Add. 
 Make sure the check box in the first column is selected to make and receive 

Voice Calls from the selected subscriber. 
 From the drop-down list, select the Call Type for the audio path. The 

available call types are All Call, Group Call, and Private Call. 
 Enter the Group ID, which is a radio ID of the talk group to make a call to. 

The Group ID is not applicable for Private Calls and All Calls. 
 

5.9.8.4 Analog channel 
The Selex repeater can also use the Analog channel. 

• In the Configuration pane, under the corresponding Selex, select Analog. 

Note: Make sure the Analog or Mixed mode have been selected 
as a Repeater Mode for the Selex repeater. 

 

• In the Analog pane, specify the following Analog channel-related settings: 
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 Name 
Enter a name for the Selex repeater in the analog mode. This name will be 
displayed in the Dispatch Console. 

 TRBOnet IP Address 
Enter the IP Address of the PC with TRBOnet Dispatch Software. Enter the 
Port number (6080, by default). 

 SELEX IP Address 
Enter the IP Address of the Selex Repeater (refer to the repeater 
configuration). Enter the Port number (6080, by default). 

 Click Test to check the connection to the repeater. 
 Always transmit when the PTT is pressed ("Impolite" channel access) 

Select this option so that when the PTT button is pressed, the radio will 
start transmitting regardless of whether the channel is free or not (that is 
any transmission in progress will be interrupted). 

Note: This feature is not available in Capacity Plus and Linked 
Capacity Plus systems. 

5.10 Analog Control Stations 
TRBOnet Dispatch Software allows using analog radios as control stations. 

• In the Configuration pane, select Analog Control Stations 
• In the Analog Control Stations pane, select Enable Analog Control Stations. 

 

5.10.1 Adding an Analog Control Station 
• In the Analog Control Stations pane, click Add. 
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• In the Control Station pane, specify the following Analog Control Station-
related settings: 
 Name 

Enter a name for the analog control station. This name will be displayed in 
the Dispatch Console. 

 Playback device 
From the drop-down list, select the playback device on the PC that the 
control station is connected to. 

 Recorder device 
From the drop-down list, select the recording device on the PC that the 
control station is connected to. 

 Serial port 
From the drop-down list, select the serial port the control station is 
connected to on the PC. 

 Always transmit when the PTT is pressed ("Impolite" channel access) - 
Select this option so that when the PTT button is pressed, the radio will 
start transmitting regardless of whether the channel is free or not (that is 
any transmission in progress will be interrupted). 

Note: This feature is not available in Capacity Plus and Linked 
Capacity Plus systems. 

 TX Timeout 
Enter the time, in seconds, to be used as a voice session limit. When a 
Dispatcher starts any voice session in the Dispatch Console, transmission 
will be interrupted after this TX Timeout expires. 

 Mic delay time 
Enter the time, in milliseconds, to be used as a delay time interval between 
pushing the PTT and starting voice communication. 
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 Extended protocol 
From the drop-down-list, select either None, if your radio does not support 
the extended protocol, or IC-F1721D v1.01 if the radio supports the 
extended protocol. 

5.10.1.1 Serial Port 

Note: The serial port settings are available only when the 
extended protocol IC-F1721D v1.01 is selected for the 
analog control station. 

• In the Configuration pane, under the corresponding Control Station, select 
Serial Port. 

 

• In the Serial Port pane, specify the same serial port settings as those on the 
radio device connected to the serial port. 

5.11 Remote Agents 
The Remote Agent is TRBOnet Agent installed on a remote PC. 

• In the Configuration pane, select Remote Agents. 
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• In the Remote Agents pane, click Add. 

 

 In the Agent pane, specify the following parameters: 
• Agent Name 

Enter a name for the remote agent. This name will be displayed in the 
Dispatch Console. 

• IP Address 
Enter the IP address of the remote agent. 

• Port 
Enter the local port number that will be used by TRBOnet Server to 
accept connections from the remote agent. 

• Click Test to check the connection to the remote agent. 
• Use all services 

Choose this option so that all available services will be used on the 
remote agent. 

• Use only specified services 
Choose this option and click the Load services from agent link to load 
services available on the remote agent. 

5.11.1 Redundancy 
A Redundant remote agent will be used when a connection to the Main remote 
agent fails. 

• In the Configuration pane, under the corresponding Agent, select 
Redundancy. 
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• In the Redundancy pane, click Add. 

 

• In the Remote Agent dialog box, specify the following parameters: 
• Agent Name 

Enter a name of the redundant remote agent. 
• IP Address 

Enter the IP address of the redundant remote agent. 
• Port 

Enter the local port number that will be used by TRBOnet Server to 
accept connections from the redundant remote agent. 

• Click Test to check the connection to the redundant remote agent. 
• Use all services 

Choose this option so that all available services will be used on the 
redundant remote agent. 

• Use only specified services 
Choose this option and click the Load services from agent link to load 
services available on redundant the remote agent. 

• Click OK to add a redundant remote agent to the system. 
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5.12 Friendly Servers 
The Friendly Servers are used to transmit voice over IP between dispatchers 
connected to different servers. 

• In the Configuration pane, select Friendly Servers. 

 

• In the Friendly Servers pane, click Add. 

 

 In the Server dialog box, specify the following parameters: 
• Name 

Enter a name for the friendly server. This name will be displayed in the 
Dispatch Console. 

• IP Address 
Enter the IP Address of the server. 

• Port 
Enter the local port number on the PC to connect to the friendly server. 

• Click Test button to check the connection to the friendly server. 
• Click OK to add the friendly server to the system. 

5.13 Telephony 
TRBOnet Server has its own built-in SIP server to support VoIP communications 
between the radios as well as other SIP-compliant clients. In addition, you can add 
an external PBX server to the TRBOnet Server configuration. 

• In the Configuration pane, select Telephony 
• In the Telephony pane, select Use Telephony. 
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5.13.1 Internal PBX Server 
• Make sure the Internal PBX Server option is selected in the Telephony pane. 
• In the Configuration pane, select Internal PBX Server. 

 

• In the Internal PBX Server pane, specify the following parameters: 
 Local IP 

Enter the IP address of the PC with TRBOnet Server. 
 Port 

Enter the local UDP port number for the SIP service (5060, by default). 

Dispatch Center 

 SIP ID 
Enter the SIP ID that will be used by the Dispatch Center. 

 SIP user 
Enter the SIP user name that will be used by the Dispatch Center. 
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5.13.1.1 Advanced Settings 
• In the Configuration pane, under Internal PBX Server, select 

Advanced Settings. 

 

• In the Advanced Settings pane, specify the following Internal PBX Server-
related advanced settings: 
 Packet time 

Enter the packet length, in milliseconds. 
 Сodecs 

In the drop-down list, select/deselect the codecs to be used. 
 Registration Interval (sec) 

Enter the time interval, in seconds, to check the SIP registration status of 
subscribers. 

 DTMF Send Mode 
Enter mode for sending DTMF tones. The available modes are RFC 2833, 
SIP INFO (DTMF relay), and SIP INFO (DTMF). 

 First VoIP port 
Enter the number of the first VoIP port for audio communications 

 Use VoIP ports 
From the drop-down list, select which VoIP ports will be used (all, even, or 
odd). 

5.13.2 External PBX Server 
You can enable an external PBX server to use the SIP Interconnect feature. This 
feature enables calls from the radio to the phone and vice versa. The dispatcher can 
make a call from the Dispatch Console to a phone as well as redirect a phone call to 
a subscriber radio. 

• In the Telephony pane, click Add. 
Or, in the Configuration pane, right-click Telephony and choose 
Add PBX Server. 
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• In the External PBX Server pane, specify the following parameters: 
 Use External PBX Server 

Select this option to enable an external PBX server. 

Provider options 

 Address 
Enter your SIP provider address, and select the protocol from the drop-
down list on the right of the address (for more details, contact your SIP 
provider). 

 Port 
Enter the port number of the SIP provider (5060, by default). 

 Click Test to check the connection to the provider. 
 Local IP 

Enter the IP address of the PC with TRBOnet Server. 
 Port 

Enter the local port number to make connections from. 

Dispatcher Center 

Note: This information is provided by the SIP provider. 

 SIP ID 
Enter the SIP ID that will be associated with TRBOnet Server to make and 
receive calls. 

 SIP user 
Enter the SIP user name for the login. 

 Password 
Enter the password for the login. 

 Test Call 
Click this button to make a test call. 
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Note: To make a test call, make sure that the TRBOnet Server 
service is not running. 

5.13.2.1 Advanced Settings 
• In the Configuration pane, under External PBX Server, select 

Advanced Settings. 

 

• In the Advanced Settings pane, specify the following External PBX Server-
related advanced settings: 
 Packet time 

Enter the same value as specified in the phone system; 
 Codecs 

In the drop-down list, select/deselect the codecs specified in the phone 
system. 

Note: For more details on Phone System configuration, see 
Appendix B: SIP Setup for Motorola Phone System 
(page 334). 

 Registration Interval (sec) 
Enter the time interval, in seconds, to check the SIP registration status of 
subscribers. 

 Do not register users on a PBX server (SIP trunk) 
Select this option so that radios will use the SIP trunk system to get 
extensions. 

 Configure user’s authorization 
Click this link to set up user authorization for the systems with enhanced 
authorization parameters. It is recommended to be used when Radio ID is 
equal to SIP ID. In case when Voice is transmitted via Radio Channel, Radio 
ID is used. When voice is transmitted via GSM channel, SIP ID is used. 
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• Click Add to add a new user authorization. 
• SIP ID 

Enter the SIP ID for the new user. 
• User Name 

Enter the User Name for the new user; 
• Click OK to save the new user authorization. 

5.14 Data Sources 
The Data Sources feature allows receiving data from third-party applications and 
devices. 
TRBOnet Dispatch Software can work with the following two data source types: 

1. Physical or virtual devices connected via a COM port 
2. PCs running third-party applications connected via TCP/IP 

To allow TRBOnet Dispatch Software to receive data from a third-party application 
or device: 

• In the Configuration pane, select Data Sources. 

 

• In the Data Sources pane, select the Enable Data Sources option. 
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5.14.1 COM Ports 
To manage physical or virtual devices connected to the TRBOnet Server PC via COM 
port: 

• In the Configuration pane, under Data Sources, select COM ports. 

 

• In the COM ports pane, click Add to add a new device. 

 

• In the COM Port dialog box, specify the following parameters: 
 Serial port name 

From the drop-down list, select the COM port on the PC with TRBOnet 
Server to which the device is connected to. 

 Baud rate 
From the drop-down list, select the baud rate at which the data is 
transmitted. 

 Parity-checking protocol 
From the drop-down list, select one of the values that represent the parity-
checking protocol. 

 Stop bits per byte 
From the drop-down list, select the standard number of stop bits per byte. 
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 Data bits per byte 
From the drop-down list, select the standard length of data bits per byte. 

 Handshaking protocol 
From the drop-down list, select the handshaking protocol for serial port 
transmission of data. 

 Text Encoding 
From the drop-down list, select the Text Encoding type. 

Note: The Text Encoding types selected in the TRBOnet Server 
and in the connected application must be the same to 
avoid incorrect text display and incorrect data parsing. 

 Message delimiter 
From the drop-down list, select the type of delimiters in the data. 

Note: The Message delimiter types selected in the TRBOnet 
Server and in the connected application must be the same 
to avoid incorrect text display and incorrect data parsing. 

 Click OK to save settings and close the dialog box. 

5.14.2 TCP/IP 

Note: When TCP/IP connection is used, all data will be transferred via 
UDP protocol only. 

To manage PCs running third-party applications: 
• In the Configuration pane, under Data Sources, select TCP/IP. 

 

• In the TCP/IP pane, click Add to add a TCP/IP connection. 
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• In the External Connection dialog box, specify the following parameters: 
 Name 

Enter a name for the TCP/IP connection. 
 Mode 

From the drop-down list, select the connection mode. The connection 
mode depends on the type of the application installed on the connected 
PC: 
• Client 

In this case, the application connects to TRBOnet Server which sends the 
data to the application. 

• Server 
In this case, TRBOnet Server accepts connections from the application 
and receives the data. 

 Remote IP 
Enter the IP address of the application server. 

Note: Available only when the Server connection mode is 
selected. 

 Port 
In the case of the Client connection mode, select the local port of the PC 
with TRBOnet Server PC. 
In the case of the Server connection mode, select the port of the PC where 
the third-party application is installed. 

 Text Encoding 
From the drop-down list, select the Text Encoding type. 

Note: The Text Encoding types selected in the TRBOnet Server 
and in the connected application must be the same to 
avoid incorrect text display and incorrect data parsing. 

 Ignore similar messages 
Select this option so that similar messages arriving during the specified 
time period will be ignored. 



  

84 TRBOnet PLUS — User Manual 

• During 
Specify the time period, in minutes, so that similar messages that arrive 
during this time period will be ignored. 

• Do not consider the following substring 
Enter a regular expression that will be used to filter messages upon 
arriving and before being processed. For example, the following regular 
expression \d{2}:\d{2}:\d{2} means that if a message contains a 
substring like 11:01:54, then this substring will be dropped before 
processing the message. 

5.15 Modbus TCP 
TRBOnet Server can receive and send data from/to Modbus hardware and interact 
with Modbus data according to desired scenarios. There are two connection modes 
between TRBOnet Server and Modbus hardware: Master and Slave. 
To connect TRBOnet Server to Modbus hardware: 

• In the Configuration pane, select Modbus TCP. 

 

• In the Modbus TCP pane, click Add. 

 

 From the Mode drop-down list, select the mode of connection. 
• If the Slave mode is selected, specify the Local IP address of TRBOnet PC 

and the Slave ID to assign to this PC. 
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Leave Behavior as Custom if this connection will be used for 
Event/Alarm management. 

• If the Master mode is selected, specify the Remote Address of the 
Modbus device, which in turn will be running in the Slave mode. 

 

5.16 Email Settings 
TRBOnet Dispatch Console allows processing emails as follows: 

1. Receive emails from email servers and forward them to a particular radio or 
talk group (via a POP3 or IMAP server); 

2. Send emails from radios to a particular email address (SMTP Server). 

Note: Microsoft Exchange Server can be used as SMTP and POP3/IMAP 
servers. 

• In the Configuration pane, select Email. 
• In the Email pane, select Enable Email Server. 

 

5.16.1 Incoming Mail Server 
The Incoming Mail Server is used to synchronize the Incoming Emails folder located 
on a mail server with your local PC. If you are using a POP3 server, all incoming 
emails can be downloaded from the mail server to the local PC to be then forwarded 
as text messages to radios or talk groups. 
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• In the Configuration pane, under Email, select Incoming Mail Server. 

 

• In the Incoming Mail Server pane, specify the following incoming mail-
related parameters: 
 Enable 

Select this option to enable Incoming Mail Server. 
 Server 

Enter the server hostname or IP address. 
 This server requires a secure connection (SSL) 

Select this option to enable a secure connection. Note that a dedicated port 
will be used to connect to the mail server via SSL. 

Note: The port number will automatically change when you select 
this option. For example, from 110 to 995 for POP3, and 
from 143 to 993 for IMAP. 

 Port 
Enter the port number to be used for the connection. 

Note: This box is populated automatically depending on the 
selected protocol and whether a secure connection is 
required. 

 Protocol 
From the drop-down list, select the protocol for the incoming mail server. 

Note: The port number will automatically change as you change 
the protocol. 

 Check for new messages every X seconds 
Enter the time interval to check for new email messages (60, by default). 

 Connect using 
Choose one of the following options: 
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• Anonymous access 
Choose this option to use an anonymous access to the incoming mail 
server. 

• Windows authentication 
Choose this option to connect via TRBOnet Service Windows Account, if 
it is running under a specific account; 

• Use login and password 
Choose this option and specify the credentials for the mailbox: 
 Login 

Enter the incoming mail server login. 
 Password 

Enter the incoming mail server password. 
 Check New Emails Now 

Click this button to synchronize the Incoming Emails folder and check for 
new emails. 

5.16.2 Outgoing Mail Server 
The SMTP Server is used to send emails from users to mail servers as well as 
between mail servers to deliver emails to the final destination. 
For example, the Administrator can enable email notifications from TRBOnet 
Dispatch Console to particular email users when alarms occur on selected radios. In 
this case, the radio sends an alarm to TRBOnet Server which in turn converts this 
alarm to text and then forwards it as an email message to particular email addresses 
(for example, to admin@yourcompany.com). 

• In the Configuration pane, under Email, select Outgoing Mail Server. 

 

• In the Outgoing Mail Server pane, specify the following outgoing mail-
related parameters: 
 Enable 

Select this option to enable Outgoing Mail Server. 

mailto:admin@yourcompany.com
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 Sender Email 
Enter the email address to send emails to. 

 SMTP server 
Enter the server hostname or IP address of the SMTP server. 

 This server requires a secure connection (SSL) 
Select this option to enable a secure connection. Note that a dedicated port 
will be used to connect to the mail server via SSL. 

Note: The port number will automatically change when you select 
this option. For example, from 25 to 465. 

 SMTP server port 
Enter the port number to be used for the connection. 

Note: This box is populated automatically depending on whether 
a secure connection is required. 

 Connect using 
Choose one of the following options: 
• Anonymous access 

Choose this option to use an anonymous access to the SMTP server. 
• Windows authentication 

Choose this option to connect via TRBOnet Service Windows Account, if 
it is running under a specific account; 

• Use SMTP user name and password 
Choose this option and specify the credentials for the mailbox: 
 User name 

Enter the SMTP server user name. 
 Password 

Enter the SMTP server password. 
 Type 

From the drop-down list, select the SMPT login type. 
 Send Test Message 

Click this button to send a test message from the Sender Email address. 

5.17 SMS Settings 
TRBOnet Dispatch Console allows sending SMS notifications to a cell phone when 
alarms and other events occur on selected radios (for example, DTMF commands 
from radios, Telemetry, Radio State, and other events). 

• In the Configuration pane, select SMS. 
• In the SMS pane, select Enable SMS Server. 
• In the Configuration pane, under SMS, select SMS. 
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• In the SMS pane, specify the following SMS-related parameters: 
 Sender 

Leave this box blank. 
 Connection to GSM via 

From the drop-down list, select the type of connection. 
• Nokia mobile phone connected to TRBOnet Server PC 

Select this item to send SMS notifications via a Nokia cell phone 
connected to the TRBOnet Server PC. 

• Cinterion BGS2T GSM Modem 
Select this item if you are using a Cinterion BGS2T GSM Modem. In 
addition, select the COM port the modem is connected to, and enter the 
SIM Card Pin Code. 

• Vianett service 
Select this item to use an account on Vianett service. 
For more details on Vianett service, see www.vianett.com 

• SMS Broadcast 
Select this item to use an account on SMS Broadcast service. 
For more details on SMS Broadcast service, see 
www.smsbroadcast.com.au 

• Clickatell 
Select this item to use an account on Clickatell service. 
In addition to the Login and Password, you'll have to specify the API ID. 
For more details on Clickatell service, see www.clickatell.com 

 Login 
Enter the login for the selected service account. 

 Password 
Enter the password for the selected service account. 

http://www.vianett.com/
http://www.smsbroadcast.com.au/
http://www.clickatell.com/
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 Send Test MMS 
Click this button to send a test MMS from the selected service account to a 
recipient's phone number. 

Note: This button is available when connected via Vianett service 
only. 

 Send Test SMS 
click to send a test SMS from Vianett account to recipient phone number. 

Note: This button is available when connected via Vianett, SMS 
Broadcast, or Clickatell services. 
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6 TRBOnet Dispatch Console 
The key features of TRBOnet can be configured by the Administrator in TRBOnet 
Dispatch Console after initial installation and configuration. 

6.1 Connecting to Server 
Launch TRBOnet Dispatch Console using the desktop or Start menu shortcut. 
The default Administrator credentials are admin for the login and admin for the 
password. 

 

Connect to: 

 Address 
Enter the IP address of the TRBOnet Server to connect to. 

Note: This is the Network interface parameter of TRBOnet Server 
configured in section 5.4, Network Parameters (page 18). 

 Port 
Enter the local port of the TRBOnet Server PC to accept connections from 
the Dispatch Console. 

Note: This is the Command port parameter of TRBOnet Server 
configured in section 5.4, Network Parameters (page 18). 

Authentication: 

 Method 
From the drop-down list, select the Authentication method: 
• TRBOnet Authentication 

Select this method to log on as a User registered in the TRBOnet 
Dispatch Console Users list. 

• Windows Authentication 
Select this method to log on using the PC name. The system 
automatically shows the PC name as a User Name. 

Note: The Windows user must be registered in the TRBOnet 
Dispatch Console Users list. 
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 User Name 
Enter the User Name registered in the TRBOnet Dispatch Console Users list. 

 Password 
Enter the user password. 

 Connect on startup 
Select this option to launch the Dispatch Console without typing User 
Name and Password every time. Use this option if you regularly connect to 
the same TRBOnet Server and your workstation is in a secure location. 

6.2 Main Window Elements 
When the TRBOnet Dispatch Console application is initially launched, the default 
Dispatch Console window will be displayed with the Voice Dispatch tab being 
active. 

 

The main user interface elements are as follows: 
1. Main menu 
2. Radio list pane 
3. Modules tab pane 
4. Radio Interface pane 
5. Activity Monitor panel 
6. Quick Panels pane 

Note: The look of the Dispatch Console windows may have been 
customized for your specific operation. 
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6.3 Main Menu 
The TRBOnet Dispatch Console main menu allows the user to manage the main 
Dispatch Console options. The main menu is located in the upper left corner of the 
main window. 

6.3.1 File 

 
The File menu contains the following items: 

• File > Connect to TRBOnet Server 
Choose this menu item to connect to a different TRBOnet Server, or to use 
different credentials for the current connection. 
For more details, see section 6.1, Connecting to Server (page 91). 

• File > Exit 
Choose this menu item to exit TRBOnet Dispatch Console. 

6.3.2 View 

 
The View menu contains the following items: 

• View > Show Navigation 
Choose this menu item to toggle displaying the Navigation Tree. 

• View > Show Modules 
Choose this menu item and in the drop-down menu select/deselect the 
modules to display. 

• View > Configure PTT Boxes 
Choose this menu item to configure the view of PTT boxes. 
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In the Configure Voice Boxes dialog box, specify the following PTT box 
parameters: 
 Type 

In this column, the box type (for example, Channel or Group) is displayed. 
 Name 

Enter a name for the selected box. This name will be displayed in the title of 
the PTT box. 

 View Mode 
From the drop-down list, select the view mode: 
• Invisible 

Select this mode so that the PTT box will not be displayed. 
• Normal 

Select this mode so that the PTT box will be displayed in Normal view 
mode: 

 

• Minimized 
Select this mode so that the PTT box will be displayed in Minimized view 
mode: 

 

Note: Hover the mouse pointer over the Minimized PTT box to 
view the PTT box in the Normal view mode. 
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 Available Calls 
From the drop-down list, select available Call Types for the PTT box: 

Create virtual channel boxes 

 To create a virtual PTT box, click the Create link in the lower-left corner of 
the Configure Voice Boxes the dialog box. 

 

In the Virtual Channel dialog box, specify the following virtual channel 
parameters: 
 Name 

Select this option and enter a name for the virtual channel. 
 Choose a Call Type for the channel. 
 Call Target 

(available only when Group Call or Private Call is selected as the Call Type) 
Choose Select by Dispatcher to allow the dispatcher to select a Call Target. 
Or, choose Selected from list and from the list below select the desired 
group (if the Group Call type is chosen) or individual radio (if the Private 
Call type is chosen). 

 Execute call on channels 
(available only when All Call or Group Call is selected as the Call Type) 
Choose Execute call on all available channels, 
or Execute call only on selected channels and in the list below select the 
available channels. 

• View > Configure Active Calls panel 
Choose this menu item to configure call types and advanced settings for the 
Active Calls panel. This menu item is available if View > Show Active Calls 
Panel is selected. 
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• Call Types 
In this tab, you can select which call types to display in the Active Calls panel: 

 

• Advanced 
In this tab, you can set following options: 
 Show Visible Channels 

Select this option to display Visible channels in the Active Calls panel. 
 Show Hidden Channels 

Select this option to display Hidden channels in the Active Calls panel. 

Note: For the visibility of channels, see Configure PTT boxes, 
View Mode. 

 Show Requests to Call 
Select this option to display Requests to call in the Active Calls panel. 
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 Show Missed Calls 
Select this option to display Missed calls in the Active Calls panel. 
• Display Time 

Set the duration of displaying Missed calls. 
The Active Calls panel is displayed in the upper part of the Dispatch Console: 

 

• View > Customize Hot Keys 
Choose this menu item to configure hot keys for the actions on the selected 
channels. 

 

 To configure hotkey PTT actions to the PTT boxes, click the 
Show all PTT boxes link, double-click the desired PTT box(es) to apply the 
changes, then assign a hotkey or a combination of hotkeys. 

 To configure specific non-PTT actions to PTT boxes (for example, mute 
channels or set default PTT channels), click the Create link to make the 
changes: 
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In the Action dialog box that appears, specify the following parameters: 
• HotKey 

Click the Configure button and on the keyboard, press the key or key 
combination you want to assign as a hot key for the selected action. 

• Caption 
Enter a caption that will be displayed in the Dispatch Console. 

• Action 
From the drop-down list, select the desired action: 
 Default PTT channel 

Selected PTT box functions as a default PTT channel. 
 Mute channels 

This action mutes selected PTT boxes. 
 Unmute channels 

This action unmutes selected PTT boxes. 
 Voice from channels 

This action mutes voice from all PTT boxes except for selected one(s). 
 Terminate All Transmissions 

This action terminates all transmissions for selected PTT boxes. 
• Channels 

In the list below, select PTT boxes to assign the actions specified above. 
 To enable displaying the configured hot keys in the Dispatch Console, 

select the Show actions panel option. 
All the hot keys you have configured are displayed in the upper part of the Dispatch 
Console: 
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• View > Add Radio Interface Tab 
Choose this menu item to add a new Radio Interface tab to the Radio Interface 
pane. 

 

 In the Configure Voice Boxes dialog box, specify the following PTT box 
parameters for the new radio interface: 
• Name 

Enter a name for the radio interface. 
Other parameters can be configured in the same way as when Configuring 
PTT Boxes. 

The user can switch between Radio Interfaces by clicking on the tab bar in the upper 
part of the Radio Interface pane. 
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• View > Delete Radio Interface Tab 
Choose this menu item to delete the Radio Interface tab currently selected in 
the Radio Interface pane. 

Note: The default Radio Interface tabs can't be deleted. 

• View > Show Channel Selector Box 
Select this menu item to display a separate PTT box that allows selecting a 
channel. 

 

Click the arrow of the drop-down list and select the channel for this PTT box. 
• View > Show Call Type Buttons 

Select this menu item to display the Call Type buttons in PTT boxes. 
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• View > Show Keypad Panel 
Select this menu item to display the Keypad panel in PTT boxes. 

 

Note: The Keypad panel will be displayed only when the Num 
button is pressed in the Call Type Buttons panel. 

• View > Audio Message Library 
Choose this menu item to add configured Voice Messages to the Queued 
Messages panel. For how to configure Voice Message settings, see Tasks, 
Voice Message. 

 

 In the Saved Audio Files dialog box, specify the following parameters: 
• Filename 

The name of the message displayed in the Queued Messages panel. 
• Description 

Enter a description for the Voice Message. 
• Severity 

From the drop-down list, select the severity level (Information, Alarm, or 
Warning). 

• Hot Key 
Click the Hot Key button and press the key or key combination you want 
to assign as a hot key for the selected Voice Message box. 
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• Visibility 
From the drop-down list, select how to display the selected Voice 
Message box: 
 Hidden 

Hide the Voice Message box. 
 Button 

Display the Voice Message as a button (1). 
 Link 

Display the Voice Message as a link (2). 

 

 
• View > Extended PTT boxes 

Select this menu item to display PTT boxes as shown: 

 

• View > Large PTT boxes 
Select this menu item to display PTT boxes as shown: 

 

• View > Medium PTT boxes 
Select this menu item to display PTT boxes as shown: 
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• View > Small PTT boxes 
Select this menu item to display PTT boxes as shown: 

 

• View > Custom PTT boxes 
Select this menu item to display PTT boxes as shown: 

 

• View > Show Active Calls Panel 
Select this menu item to display the Active Calls panel in the Dispatch Console. 
See also Configuring Active Calls panel. 

• View > Show Quick Commands Panel 
Select this menu item to display the Quick Commands panel in the Dispatch 
Console. 

• View > Show Queued Messages Panel 
Select this menu item to display the Queued Messages panel in the Dispatch 
Console. 

• View > Show Cross Patch Panel 
Select this menu item to display the Cross Patch panel in the Dispatch Console. 

• View > Telephony Tab 
Select this menu item to display the Telephony tab in the Radio Interface pane. 

• View > Show Extended Messages Tab 
Select this menu item to display the Extended Messages tab in the Radio 
Interface pane. 

• View > Show Radios Tab 
Select this menu item to display the Radios tab in the Radio Interface pane. 

The Extended Messages and Radios tabs appear on the top of the Calls pane: 
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6.3.3 Map 
• Select Location Tracking (1) in the Navigation pane to enable Map Options: 
• Click the Map menu (2). 

 

The Map menu contains the following items: 

 
• Map > Select Active Map 

Click this menu item to select the map to display in the Dispatch Console. 
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 Enter the Caption of the map that will be displayed in the Dispatch 
Console. 

 In the list of Available Maps, choose the map to be displayed. 
 You can also add a custom map using the URL. 

Click the Add button. 

 

• Enter the Name for the new map. 
• Enter the URL, as shown in the example. 
 Z 

Enter the zoom value for the map. 
 X 

Enter the latitude coordinate (X-direction). 
 Y 

Enter the longitude coordinate (Y-direction). 
• Map > Save Online Map Data 

Click this menu item to save your current map region. 
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In the dialog box, specify the following parameters: 
 Expire tiles days 

Enter the time the saved offline map will be stored before it is automatically 
updated. 

 Redownload all tiles 
Select this option to re-download the map tiles before saving to your PC. 

 Zoom level 
Move the slider from left to right to increase the detail level of the map. 

 Show tiles preview 
Select this option to show how the map is divided into tiles. 

 Show tiles progress 
Select this option to show the progress bar while the online map is being 
saved. 

 Click Start and wait for the system to save the files. This may take several 
minutes. 

• Map > Map Content 
Click this menu item to specify the folder and settings to store the map data. 

 

In the Online Map dialog box, specify the following settings: 
 Cache folder 

Click Change and locate the folder on the PC where you wish to store the 
map data. 

 Update 
Enter the update interval for the map data stored in the specified Cache 
folder. 

Note: The value 0 means that the map data won't be updated. 

 Map Type 
From the drop-down list, select the map type. For more details on the maps 
used in TRBOnet Dispatch Console, see section 6.3.3.1, Map Types 
(page 106). 

6.3.3.1 Map Types 

Online maps: 

 OpenStreetMap – free online maps. Includes MAPNIK, CYCLE, 
TRANSPORT, and LANDSCAPE subtypes. For more details on 
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OpenStreetMaps, visit the official the website: 
http://www.openstreetmap.org 

 Microsoft BING – commercial maps from Microsoft. Includes 
BING_ROAD, BING_AREA, and BING_HYBRID subtypes. A user may use 
BING maps for 90 days and then they must get a Basic Key. Visit 
http://msdn.microsoft.com/en-us/library/ff428642.aspx to get a Basic Key. 

Offline Maps: 

 TRBOmap – internal map-making resource. A user can customize a part of 
online maps according to requirements. For more details on map 
calibration, read the following article at: 
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=27. 

 TMap – internal map-making resource. A user can create an offline copy of 
online maps for selected regions according to requirements. A user can 
create a map from any picture via the TRBOnet Map Edit application. 
Click Start > All Programs > Neocom Software > TRBOnet Map Edit 
For more details on map calibration, read the following article at: 
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=28. 

 Beacon 2D – two-dimension offline map for Indoor positioning. A user can 
create maps using the Beacon2DMapGenerator tool. To get 
Beacon2DMapGenerator, contact your local TRBOnet dealer. 

 Beacon 3D – three-dimension map for Indoor positioning. A user can use 
any DirectX file as a map. 

• Map > Print 
Click this menu item to print the map region currently displayed in the Map 
pane. 

• Map > Geocoding 
Click this menu item to configure geocoding servers in the Dispatch Console. 

 

 Load data from the TRBOnet server if local one is unachievable 
Select this option to allow the Dispatch Console to receive GPS data from 
the TRBOnet Server PC. 

 For other settings, see section 5.8.1.1, Configuring Geocoding Servers 
(page 27). 

• Map > Open New Map in Tab 
Click this menu item to add a new map tab to the Map pane. 

http://www.openstreetmap.org/
http://msdn.microsoft.com/en-us/library/ff428642.aspx
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=27
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=28
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 Map Type 
From the drop-down list, select the map type. 

 Caption 
Enter a caption for the new map tab. 

 For other settings, see Selecting Active Map. 
Once you have clicked OK, the new tab will appear in the Map pane: 

 

• Map > Open New Map in Window 
Click this menu item to create a new map window with the specified map. 
 For required settings, see Selecting Active Map 
Once you have clicked OK, the new Map window will appear: 

 

• Map > Google Earth 
Click this menu item to open the Google Earth application. 
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Note: Google Earth must be previously installed on the PC. For 
more details, see the following article at 
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;Ite
mID=79. 

• Map > Delete Routes on Google Earth 
Click this menu item delete all routes from Google Earth. 

• Map > Show Radios on Google Earth 
Click this menu item and in the drop-down menu select which radios to 
display on Google Earth. 

6.3.4 Tools 

 
The Tools menu contains the following items: 

• Tools > Event Viewer in Window 
Click this menu item to open the Event Viewer in a new window. 

 

• Tools > Recent Calls/Events in Window 
Click this menu item to open Recent Calls/Events in a new window. 

http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=79
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=79
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 Click Playback to play back the selected call. 
 Click Save to save the selected call as an audio file. 

In the 'Save As' dialog box, locate the folder where you want to save the 
audio file, specify the file name, and from the drop-down 'Save as type' list, 
select the format (*.wav or *.tna) for the audio file. 

 Click Add Note to add a note to the selected call. 

 

• Enter the text of the note in the text box. 
• You can extend the form of a note by clicking the Add Extension link 

and adding new fields and their possible values to the form. 
• Tools > Job Ticketing Monitoring 

Click this menu item to open the window that visually represents the job 
tickets created by dispatchers and assigned to radios. 
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In this window, you can perform the following actions: 
 Select a time period for which to display Job Ticketing data. 
 Monitor tickets created by dispatchers. 
 Monitor tickets assigned to radios. 
All data are shown in the form of status diagrams. 

• Tools > Radios in Window 
Click this menu item to open a new window that displays the radios present in 
the system. 

 

In this window, you can make radio calls, send text messages. In addition, you 
can select to display radios by groups and statuses. 

• Tools > Telephony in Window 
Click this menu item to open a new window that displays the Telephony 
system present in the system. 
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In this window, you can make and receive telephone calls. 
• Tools > Telemetry Monitoring 

Click this menu item to open the window that displays configured telemetry 
profiles for the radios. 

 

 From the Show drop-down list, select the Telemetry profile to display. 
See also section 6.4.8, Telemetry (page 192). 

• Tools > Text Messages in Window 
Click this menu item to open a new window to manage text messages. 

 

In this window, you can perform the following tasks: 
 View sent messages in the upper-right pane. 
 Select online dispatchers and radio groups in the left pane, or by clicking 

the ellipsis (…) button in the lower-right pane. 
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 Type messages in the text box in the lower-right pane. 
 Send messages by clicking the Send button in the lower-right pane. 

• Tools > Routes in Window 
Click this menu item to open a new window to manage routes. 
For more details on Route Management configuration, see section 6.8, Guard 
Tour / Route Management (page 288). 

• Tools > Camera in Window 
Click this menu item to open a new window with a camera view. 

 

In this window, the selected camera view will be shown. 
 Camera 

From the drop-down list, select a camera that is connected to TRBOnet 
Dispatch Console. 

 Size 
From the drop-down list, select either Fit to Window so that the video will 
automatically be stretched/shrunk to fit the window, or Original to retain 
the original video size, regardless of the window size. 

See also section 6.4.6, IP Cameras (page 185). 
• Tools > Reset All GPS Triggers 

Choose this menu item to stop/start GPS triggers on all radios. 
• Tools > Terminate All Transmissions 

Click this menu item to terminate all voice sessions. 
This action is a "hard" request to stop all "hung" transmissions in the TRBOnet 
software. If a radio communication session is not allowed to be interrupted on 
a repeater or base station, it will only be stopped for the TRBOnet software. 

6.3.4.1 Options 
• On the Tools menu, click Options. 
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Sound 
 In the Options dialog box, click the Sound tab. 

• Use Sound Notifications 
Select this option to enable sound notifications in the Dispatch Console. 

• Select the event in the list and specify the sound. 
• From the Sound drop-down list, select ether 'Sound by default' to play 

default sound, or 'Disabled' to disable sound notification for the event. 

• Click  to listen to the sound notification for the selected event. 
• Click Select and browse for the sound file on your PC. 

 Alarm of Emergency Call duration 
Enter the time value, in seconds, for the duration of the alarm tone when 
an emergency call is received. 

Map 
 In the Options dialog box, click the Map tab. 
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• Map refresh interval 
Enter the time period, in seconds, to update map data. 

• Show the directions of motion 
Select this option to display a direction of motion for map objects. 

• Show names of objects  
Select this option to display object names on the map. 

• Show PTT on map 
Select this option to allow the dispatcher to make private calls by 
clicking a corresponding radio icon on the map. 

• Select the image size 
From the drop-down list, select the size of a radio icon. 

• Select the default image type 
From the drop-down list, select the default image type of a radio icon. 

• Path to Google Earth exe file 
Click the ellipsis (…) button and specify the location of the Google Earth 
exe file on your PC. 

Coverage Map 
TRBOnet Dispatch Console allows displaying RSSI levels on a map. The RSSI is a 
received signal strength indicator. It measures the power level of the signal at a 
radio's receiver. The RSSI maps can be used by radio system engineers to plan a 
further extension of their radio networks. 

 In the Options dialog box, click the Coverage Map tab. 

 

• Draw in Dots 
For a more detailed data view, choose this option to display on the map, 
dots of RSSI levels representing coordinate points. 
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• Draw Coverage Zone 
For a less detailed view, choose this option to configure and display on 
the map, RSSI zones of average RSSI levels using GPS coordinates. 
 RSSI Zone Size 

Enter the size of the RSSI zone within which RSSI levels will be 
averaged. 

 

• Click Add to add a new RSSI level. 
 Value 

Enter the minimum level for the signal range (for example, -65 means 
-65 and higher). 

 Description 
Enter a name of the RSSI level to display in the system. 

 Color 
Pick a color for the RSSI indicator on the map. 

To view RSSI Levels on the map, click the Location Tracking tab in the 
Navigation pane and on the Map pane's toolbar, click Coverage Map. Then 
set the Start Date and End Date to display RSSI data. 

Hardware 
 In the Options dialog box, click the Hardware tab. 
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• Use external hardware 
Select this option to use external hardware devices, for example, mic 
connectors. 
 Serial port 

From the drop-down list, select the COM port the device is connected 
to. 

 TRBOnet footswitch 
Select this option to use the TRBOnet foot pedal as a PTT button. 

• Use signaling device 
Select this option to use an external signaling device. 
 Serial port 

From the drop-down list, select the COM port the signaling device is 
connected to. 

• Click Configure and specify the duration of a signal and which call types 
to include in signaling. 

 

The USB Devices table displays the connected USB devices 
(Type/Name/Description). 
• Click the Add link, and from the pull-down menu select the type of the 

USB device with a PTT button connected to the PC (HID, DirectX, or 
TIPRO). 

• In the dialog that opens, specify the desired parameters and click OK. 
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• First VoIP port 
Enter the number of the first VoIP port for audio communications (4022, 
by default). Each additional Dispatch Console will create a connection on 
the next port number. 

• First IP Camera port 
Enter the number of the first IP Camera port for video communications 
(13152, by default). Each additional Dispatch Console will create a 
connection on the next port number. 

• Use proxy server 
Select this option to enable Proxy Server service in TRBOnet Dispatch 
Console to access the Internet. 
A proxy server can be used when a user's computer cannot be 
connected directly to the Internet, but there is another computer with 
Internet access in the network. 
 Click the Configure link to specify the alternative server settings. 

 

Advanced 
 In the Options dialog box, click the Advanced tab. 
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Configuration Scope 

 Per machine 
Choose this option to store settings in a common place for all dispatchers 
of the Dispatch Console. 

 Per user 
Choose this option to store settings for each dispatcher separately if they 
are using different Windows user accounts. 

PTT Options 

 Tone and PTT when using external PTT device 
Select this option to enable Alert Tone for all subscribers on a channel when 
the dispatcher presses the PTT button on an PTT external device. 

 Use Record Mode with external PTT 
Select this option to record all voice transmissions from external PTT 
devices (Palm mics, Footswitches, and other devices). 

 Suggest Queued Message when channel is busy or subscriber radio is 
offline 
Select this option to record a Queued Voice Message when a radio channel 
is busy or subscriber is offline. 

 Enable Short Press PTT 
Select this option to start and finish voice calls by a short press of the PTT 
rather than keeping the PTT pressed until the end of a voice call. 

 Use 'Space' key to press PTT 
Select this option to use a hot key for the PTT. Click the Configure link and 
on the keyboard, press the key you want to assign as a hot key for the PTT 
button. 

Voice Options 

 Mute other dispatchers 
Select this option to mute all other dispatchers voice transmissions. 

 Mute radio-to-radio private calls 
Select this option to mute all private calls on the channel. 

 Mute all receive sources during voice input 
Select to mute all Voice Notifications when Dispatcher transmits or records 
audio. 

 Automatically set channel to Solo when transmitting audio 
Select this option to mute other channels when transmitting audio. 

 Automatically unmute channel when transmitting audio 
Select this option to automatically unmute a channel when transmitting 
through this channel. 
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View Options 

 Customize the automatic subscriber name pattern 
Select this option and click the Configure link to set a custom alias for a 
radio in the list of subscribers. Once the changes are made, selecting this 
check box will cause a change to the radios in the Radio list pane (upper left 
pane of the Main Interface screen). 

 

• Radio display name 
Click the ellipsis (…) button and in the Format dialog box pick the fields 
to display for a radio. 

 

• Allocated radio display name 
Click the ellipsis (…) button and in the Format dialog box pick the fields 
to display for an allocated (taken) radio. 

• Allocated radio display name 
(the owner has more than one radio) 
Click the ellipsis (…) button and in the Format dialog box pick the fields 
to display for an allocated (taken) radio in case when a user has more 
than one radio. 

• Click Defaults to set default settings for radio display. 
 Show extended notes 

Select this option to enable Extended Notes in the Dispatch Console. 
The Extended Notes feature is intended to add predefined Extended Notes 
templates, the same as for Extended Messages, for the selected calls and 
events. 
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For example, a Taxi Dispatcher needs to check clients' calls response period 
for the company internal monitoring of the employees. They can add a 
predefined template and check the time period. All Extended Notes are 
displayed in the Ext. Note column in the Recent Calls/Events tab: 

 

Click the Extended Notes button (1) to fill the template; 
Click the View button (2) to see the Extended Note. 

 Show confirmation dialogs 
Select this option to enable confirmation dialogs for dispatcher actions. For 
example, when sending a configured Voice Message from the Dispatch 
Console, the following confirmation dialog box will appear: 

 

 Enable pop-up window to display incoming Text Message 
Select this option so that incoming Text Messages will pop up over the 
application window. 

 

 
 Enable pop-up window to display incoming Request to Talk 

Select this option so that incoming Request to Talk messages will pop up 
over the application window. 
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 Close button minimizes application 
Select this option so that clicking the Close button will minimize the 
Dispatch Console rather than close it. 

 Minimize button minimizes to Voice Bar 
Select this option so that once you click the Minimize button you will see 
only the Voice Bar displayed at the top of the PC's screen. 

 Queue all incoming telephone calls 
Select this option so that when the telephone line is busy, incoming calls 
will be queued rather than rejected. 

 Max items in "Recent calls/Events" 
Enter the maximum number of items to display in the Recent calls/Events 
pane. 

 Measurement system 
From the drop-down list, select either the Metric or the US unit system. 

 Coordinate system 
From the drop-down list, select the coordinate system to be used. 
• On Map 

Select this option to display coordinates on the map. 

Audio 
 In the Options dialog box, click the Audio tab. 

 

Default audio devices 

 Recorder 
From the drop-down list, select the recording device the microphone is 
connected to. 
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 Player 
From the drop-down list, select the audio device to play incoming voice 
messages and playback voice recordings in the Dispatch Console. 

Note: If TRBOnet Dispatch Console is running on the same PC 
with TRBOnet Server connected to control stations via 
programming cable and sound card, the playback and 
recorder devices cannot be the same for TRBOnet Dispatch 
Console and TRBOnet Server. 

 Customize Selected channel speakers and volume parameters. 
 Customize Unselected channel speakers and volume parameters. This 

option is intended for radio channels which are not selected in Dispatch 
Console. 

 Customize Intercom speakers and volume parameters. This option is 
intended for Intercom Voice session between the dispatchers. 

 Customize System sounds speakers and volume parameters. 
For the list of system sounds, see section Sound (page 114). 

 Customize SIP Interconnect speakers and volume parameters. This option 
is intended for SIP calls. 

Alarm 
 In the Options dialog box, click the Alarm tab. 

 

 Always show radio on map 
Select this option so that radios in alarm mode will always be displayed on 
the map. 

Note: When this option is selected, you cannot disable the display 
of radios in alarm mode. 
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 Display camera in separate window 
Select this option so that when a radio is in alarm mode, a window will 
open with the camera associated with the radio. 

 Display radio in separate window 
Select this option to display a radio in alarm mode on the selected map in a 
separate window. 
• Map 

This field displays the map name. Click the Select map link and specify 
the map on which to display a radio in alarm mode. 

6.3.4.2 Exporting/Importing Options 
A dispatcher can export custom Dispatch Console settings (Volume level, UI view, 
hotkeys configuration, and other settings) as a .config file and save it to the local PC 
or to a selected external device. 

• Click Tools > Export Options and save the file to the specified location. 
If you want to apply settings from a different TRBOnet Dispatch Console: 

• Click Tools > Import Settings and browse for the .config file with the desired 
settings. 

6.3.4.3 Setting Language 
• On the Tools menu, click Set Language 

 

 From the drop-down list, select the desired language and click OK. 
The changes will apply after you restart the Dispatch Console. 

6.3.4.4 Changing Password 
• On the Tools menu, click Change Password 
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 In the Old password box, enter your current password. 
 In the New password box, enter the new password. 
 In the Repeat password box, enter the new password again. 
 Click OK. 

6.3.5 Help 
• Help > Send Feedback 

Click this menu item to send your feedback to Neocom Software, either 
through E-mail, or online via the site. 

• Help > Save System Logs 
Click this menu item to save the logs as a .zip file. This .zip file can then be sent 
to Neocom support. 

• Help > About 
Click this menu item to see the About dialog displaying information about 
TRBOnet PLUS (applied license, version, build date, and other relevant 
information). 

6.4 Administration 
Click the Administration tab to set system elements and options. 
Click the Administration tab (1), and see the full system information on the Server 
(2) pane: 
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6.4.1 Database 
Go to Administration (1), Database (2) to see the full overview of the database: 

 

In the Database pane, the administrator can restore and back up the database and 
audio recordings. 
For more details on backups, see Appendix A: Backing up and Restoring Database 
and Audio Recordings (page 323). 

6.4.2 Radio Systems 
All radio systems registered in the Server are represented on the Radio Systems 
pane. 
Go to Administration (1), Radio Systems (2) to see the system parameters: 

 

The administrator is able to see the following radio system parameters in the table: 
• System Type - the type of the system. 
• System ID - a unique System Identifier configured in TRBOnet Server 

configuration for repeater or control stations in the system. 
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• Caption – the caption of the system. 

6.4.2.1 Radio System Properties 
To see the radio system properties, do the following: 

• Select a radio system in the list and click the Properties button (1); 
or, 
double-click the radio system in the list; 
or, 
click the corresponding element at the bottom of the Dispatch Console 
window, and choose Properties (2). 

 

The administrator is able to see Active and Inactive registered systems. In case you 
have more than 10 registered systems, systems are grouped and can be seen in the 
drop-down list. 
Common information for all system elements is listed below: 

Description tab 

On the Description tab, you can see the general info: 
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• System Type 
The system type for a repeater/control station (in Digital or Analogue mode). 
For more details on the systems, see section 3.2, MOTOTRBO Radio Systems 
(page 4). 

• System ID 
The Unique System Identifier configured in TRBOnet Server for a repeater or 
control stations in the system. 

• Caption 
Enter the system name. 

Channels tab 

On the Channels tab, you can see System Element properties: 

 

• Click the Properties button to see the channel additional data: 
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 ID 
Default registration number (manufacturer’s number); 

 Name 
System element’s name in the system; 

 Type 
System type for a repeater/control station (in Digital or Analogue mode). 

 Mode 
System type for a repeater/connection mode for a control station. 
For details on the control station modes, see section 5.9.3.1, Control Station 
Connection Modes (page 36). 

 Connected 
• Serial number 

Default system element’s serial number (manufacturer’s number). 
• Firmware Version 

Current system element’s firmware version. 
• Click the Reset button to test the connection to the system element. 

Note: For a repeater, clicking the Reset button reconnects the 
repeater. 
For a control station, clicking the Reset button reloads the 
radio. 

Talk groups tab (for repeaters only) 

 On the Talk groups tab, you can see selected Talk group info: 
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 Specify available Talk groups for the system element in the list of created 
Talk groups. 
Selected Talk groups are available on the Radio tab in the system element 
box in the drop-down list: 

 

Note: Close TRBOnet Server before applying the system element 
settings. 

Volume tab (for repeaters only) 

 On the Volume tab, you can see Volume settings for the repeater: 
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• Specify the RX and TX volume levels for the Repeater using a volume 
control slider. 

• Click the Reset link to set default volume level for RX or TX. 
• Configure system volume 

Select this option to save default volume settings for Voice transmissions 
from the selected Repeater. 

Transmits tab 

• On the Transmits tab, you can see the information about audio and data 
transmissions: 

 

 Record audio 
Select this option to enable audio recordings for the selected repeater. 

 Manage Audio by DTMF 
Select this option to manage audio on the selected channel by specified 
DTMF tones. 
• Mute channel 

Enter a DTMF sequence to be used to mute the selected channel. 
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• Unmute channel 
Enter a DTMF sequence to be used to unmute the selected channel. 

6.4.3 System Bridging 
TRBOnet Dispatch Console provides the System Bridging function. System Bridging 
allows configuring the network to redirect calls. 
Administrator can create two types of System Bridging: 

1. System Bridging for Master stations – allows connecting all types of Radios 
(analogue and digital radios, supports IP Site Connect, Capacity Plus, Linked 
Capacity Plus and Connect Plus modes). 

2. System Bridging for repeaters - allows connecting only the repeaters in the 
IP Site Connect mode. 

Go to Administration (1), System Bridging (2) to add System Bridging to the 
system: 

 

• Click the Add button (3) to add a Cross Patch. 
From the drop-down menu, select the System Bridging type. 

Radio System Bridging 
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 Name 
Specify a name for System Bridging to display in Radio Interface. 

 Work mode 
Select the work mode from the drop-down list. For more details on System 
Bridging types, see 6.4.3.1, System Bridging Types (page 134). 

 PTT Button 
set PTT on the System Bridging interface to be able to transmit voice or do 
not set only to hear the voice from other channels. There are 3 options 
available: 
• Enable when a Bridge enabled 
• Always Enabled 
• Invisible 

 On the Channels tab, click the Add button (1) to add a channel to the list. 
 In the Radio System column, select a radio channel from the drop-down 

list (2). 
 In the Group column, select available group for the radio channel (3). 
 In the Mode column, select a mode for the radio channel (4). 

• Always 
Enables System Bridging always, regardless of the radio status 
(online/offline). 

• By Radio 
Enables System Bridging on a selected channel when there are online 
radios capable to receive voice calls from the selected group. 

 On the Parameters tab, specify call types for System Bridging: 

 

 Select call types to use in System Bridging mode. 
 Click OK to add System Bridging for the radio channels. 
The System Bridges are displayed on the Cross Patch panel of the Radio 
Interface pane: 
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6.4.3.1 System Bridging Types 
1. Channels redirect the calls to each other 

This is the most common type of System Bridging when data exchanges 
between the channels set in the System Bridging settings. Thus, there is a 
common channel for all the subscribers of the specified control stations: 
To create this mode of System Bridging, add a System Bridging and set the 
Work Mode as Channels redirect the calls to each other. 
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To create this type of System Bridging, add a System Bridging and set the 
Work Mode as A Channel redirects calls to many Channels. 

3. Many channels redirect calls to one channel 

Radio network 
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Radio network 
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Radio network 
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Control Station

Control Station

Control Station
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Voice Call via System Bridging
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To create this type of System Bridging, add a System Bridging and set the 
Work Mode as Many Channels redirect the calls to one Channel. 

Binary Patch (for IP Site Connect only) 

 

• Name 
Specify a name for the Binary Patch to display in Radio Interface. 

• Rules 
Specify the rules for System Bridging to redirect calls. 
 Check Voice/Data to transmit on the selected slot. 
 Select available Call types. 
 Select available Groups for System Bridging from the drop-down list. 
 Select available Repeaters to redirect calls in System Bridging from the 

drop-down list. 
The Binary Patches are displayed on the Cross Patch panel of the Radio Interface 
pane: 
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Note: System Bridging can also be created by drag and drop of 
the PTT boxes in Radio Interface. It is a temporary System 
Bridging; it will be deleted after reconnecting to TRBOnet 
Server or exiting TRBOnet Dispatch Console. 

6.4.4 Telephony 
Click Administration (1), and then Telephony (2) to configure incoming and 
outgoing SIP calls: 

 

6.4.4.1 Radio Calls Configuration 
Click the Configure button (3) to set radio call configuration parameters: 
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• Allow subscribers to make outgoing calls 
Select this option to enable outgoing phone calls from the radio subscribers. 

• Allow to use DTMF 
Select this option to allow radio subscribers to dial the phone number as a 
sequence of DTMF tones. 

• Allow to use Text Messages 
Select this option to allow radio subscribers to initialize phone calls via sending 
TMS messages with a specified prefix to the dispatcher. 
 Prefix 

Enter the standard prefix for a text message. 
• Play the incoming call tone on the radio 

Select the mode for playing the incoming call tone on the radio that initiates a 
call. 
 After the called party answers the call 

When a radio initiates a phone call to a subscriber via DTMF tones or a TMS 
message, the incoming call tone will be played on the radio after the called 
party answers the call. 

 Immediately 
When a radio initiates a phone call to a subscriber via DTMF tones or a TMS 
message, the incoming call tone will be played on the radio immediately 
that is without waiting for the called party to answer the call. 

• Initialize call to radio 
Select the option how to start a call on a radio. 
 Start transmission 

Select to start a call to a radio automatically. 
 Send ring tone 

Select to play a ring tone until the radio user presses the PTT. 
• Initialize call timeout 

Specify a timeout that defines how long to attempt to connect to the called 
party. 
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• Execute Check Radio before call 
Select this option to execute a Check Radio command before placing a call. 

• Send text message if cannot establish call 
Select this option to send a text message to the radio when the channel is 
busy and a phone call cannot be established. 

• Play tone when PTT changed 
Select this option so that the phone will sound a tone when the remote radio's 
PTT is pressed or released. 

• DTMF Access Code 
Set the value to that configured for the radios as Access Code in 
MOTOTRBO CPS (see Appendix B: SIP Setup for Motorola Phone System, 
section Programming Radios). 

• DTMF Deaccess Code 
Set the value to that configured for the radios as Deaccess Code in 
MOTOTRBO CPS (see Appendix B: SIP Setup for Motorola Phone System, 
section Programming Radios). 

6.4.4.2 Incoming Calls Configuration 
Click the Configure button (4) to set incoming call configuration parameters: 

 

• Call to Dispatch Center 
Select the mode for handling incoming calls made to the dispatcher. 
 Decline calls 

All incoming phone calls will be declined. 
 Open voice menu 

When an incoming call arrives, the subscriber will hear Voice menu 
commands. 

 Redirect to dispatchers 
All incoming voice calls will be redirected to all dispatchers of the Dispatch 
center and any free dispatcher will answer the phone call. 
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• Call to external number 
Select the mode for handling incoming calls made from unregistered 
subscribers. 
 Decline Calls 

Select this option to decline all phone calls from unregistered subscribers. 
 Use number as Radio ID 

Select this option so that the system will use unregistered numbers as a 
Radio ID and start a Private Call. 

 Use number as Internal 
Select this option to allow the system to read unregistered numbers 
according to Voice Menu rules. 

Extension numbers (Voice menu) 

• Start call automatically 
Select this option to search for the number in the Extensions table 
automatically. When this option is disabled, the subscriber must dial the 
number according to the following example: 0(phone number)#. The 
character # is used to search for the phone number in the table. 

• Max. number length 
Specify the maximum number of characters allowed in a phone number. 

• Accept Code 
Specify the character that will be used to finish dialing the number. 

All available numbers are listed in the table below. 
• Click the Add link to add a number to the table. 

To add a static number 

 Choose Static number. 

 

 Number 
Enter a phone number to add to the table (contact list). 

 Call Type 
Select the call type from the drop-down list. 
• Call Dispatcher 

Select this type to make a phone call to the dispatcher. 
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• Call Radio 
Select this type to make a phone call to the selected radio. 

• Call Group 
Select this type to make a phone call to the selected group. 

 Channel 
Select the channel to make a group phone call through (available for Group 
Calls only). 

 Dispatcher/Radio/Group 
Select the dispatcher, radio, or group depending on what you have selected 
in the Call Type box. 

To add a dynamic number 

 Choose Dynamic number. 

 

 Prefix 
Specify a prefix to type in on the keyboard. 

 Call Type 
Select the call type from the drop-down list. 
• Call Radio 

Select this type to make a phone call to a radio. 
• Call Group 

Select this type to make a phone call to a group. 
• Call Phone 

Select this type to make a phone call to a telephone. 
 Channel 

Select the channel to make a group phone call through (available for Group 
Calls only). 
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6.4.4.3 Ring Tones Configuration 
To configure ring tones, click the Configure button (5): 

 

On the Active Line (Inactive Line) tab: 
• Click a corresponding link in the Ring Tone column, and from the pull-down 

menu, select either Set Default, Set Custom, or Disable. 
If you select Custom, in the dialog box that opens, browse for the audio file on 
the local PC and click Open. 

• Click a Play link in the Action column to play back the corresponding ring 
tone. 

On the Hold Line tab: 

 

• Remind after 
Enter the timeout, in seconds, that will be used for playing the reminder tone 
when a call is on Hold. 

• Ring Tone 
Specify the reminder tone to be played when a call is on Hold. 
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6.4.4.4 Adding SIP Extensions 
Click Administration (1), Telephony (2), Extensions (3), Add > SIP Phone (4) 

 

In the Phone User dialog box, specify the following parameters: 

 

• SIP ID 
Enter the SIP ID that will be used by the phone user. 

• SIP Name 
Enter the SIP user name that will be used by the phone user. 

• Caption 
Enter the caption to be displayed for the phone user. 

• Password 
Enter the password for the phone user to be authenticated by the telephone 
system. 

• Password (repeat) 
Enter the password again. 
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6.4.5 Tasks 
Go to Administration (1), Tasks (2) to see the list of the tasks created in the system: 

 

Note: After you have created a task you need to enable it. Just select the 
check box (3) beside the task you want to enable. 

6.4.5.1 Dispatcher Presence Control 
When enabled, this feature checks the presence of dispatchers and sends 
notifications to interested parties if the specified dispatchers are not present in the 
system. 

• Click Tasks (1), and double-click Dispatcher Presence Control (2) in the Tasks 
pane. 

 

• In the Dispatcher Presence Control dialog box, specify the following options: 
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 Presence timeout 
Enter the time period, in minutes, that will be used as a timeout to check for 
the presence of dispatchers. 

 Reminder time 
Enter the time period, in seconds, that will be used to show a reminder 
pop-up dialog before the planned time of performing the check. When the 
reminder appears on top of the screen, the dispatcher must click the round 
button in the center to confirm their presence in the system. 

 All Dispatchers 
Choose this option button so that all dispatchers will be checked for 
presence. 

 Selected Dispatchers 
Choose this option button so that only selected dispatchers will be checked 
for presence. 
• Dispatchers 

In the drop-down list, select the dispatchers. 
 Notifications 

Click this link to select who will receive the appropriate notifications. The 
recipients may include dispatchers, Email groups, SMS groups, radios, and 
radio groups. 

6.4.5.2 Agenda 
The Agenda is used to automatically send predefined messages to the radios. It may 
be used when you have any software receiving any messages but it is not able to 
send them to the subscribers. In this case, TRBOnet Dispatch Console acts as an 
intermediary for receiving the messages from the folder and sending them to radios. 

• To add an agenda, select Tasks (1), and click Add > Agenda (2). 
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• In the Agenda dialog box, specify the following parameters. 

 

 Task name 
Specify a name for the task. 

 Outgoing folder (on server) 
Specify the outgoing folder for the text messages to be displayed in the 
Dispatch Console (for example, C:\Outgoing). 

 Incoming folder (on server) 
Specify the incoming folder for the reports (for example, C:\Incoming 
files); 

 Wait for response 
Specify the time interval, in seconds, for the response. 

 Text to confirm 
Specify the text to be sent by the subscribers after they receive the 
message. 

6.4.5.3 Recorder 
The Recorder feature allows connecting to an audio recorder via IP. 

• To enable the task, select Tasks, and click Add (1) > Recorder (2): 
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The feature allows replicating audio recordings to the recorder: 

 

• Task name 
Specify a name for the task. 

• IP 
Enter the recorder's IP address. 

• Port 
Specify the recorder's port number. 

• Click Test of channels to view all available channels on the recorder. 
• Click OK to add the task. 

6.4.5.4 Import Beacon Data from Firebird DB 
The Import beacon data from Firebird DB option allows import beacon data from 
Firebird database to TRBOnet Dispatch Software database. 
To enable the task, select Tasks, and click Add (1) > Import beacon data from DB 
"Firebird" (2): 
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• Name 
Specify a name for the task. 

• Server 
Specify a remote server or a server on the local PC. 

• User 
Type in a name of the Firebird DB user. 

• Database path 
Specify the Firebird DB path. 

• Password 
Specify a password to connect to Firebird DB (provided at logon). 

• Port 
Specify the port number to connect to Firebird DB. 

• Update (sec.) 
Specify the update period for Firebird DB. 

• Click Test to test the connection to Firebird DB. 
• Click the Import tab to specify Import settings: 
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• Import data from 
Specify the Firebird DB name. 

• Click Import to import data. 
• Delete old data 

Select this option to delete all previously imported data from Firebird DB. 
• Report 

In this box, an import report will be displayed. 
• Click OK to add the task. 

6.4.5.5 Export Data 
TRBOnet Dispatch Console provides the Export Data function, which allows 
exporting data to an external database table. 

• To add an Export Data task, select Tasks (1), and click Add > Export Data (2): 

 

• In the Export Data dialog box, specify the following parameters: 
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Connection tab 

• Task name 
Specify a name for the task. 

• Type 
Select the type of data export from the drop-down list. TRBOnet Dispatch 
Console allows exporting data for third-party systems using data export tasks. 
 Export to database table 

Allows exporting data to MS SQL Server tables. Specify MS SQL Server 
connection parameters, database, and table to export data. 

 Export to Versatrans 
Allows exporting data to the Versatrans data collection system via IP. For 
more details, visit the official website of Versatrans. 

 Export to Google 
Allows exporting data to file (file format is KML). For more details, visit the 
following website. 

 Export to NMEA 
Allows exporting data to a file (text file format, export format is NMEA 
0183). For more details, visit the following website. 

 Export to file 
Allows exporting data to a text file. 

• Data 
Select which data to export from the drop-down list. 

• Default connection 
Choose this option for default connection to SQL Server. 

• Specified connection 
Choose this option and specify the SQL Server and database name. 

• Server name 
Specify the SQL server name. 

http://www.tylertech.com/solutions-products/versatrans-product-suite
http://en.wikipedia.org/wiki/Keyhole_Markup_Language
http://en.wikipedia.org/wiki/NMEA_0183
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• Database name 
Select the database from the drop-down list. 

• Windows authentication 
Select this option to use Windows authentication, or deselect it to use SQL 
Server authentication (SQL Server user name and password will be required). 

Data tab 

 

• Table 
the name of the table to be exported into external database (by default, the 
name of the table is created after you have specified it in Create table dialog 
box). 

• Click the Load columns list link to update the columns list in case you have 
made any changes to the table. 

• Click the Create table link to add a new table for data export: 

 

 Select the data fields to add to the table. 
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Scheduler tab 

 

• Days of week 
In the drop-down list, select the days of the week on which to export the data. 

• Execute recurrently with interval 
Choose this option to perform data export on a periodic basis. 
 Start time 

Specify the time at which to start data export. 
 Stop time 

Specify the time at which to stop data export. 
 Repeat every 

Specify a time period for periodic data exports. 
• Execute at particular time 

Choose this option and specify the times in the columns of the table below. 

Advanced tab 
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• Export only changed data 
Select this option to export only changed location of the radio data. 

• Export mode 
Choose the mode for exporting data. 

6.4.5.6 Geofencing 
The Geofencing feature allows controlling the location and speed of radios relative 
to manually defined regions on the map. 
The Geofencing monitoring consists of the manually defined regions and the tasks. 
The regions specify where to apply the rules, while the tasks specify how to apply 
the rules for the regions and radios. 

• Click Tasks (1), and double-click Geofencing (2) in the Tasks pane. 

 

The administrator can add/disable/delete the rules for Geofencing as well as edit 
the currently selected rules: 
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• Click the Add Rule button (1) and select the appropriate rule from the drop-
down list (Map Region, Beacons, Radios, Lone Worker) to add a rule to the 
current Geofencing configuration. A new rule will be displayed in the list of 
rules (4). 

• Click the Disable rule button (2) to disable the selected rule. 
• Click the Delete rule button (3) to delete the selected rule. 

General tab 

• Name 
Specify the rule name. 

• Description 
Add a description of the rule. 

• Run the rule on a schedule 
Select this option and in the boxes below specify the schedule for the rule to 
run. 
 Days of week 

In the drop-down list, select the days of the week on which to run the 
Geofencing rule. 

 Start time 
Specify the start time to run the rule. 

 Stop time 
Set the time to stop running the rule. 

• Reset Alarm mode when the rule conditions are no longer met 
Select this option to reset Alarm mode after the rule is triggered. 

Location tab 

 

Trigger this rule when a subscriber: 
• Enters the selected regions 

Select this option so that the rule will be triggered as soon as a subscriber 
enters the selected region. 
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• Leaves the selected regions 
Select this option so that the rule will be triggered as soon as a subscriber 
leaves the selected region. 
For multiple nested/overlapping regions 
Choose one of the options specifying for multiple regions whether to consider 
only outer border of the group of regions, or any border of a region within the 
group. 

Perform the following actions: 
Here you specify which actions to execute when the rule is triggered. 

• Activate Alarm mode 
Select this option to activate an Alarm mode in the Dispatch Console. 

• Activate Lone Worker mode 
Select this option to automatically activate a Lone Worker mode for the radio 
in case of entering or leaving the selected region. 

• Send Text Message to the source radio 
Select this option to automatically send a text message to the radio when it 
enters or leaves the selected region. 

• Send notification 
Select this option to send a notification when the radio enters or leaves the 
selected region. Click the Recipients link and specify the recipients to send the 
notification to. 

• Send Request to Talk to the source radio 
Select this option to automatically send a Request-to-Talk to the radio when it 
enters or leaves the selected region. 

Speed tab 

 

Trigger the rule when a subscriber: 

• Moves faster than 
Select this option and specify the maximum allowed speed for the vehicles. 
The rule will be triggered when the vehicle with the radio exceeds this speed 
limit. 



TRBOnet Dispatch Console 

155 

• Moves slower than 
Select this option and specify the minimum allowed speed for the vehicles. The 
rule will be triggered when the vehicle with the radio drops below the 
specified speed. 

• Stands still for longer than 
Select this option and specify the time period, in seconds, during which the 
vehicle is allowed to stand still. The rule will be triggered when the vehicle with 
the radio stands still for longer than this specified time period. 

• Track speed in relation to regions 
From the drop-down list, select where to track the speed of the vehicles: inside 
or outside the selected regions, or independently of the region. 

Regions tab 

 

 
• All regions 

Choose this option to apply this rule for all regions. 
• Only selected regions 

Choose this option to apply the rule for one or several regions. 
• Select all 

Click this button to select all regions in the list. 
• Deselect all 

Click this button to deselect all regions in the list. 
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Radios tab 

 

• All radios 
Choose this option to apply this rule for all radios. 

• Only selected radios 
Choose this option to apply the rule for one or several radios. 

• Select all (1) 
Click this button to select all radios in the list. 

• Deselect all (2) 
Click this button to deselect all radios in the list. 

• Collapse all (3) 
Click this button to collapse the view of radios in the list. 

• Expand all (4) 
Click this button to expand the view of radios in the list. 

•  (5) 
Click this button, and from the drop-down menu, select which list to display: 
Radio List, Radio Groups, or Logical Groups. 

Lone Worker tab 
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• All Tasks 
Choose this option to execute all Lone Worker tasks configured by the 
administrator when the rule has been triggered. 

• Only selected tasks 
Choose this option, and in the list below, select the Lone Worker tasks to be 
executed when the rule has been triggered. 

Variable settings for Geofencing rules of event types (Map Region, Beacons, Radios 
and Lone Worker) are represented in the table below: 

Event type Tab Name Parameters Description 

Common Settings General Name – specify the rule name; 

Description – add the rule description; 

Scheduler Run the rule on a schedule - select to start a scheduler 
for Geofencing rules; 

Days of week - select the days of the week on which to 
activate the Geofencing rule; 

Start time - set the time at which to start the rule; 

Stop time - set the time at which to stop the rule. 

Radios All radios – choose to apply this rule for all radios; 

Only selected radios – choose to apply the rule for one 
or several radios; 

Select all – click to select all radios in the list; 

Deselect all – click to deselect all radios in the list. 
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Event type Tab Name Parameters Description 

Map Region. 

Allows configuring 
rules when a 
radio(s) enters or 
leaves the defined 
map region(s). 

General Regions Control – select to enable regions control; 

Control mode – select the control mode for regions in 
the dropdown list; 

Activate Alarm mode if the rule has been triggered – 
select to activate Alarm mode in the Dispatch Console if 
Regions Control rule has been triggered;  

Send Text Message to a radio if the rule has been 
triggered – select to inform radio subscriber if Regions 
Control rule has been triggered;   

Activate Lone Worker if the rule has been triggered – 
allows automatically activating a Lone Worker policy for a 
radio in case of entering or leaving exact region on map.  
Select to enable this option. 

Speed and Idle Control – select to enable speed and 
idle control; 

Control mode – select the control mode for speed and 
idle control in the dropdown list; 

Maximum Speed – set the maximum speed for radio; 

Maximum Idle Time – set the maximum idle time for 
radio; 

Activate Alarm mode if the rule has been triggered – 
select to activate Alarm mode in the Dispatch Console if 
Speed and Idle Control rule has been triggered 

Send Text Message to a radio if the rule has been 
triggered – select to inform radio subscriber if Speed 
and Idle Control rule has been triggered; 

Send Call Alert to a radio if the rule has been 
triggered – select to inform radio subscriber if the rule 
has been triggered; 

Reset Alarm mode if the rule is not triggered - select 
to inform radio subscriber if the rule has not been 
triggered. 

Scheduler See above. 

Regions. 

Select regions 
to apply the rule 

All regions – choose to apply this rule for all regions; 

Only selected regions – choose to apply the rule for one 
or several regions; 

Select all – click to select all regions in the list; 

Deselect all – click to deselect all regions in the list. 

Radios See above. 

Lone Worker. 

Enables Lone 
Worker when 
the rule has 
been triggered 

All Tasks – choose to apply all tasks configured by the 
administrator when the rule has been triggered; 

Only selected tasks – choose this option, and in the list 
below, select the Lone Worker tasks to be executed when 
the rule has been triggered. 
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Event type Tab Name Parameters Description 

Beacons. 

Allows configuring 
rules when a radio 
(s) enters or leaves 
the beacon 
coverage zone 

General Control mode: 

Control entering beacon coverage zone – select to 
enable the rule when a radio enters beacon coverage 
zone; 

Control leaving beacon coverage zone - select to 
enable the rule when a radio leaves beacon coverage 
zone; 

Activate Alarm mode if the rule has been triggered -  
select to activate Alarm mode in the Dispatch Console if 
Beacons rule has been triggered; 

Reset Alarm mode if the rule is not triggered – select 
to reset Alarm mode in the Dispatch Console 
automatically if the rule condition was not triggered (for 
example, when Control entering beacon coverage zone 
is selected and the radio enters the monitored coverage 
zone and then instantly leaves the zone, the alarm mode 
in the Dispatch Console will be reset automatically) 

Send Call Alert to a radio if the rule has been 
triggered – select to inform radio subscriber if the rule 
has been triggered;   

Send Text Message to a radio if the rule has been 
triggered – select to inform radio subscriber if Beacons 
rule has been triggered; 

Activate Lone Worker if the rule has been triggered – 
allows automatically activating a Lone Worker policy for a 
radio in case of entering or leaving beacon coverage 
zone. Select to enable this option. 

Scheduler See above. 

Radios See above. 

Beacons. 

Enables the rule 
for selected 
beacons 

All Beacons – choose to apply this rule for all beacons; 

Only selected beacons – choose to apply the rule for 
one or several beacons. 

Lone Worker See above. 
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Event type Tab Name Parameters Description 

Radios. 

Allows using 
radio(s)1 as a map 
region and monitor 
when another 
radio(s) enters or 
leaves radio’s 
coverage zone 

General Control mode: 

Control Entering Region – select to enable the rule 
when a radio enters the coverage zone associated with 
another radio; 

Control Leaving Region - select to enable the rule when 
a radio leaves the coverage zone associated with another 
radio; 

Activate Alarm mode if the rule has been triggered -  
select to activate Alarm mode in the Dispatch Console if 
Radios rule has been triggered; 

Reset Alarm mode if the rule is not triggered – select 
to reset Alarm mode in the Dispatch Console 
automatically if the rule condition was not triggered (for 
example, when Control Entering Region is selected and 
radio enters to the monitored coverage zone and then 
instantly leaves the zone, alarm mode in the Dispatch 
Console will be reset automatically) 

Send Text Message to a radio if the rule has been 
triggered – select to inform radio subscriber if Radios 
rule has been triggered; 

Send Call Alert to a radio if the rule has been 
triggered – select to inform radio subscriber if the rule 
has been triggered;   

Minimum distance between radios – specify the 
distance, in meters. When a distance is less than the 
selected value, the rule will be triggered according to the 
settings above. 

Color of region – select the radio coverage zone color. 

Scheduler See above. 

Regions Select radio coverage zones the rule is applied for. 

Radios See above. 

Lone Worker. 

Allows configuring 
scheduled Lone 
Worker tasks 

General Days of week - select the days to activate the Lone 
Worker rule; 

Start time - set the time to start the rule; 

Stop time - set the time to stop the rule. 

Radios See above. 

Lone Worker Select all configured by Administrator Lone Worker tasks 
or several configured tasks. 

When a Lone Worker task is mentioned as Disabled, the 
administrator should enable the task. 

6.4.5.7 Idle Time 
The Idle Time feature allows monitoring vehicles idle time assigning Telemetry 
Commands on selected VIOs. 

• Click Tasks (1), and double-click Idle Time (2) in the Tasks pane. 
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Specify the telemetry command to set the Idle Time: 

 

Start 

• Specify the telemetry VIO and Command to start the Idle Time. 

Stop 

• Specify the telemetry VIO and Command to stop the Idle Time. 
The administrator can see Idle Time reports and statistics. 
Click Reports (1), and under GPS reports, click Idle Time Summary or Idle Time 
detailed (2) to see a common Idle Time report: 
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Note: Specify the speed accuracy value in the Speed box (3). 

6.4.5.8 Lone Worker 
The Lone Worker policy lets the dispatcher set a time interval the communication 
with a subscriber is expected. For example, if a lone worker has not called the 
dispatcher for 15 minutes, the radio receives a message and the Dispatcher receives 
an alarm signal. 

• To add a Lone Worker task, select Tasks (1), and click Add > Lone Worker (2). 

 

• In the Lone Worker dialog box that appears, specify the following parameters: 

 

Task Start tab 

• Manually by dispatcher 
Select this option to start the Lone Worker task manually by the dispatcher. 
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• Automatically by receiving Text Message from a radio 
Select this option so that the Lone Worker task will start after receiving a 
message from a radio. If you select this option, specify a text message in the 
Message box. 

• Automatically by receiving Telemetry Command from a radio 
Select this option so that the Lone Worker task will start after receiving a 
telemetry command from a radio. If you select this option, specify the VIO 
contact, and from the Command drop-down list, select the signal level at 
which the user's radio should send the telemetry command. 

• Automatically by receiving DTMF command from a radio 
Select this option so that the Lone Worker task will start after receiving a 
predefined DTMF command, for instance, #11#. If you select this option, 
specify a DTMF combination without the # characters in the Command box. 

• Automatically by receiving Status from a radio 
Select this option so that the Lone Worker task will start after receiving a 
specified status from a radio. If you select this option, specify Status. 

• Send the following text message to the radio 
Select this option and in the Message box enter the text message that will be 
sent to the radio when a Lone Worker task is started for that radio. 

Conditions tab 

 

• Response time 
Specify the time period, in minutes, that determines how long TRBOnet Server 
waits since the last radio transmission. 

• Send notification to radio 
Select this option so that TRBOnet Server will send a notification to the radio 
before raising the alarm if the radio has not transmitted for the specified time 
period. 
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 Reminder time 
Specify the time period before it comes to raise the alarm, to send a 
notification asking the radio to respond. 

 Send Request to Talk 
Choose this option to send a Request-to-Talk to the radio. 

 Send Text Message 
Choose this option to send a text message to the radio. Specify the 
message text in the Message box. 

• Reset Lone Worker when receiving Text Message 
Select this option to reset the Lone Worker task after receiving the message 
specified in the Message box. 

• Reset Lone Worker when receiving Telemetry command 
Select this option to reset the Lone Worker task after receiving the telemetry 
command. If you select this option, specify the VIO contact, and from the 
Command drop-down list, select the signal level at which the user's radio 
should send the telemetry command. 

• Reset Lone Worker when the distance has been traveled 
Select this option to reset the Lone Worker task after the distance specified in 
the Distance box has been traveled. 

• Do not trigger alarm if radio is offline for less than 
Select this option so that the alarm is not triggered if the radio is offline for a 
time less than the time specified in the Interval box. 

Task Stop tab 

 

In the Task Stop tab, you can specify how to stop the Lone Worker task. The 
available options are similar to those you specified on the Task Start tab. 
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Enabling Lone Worker 

• To enable the Lone Worker task for a selected radio, go to Voice Dispatch (1), 
right-click the selected radio (2), and choose Start Lone Worker (3): 

 

• To monitor the Lone Worker task, click the Active Tasks tab: 

 

Enabling Lone Worker from Geofencing 

• Click Location Tracking (1), and click the Geofencing button (2) in the Map 
pane: 
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• In the Geofencing and Speed Control dialog box, click 
Add Rule > Lone Worker (1): 

 

 Specify a Name for the Lone Worker rule and add a Description. 
 Days of week 

In the drop-down list, select the days of the week on which to activate the 
Lone Worker rule. 

 Start time 
Specify the time at which to start the rule. 

 Stop time 
Specify the time at which to stop the rule. 

• Click the Radios tab and add radios to which to apply the Lone Worker rule: 
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 All radios 
Choose to apply this rule to all radios. 

 Only selected radios 
Choose to apply the rule to one or several radios. 

 Select all 
Click to select all radios in the list. 

 Deselect all 
Click to deselect all radios in the list. 

• Click the Lone Worker tab and select the configured Lone Worker tasks: 

 

 Choose either all configured Lone Worker tasks or several configured tasks. 

Note: When a Lone Worker task is mentioned as Disabled, enable 
it on the Tasks pane. 

6.4.5.9 Radio Allocation (Sprite Forms) 
This function is used for direct communication between the dispatcher and the 
subscriber via special Tallysman Option board installed into the radio. The 
dispatcher and subscriber have special form templates. The dispatcher receives Duty 
ID of the subscriber with his template output form whereas the subscriber sends it 
using his template input form. The radio name changes to its Duty ID. 
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Note: Any activity may be decoded with its Duty ID so this is a 
way to communicate for the dispatcher and subscribers 
only. 

• Click Tasks (1), and double-click Radio Allocation (Sprite Forms) (2) in the 
Tasks pane. 

 

• Load the Sprite Form (output template) and select the Field Name: 

 

• Click OK to add a Sprite Form. 

6.4.5.10 Scheduled Task 
This function allows sending scheduled messages to radios. 

• To add a scheduled task, click Add (1) > Scheduled task (2): 
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 Task name 
Specify a name for the task. 

 Command 
From the drop-down list, select what to send to selected radios. 

Send Text Message 

• Message 
Enter the message text in this box. 

Send Telemetry 
Select this command to send scheduled telemetry commands to selected 
radios/groups, or request telemetry states from selected radios/groups. 

• VIO 
Specify the VIO contact. 

• Command 
From the drop-down list, select the signal level at which to send the 
telemetry command to selected radios/groups, or select 'Request state' 
to receive telemetry states from selected radios/groups. 
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Request Location 
Select this command to receive location data from selected radios/groups. 

 Send to radio group 
Choose this option to send the specified command to selected radio 
groups. 

 Send to subscribed radio 
Choose this option to send the specified command to selected radios. 

 Recipient 
In this list, select the radio groups/radios to send the specified command to, 
or receive telemetry/location data from. 

Send Voice Message 
Select this command to send a voice message to selected radios/groups: 

 

 Load from file 
Click this link to load an existing file from your PC. 

 Record Message 
Click this link to record a new voice message. 

 Play back message 
Click this link to play back the voice message. 

 Specify Call type, Channel, and Call Target for a voice message. 

Note: To send a Voice Message to a subscriber from the phone 
book, click the ellipsis (…) button in the Call Target column 
and select a contact from the phone book. 

 Impolite channel access 
Select this option so that the voice message will be sent regardless of 
whether the channel is busy or not. 
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Scheduler tab 

 

• Start date 
Select a date to start the task. 

• Stop date 
Select a date to stop the task. 

• Days of week 
In the drop-down list, select the days of the week on which to perform the 
task. 

• Execute recurrently with interval 
Choose this option to perform the task on a periodic basis. 

• Start time 
Specify the time at which to start the task. 

• Stop time 
Specify the time at which to stop the task. 

• Repeat every 
Specify a time period for periodic task executions. 

• Execute at particular time 
Choose this option and specify the times in the columns of the table below. 

6.4.5.11 SMS and Email Notifications 
TRBOnet Dispatch Console allows managing text messages: 

1. Send Text Messages from LAN to a particular radio or talk group (POP3 
Server); 

2. Forward all Text Messages from radios to base radio to particular email 
address (SMTP Server). 

Note: Microsoft Exchange Server can be used as SMTP and POP3 
servers. For more details on SMTP or POP3 servers, ask your 
System Administrator. 
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To enable the task, click Tasks (1), and double-click SMS and Email notifications 
(2) in the Tasks pane. 

 

SMS settings tab 

 

 Send SMS to recipients if ALARM has been activated 
Select this option to send an SMS in case of an alarm on the radio. 

 Send MMS to recipients if ALARM has been activated 
Select this option to send an MMS in case of an alarm on the radio. 

Forward Text Messages to cell phone recipients 

 Input messages (from radio network to dispatchers) 
Select this option to forward incoming text messages to cell phones. 

 Output messages (from dispatchers to radio network) 
Select this option to forward outgoing text messages to cell phones. 

For more details on SMS settings, see section 5.16.2, Outgoing Mail Server (page 87). 
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A radio sends text messages to the base station. TRBOnet Server forwards all text 
messages to a particular email address (for example, admin@yourcompany.com). 
The administrator receives text messages from radios as regular emails. 

Outgoing Email settings (SMTP) tab 

 

 Send Email to recipients if ALARM has been activated 
Select this option to send an Email in case of alarm. 

Forward Text Messages to email recipients 

 Input messages (from radio network to dispatchers) 
Select this option to forward incoming text messages to Email address(es). 

 Output messages (from dispatchers to radio network) 
Select this option to forward outgoing text messages to Email address(es). 

Incoming Email settings tab 

TRBOnet Server connects to POP3 server, reads emails and sends text messages to 
radios or talk groups. 

1. Create an email account on your email server. 
2. Send an email to radioserver@yourcompany.com. In the Subject field, enter 

Radio ID: XXX to send an email to a selected radio, or Group ID: XXX to send 
an email to a selected radio group. 

Note: If you don't properly specify the email Subject, or specified 
a non-existing Radio ID, a corresponding notification will 
appear in the Event Viewer of the Dispatch Console. 

• Forward incoming emails to radio network (from email box to radios) 
Select this option to forward incoming emails to radio network. 

6.4.5.12 User Activity 
The User Activity function allows the dispatcher to create lists of radios, to which 
radios can be assigned due to their activity. 

mailto:admin@yourcompany.com
mailto:radioserver@yourcompany.com


  

174 TRBOnet PLUS — User Manual 

For example, if a subscriber sends an On duty message or presses an exact preset 
telemetry button, this subscriber gets assigned to the On duty list in the Dispatch 
Console. The dispatcher can also manually assign subscribers to lists. 

• To enable the User Activity task, click Tasks (1), and double-click User Activity 
(2) in the Tasks pane: 

 

Lists of radios tab 

 

• Click Add to add a list of radio activities: 
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• Name 
Specify a name for the user activity list. 

• Description 
Add a description for the user activity list. 

• Background 
Select the background color to display the radios assigned to the list. 

Move a radio to this list if: 

• Manually by dispatcher 
Select this option to assign radios to the list manually. 

• Automatically by receiving Text Message from a radio 
Select this option to assign a radio to the list after receiving a text message 
from the radio. If you select this option, specify a brief text message in the 
Message box. 

• Automatically by receiving Telemetry Command from a radio 
Select this option to assign a radio to the list after receiving a telemetry 
command. If you select this option, specify the VIO contact, and from the 
Command drop-down list, select the signal level at which the user's radio 
should send the telemetry command. 

• Automatically by receiving DTMF command from a radio 
Select this option to assign a radio to the list after receiving a predefined 
DTMF command, for instance, #11#. If you select this option, specify a DTMF 
combination without the # characters in the Command box. 

To assign offline radios to the default User Activity list, click the Advanced tab: 
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• Automatically set the default status for offline radios 
Select this option to allow assigning the default status for offline radios. 

• Timeout 
Specify the time period, in minutes, after which the default status is set to a 
radio. 

6.4.5.13 Voice Message 
The Voice Message allows automatically broadcasting a predefined Voice Message 
after receiving a telemetry command, a text message or a DTMF command. 

• To add a Voice Message task, select Tasks (1), and click Add > Voice Message 
(2). 

 

The user can have several Voice Message policies for different purposes. Specify a 
name of the policy in the Task name box and set the policy's parameters. 
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Task Start tab 

 

• Manually by dispatcher 
Select this option to allow the dispatcher to manually start the Voice Message 
task. 

• Automatically by receiving Text Message from a radio 
Select this option to start the Voice Message task after receiving a specified 
text message from a radio. If you select this option, specify a brief text 
message in the Message box. 

• Automatically by receiving Telemetry Command from a radio 
Select this option to start the Voice Message task after receiving a telemetry 
command. If you select this option, specify the VIO contact, and from the 
Command drop-down list, select the signal level at which the user's radio 
should send the telemetry command. 

• Automatically by receiving DTMF command from a radio 
Select this option to start the Voice Message task after receiving a DTMF 
command from a radio, for instance, #11#. If you select this option, specify a 
DTMF combination without the # characters in the Command box. 

• Automatically by receiving Emergency from a radio 
Select this option to start the Voice Message task after receiving an emergency 
command from a radio.  
 Emg. Type 

From the drop-down list, select the type of emergency to be sent from a 
radio. 

• Activated by any radio 
Choose this option to expect receiving data from any radio in the system. 

• Activate by specific radios only 
Choose this option to expect receiving data from selected radios. 
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 Radio 
In the drop-down list, select the radio(s). 

• Send Text Message to a radio 
Select this option so that a text message will be sent to the radio that activated 
the Voice Message task. If you select this option, specify a brief text message 
in the Message box. 

Task Process tab 

 

• Send Voice Message once 
Choose this option to send the voice message to a selected radio (s) only 
once. 

• Send Voice Message repeatedly 
Choose this option to send the voice message repeatedly. 
 Repeat Interval 

Specify the repeat interval, in seconds. 
 Repeat Count 

Select this check box and specify the number of times to repeat the voice 
message. 

• Impolite channel access 
Select this option so that the voice message will be sent regardless of whether 
the channel is busy or not. 

• Start delay 
Select this check box and specify the delay time, in seconds, for the Voice 
Message task. 

Task Stop tab 

Note: These options are available only if you have selected the Send 
Voice Message repeatedly option in the Task Process tab. 
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• Manually by dispatcher 
Select this option to allow the dispatcher to manually stop the Voice Message 
task. 

• Automatically by receiving Text Message from a radio 
Select this option to stop the Voice Message task after receiving a message 
from a radio. If you select this option, specify a text message in the Message 
box. 

• Automatically by receiving Telemetry Command from a radio 
Select this option to stop the Voice Message task after receiving a telemetry 
command from a radio: If you select this option, specify the VIO contact, and 
from the Command drop-down list, select the signal level at which the user's 
radio should send the telemetry command. 

• Automatically by receiving DTMF command from a radio  
Select this option to stop the Voice Message task after receiving a DTMF 
command from a radio, for instance, #11#. If you select this option, specify a 
DTMF combination without the # characters in the Command box. 

• Send Text Message to a radio 
Select this option so that a text message will be sent to the radio that stopped 
the Voice Message task. If you select this option, specify a brief text message 
in the Message box. 
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Message tab 

 

• Load from file 
Click this link to load an existing file from your PC. 

• Record Message 
Click this link to record a new voice message. 

• Play back message 
Click this link to play back the voice message. 

• Specify Call type, Channel, and Call Target for a voice message. 

Note: To send a Voice Message to a subscriber from the phone 
book click the ellipsis (…) button in the Call Target column 
and select a contact from the phone book. 

Telemetry tab 
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• Send telemetry before starting task 
Select this option to send a telemetry command before the voice message is 
transmitted. 
 Specify the VIO contact number. 
 Select the signal level from the Command list. 
 Delay after sending 

Specify the time period, in seconds, to wait before sending the voice 
message after the telemetry command has been sent. 

• Send telemetry after stopping task 
Select this option to send a telemetry command after the Voice Message task 
is stopped. 
 Specify the VIO contact number. 
 Select the signal level from the Command list. 
 Delay before sending 

Specify the time period, in seconds, to wait before sending the telemetry 
command after the voice message has been sent. 

• Recipient 
In the drop-down list, select the radios/groups to send the telemetry 
command to. 

• Send Telemetry on every Voice Message 
Select this option to send the telemetry command to the selected 
radios/groups every time the voice message is sent, provided the voice 
message is repeatedly sent. 

6.4.5.14 Scheduled Report 
The Scheduled Report task allows reporting on selected parameters and sending 
these reports to selected Email subscribers groups. The user can have several 
Scheduled Report policies for different purposes. 

Note: Before configuring the task, you need to create a number 
of the Email groups to send reports to. For more details on 
Email groups, see section 6.4.14, Email Groups (page 219). 

• To add a Scheduled Report task, select Tasks (1), and click Add > Scheduled 
Report (2): 
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• Specify a name of the policy in the Task name box and set the policy 
parameters. 

 

• On the Report tab, select the type of a report for the Scheduled Report task. 
The report details and filter might be different. 
For more details on reporting, see section 7.3.5, Reports (page 322). 

• Click the Scheduler tab to configure a schedule for the report. 
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• Start date and Stop date 
Select the time period over which to generate reports and send them to email 
group. 

Note: The start date may be any date you choose to start the task 
on. The stop date must be later or the same as the current 
date. 

• Days of week 
In the drop-down list, select the days of the week you want to generate 
reports on. 

• Start time 
Specify the time to start generating the report at. 

• Statistic period 
Select the time interval (in minutes, hours, days, weeks, or months) to collect 
the data. 

• Email groups 
In the list, select Email groups to send the report to. 

The created scheduled report will be displayed in the Tasks pane: 
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To enable the task, select the check box in front of the Scheduled Report task you 
have already created. 
There are three types of the Scheduled Report status icons: 

• Green indicates an active task, meaning the task is enabled (checked). 
• Grey indicates an inactive task, meaning the task is disabled (unchecked). 
• Red indicates a disabled task, meaning the task period is up in the past. 

6.4.5.15 Automatic Data Retrieval 
The Automatic Data Retrieval task is used to automatically retrieve missing 
location data from the radio's option board. 

• Go to Administration, Tasks. 
• In the Tasks pane, click Add > Automatic Data Retrieval (Swift GPS). 

 

• In the dialog box, specify the following parameters: 
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 Maximum number of simultaneous requests  
Specify the maximum number of radios being requested at the same time. 

 Retrieve missing locations if the data gap exceeds 
TRBOnet Server automatically checks whether the location data is 
continuous. If it detects data gaps between any consecutive location data 
that exceed this value, it will attempt to retrieve missing information. 

 Don't retrieve missing locations older than 
TRBOnet Server doesn't check location updates for consistency if they are 
older than this value in seconds, minutes, or hours. 

 On the Radios tab, specify the radio(s) to retrieve location data from. 
In the list of tasks, activate the Automatic Data Retrieval (Swift GPS) task by 
selecting the checkbox next to the task name. 

6.4.6 IP Cameras 
This section describes how to connect IP cameras to TRBOnet Dispatch Console. 
Go to Administration, IP Cameras to manage IP cameras in the system. 

• In the IP Cameras pane, click the Add button. 
• In the IP Camera Configuration dialog box, specify the following parameters: 
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 Name 
Enter a name for the camera. 

 Description 
Enter a description for the camera. 

 URI 
Enter the URI for the camera. Note the use of the RTSP:// prefix and port 
number 5554. 

 Protocol 
From the drop-down list, select UDP. 

 Authorization 
• User 

Enter the user name for the authentication, if needed. 
• Password 

Enter the password for the authentication, if needed. 

6.4.7 Event/Alarm Management 
The Event/Alarm Management feature allows creating action rules for Alarms, 
Emails, Notifications, Text Messages to radios, and other events. When a configured 
rule is executed, the appropriate action will start. 
For example, an external application sends text data which contains the text "alarm" 
to TRBOnet software. The text "Alarm" is configured as the rule to start sending a 
predefined voice message (for example, "Alarm in Sector N") to selected radios (for 
example, the group "firemen"). As a result, the group "firemen" is notified about an 
emergency condition. 

• Go to Administration (1), Event/Alarm Management (2) to set Event/Alarm 
Management: 

 

• Click Add (3) to add a new Event/Alarm Management configuration. 
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• The administrator can create a copy of the existing Event/Alarm Management 
configuration. Select a configuration in the list and click the Create a Copy 
button. The system will create a copy with the same configuration parameters. 

• On the Source tab (1), click Add (2) to add a new data source for the action. 

 

 Event 
From the drop-down list (3), select the event type to set as a rule for the 
action. 
For the settings for various event types, see the table below: 

Event Type Parameters Description 

Text 
Message 

Activated by any radio – choose to receive text messages with predefined 
text from any radio in the system to enable the action; 

Activate by specific radios only - choose to receive text messages with 
predefined text from selected radios in the system to enable the action; 

Text Contains – specify the text or characters that the text messages from 
radios must contain to start the action selected in the Action page. 

Telemetry 

Activated by any radio – choose to receive telemetry data from any radio in 
the system to enable the action; 

Activate by specific radios only - choose to receive telemetry data from 
selected radios in the system to enable the action; 

VIO – specify VIO to send telemetry; 

Command – specify a command for selected VIO. 

DTMF 

Activated by any radio – choose to receive DTMF command from any radio 
in the system to enable the action; 

Activate by specific radios only - choose to receive DTMF command from 
selected radios in the system to enable the action; 

Command – specify DTMF command to start the action. 

COM Port 
COM Port – select the COM Port connection configured in Server; 

Regular Expression – specify the text or characters that the external 
application data must contain to start the action selected in the Action page. 
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Event Type Parameters Description 

External 
Network 
Connection 

Connection – select the connection configured in Server in the TCP/IP page; 

Regular Expression – specify the text or characters the external application 
data must contain to start the action selected in the Action page. 

Alarm 

Activated by any radio – choose to receive an alarm from any radio in the 
system to enable the action; 

Activate by specific radios only - choose to receive an alarm from selected 
radios in the system to enable the action; 

Alarm – select alarm type in the dropdown list. 

Emergency Alarm – alarm configured in the radio's codeplug; 

Man Down – radio's Man-Down monitoring; 

No Movement – radio's No-Movement monitoring; 

Crash Detect – radio's speed and sudden stop monitoring; 

Geofencing - control the location and speed of radios relative to manually 
defined map regions. 

Radio State 

Activated by any radio – choose to receive radio state data from any radio 
in the system to enable the action; 

Activate by specific radios only - choose to receive radio state data from 
selected radios in the system to enable the action; 

Radio is detected as online –  select to start the action when a radio is 
online; 

Radio is detected as offline - select to start the action when a radio is 
offline; 

Radio fixed GPS - select to start the action when a radio has fixed GPS 
signals; 

Radio lost GPS - select to start the action when a radio has lost GPS signals. 

 

Note: Select the event you want to enable. In case no event is 
selected, all configured events are disabled by default. 
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• Click the Location tab (1) to set the regions for the action. 
When the Location rule is enabled and a region is selected, the events 
specified in the Source tab must take place in the selected region to start the 
action. 

Note: When COM Port and/or External Network Connection 
are selected as the event source, the Location rule should 
not be used. 

 

 Enable 
Select this option to apply the Location rule to the action. 
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 All Regions 
Choose this option to use Source Event rule in all map regions to start the 
action; 

 Selected Regions 
Choose this option to use Source Event rule to start the action only in 
selected regions. 
• Region 

In the list, select the region(s). 
• Click the Action tab (1) to set actions for the Source Event and Location 

rules. 
In the Actions list, the administrator can add and configure the action types to 
be started when the rules configured in the Source and/or Location pages are 
executed. 

• Click Add (2) to add an action: 

 

 Action Type 
From the drop-down list (3), select the action type. 
For the settings for various action types, see the table below: 

Action Type Parameters Description 

Alarm Not applicable. 

Email 

Recipients – select email recipients in the drop-down list; 

Subject – enter the subject of the email to send to recipients; 

Variables –add variables to include in the email subject: 

Text – enter the email text to send to recipients; 

Variables –add variables to include in the email text: 

Job Ticket 

Deadline – select the task end time; 

Recipients – select the radios or radio groups registered in the system; 

Description – add a description for the Job Ticket; 
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Action Type Parameters Description 

Variables – add variables to include in Job Ticket description. 

Notification 

Severity – select the severity level from the drop-down list. 

Information – low severity level; 

Warning – middle severity level; 

Alarm –high severity level. 

Text – add text to the notification to display in the Dispatch Console; 

Variables – add variables to include in the notification. 

Request 
Location Not applicable. 

SMS  

Recipients – select SMS recipients from the drop-down list; 

Text – enter the SMS text to send to recipients; 

Variables – add variables to include in the SMS text. 

System 
Bridging 

Profiles – select the System Bridging profile to activate/deactivate; 

Activate/deactivate – choose the action type for the System Bridging 
profile. 

Telemetry 

VIO - select the VIO to send telemetry commands to; 

Command – select a signal level for the command for selected VIO; 

Recipients – select radios or radio groups to send telemetry commands to. 

Text 
Message 

Recipients – select text message recipients in the drop-down list; 

Text Message – enter the message text to send to recipients; 

Variables –add variables to include in the message text. 

Text to 
Speech 

The Text to Speech feature allows converting text to speech: 

 
1 – click the Add link to add a text to convert to speech; 

2 – configure Call Type, Channel and Call Target to send the text converted 
to speech. 

Text – enter the text to be converted to speech. 

Variables - add variables to include in the message to be converted to 
speech. 
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Action Type Parameters Description 

Voice 
Message 

Voice Messages – select recorded voice messages. For more details on 
Voice Messages, see section Voice Message. 

 

Note: After you configure the rule, enable it by selecting the 
check box beside it. In case when no rule is selected, the 
action will not be started. 

 

6.4.8 Telemetry 
On the Telemetry page you can configure settings for Telemetry. 

6.4.8.1 Radio Groups Telemetry 
This is a default telemetry profile that is used to send telemetry commands to radio 
groups. 

• Click Radio Groups Telemetry in the Administration pane. 
• In the Telemetry configuration pane, click Edit. 
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 Click Add and specify ID (VIO), Name, and Command (signal level). 

Note: For Radio Groups Telemetry only the Digital Outputs tab 
is available. 

6.4.8.2 Adding Telemetry Profile for Radios 
• Go to Administration (1), Telemetry (2), and click Add (3): 

 

 

 

 Specify Telemetry Type for Radio groups: 
• MOTOTRBO – telemetry from Motorola devices. 
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• Novox – telemetry from Novox devices connected to a radio via COM 
port. 

• Swift.Tracker – telemetry from Swift.Tracker sensors connected to a 
radio over-the-air. 

• Sprite – telemetry from Sprite devices. 

Note: Sprite telemetry profile can be read but not written. 

 Profile name 
Specify a name of the profile to display in the Dispatch Console. 

 Click OK. 

 

Common tab 

 Auto request input states 
Select this option and in the Request interval box specify the time interval, 
in seconds, to request input data. 

 Trace digital inputs 
Select this option to monitor digital input damages. 

 Trace analog inputs 
Select this option to monitor analog input damages. 

 Replace state event to VIO events 
Select this option to generate VIO ON/OFF event when the system 
compares between the last and the current states of the VIO. 

Note: Most of the policies are set to replace events, so it is 
recommended to enable this option. 
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Digital Inputs tab 

 

• Click Add to add a VIO (Virtual Input/Output) to the profile. 
 ID 

Select the VIO to set the parameters for. 
 Name 

Specify a name for the VIO to be displayed in the Dispatch Console. 
 Event 

Select the signal level of VIO events from the drop-down list. When an 
event with the selected signal level occurs on the selected VIO, the 
telemetry will be activated. The signal level must be the same in the radio's 
codeplug and in Telemetry configuration in TRBOnet. It is a programmable 
option that sets the pin's voltage level to High or Low in order to trigger a 
selected functionality. 

 Severity 
Specify a severity level for the VIO event from the drop-down list. 

 Display as subscriber state 
Select this option so that the radio will change its status after it sends the 
telemetry command. 

 Auto reset state 
Select this option to automatically reset the telemetry VIO after the radio 
sends the telemetry command. 

 Request location of subscriber 
Select this option to request a GPS position of the radio after it sends the 
telemetry command. 

 Click Apply to apply settings to selected inputs. 



  

196 TRBOnet PLUS — User Manual 

Digital Outputs tab 

 

• Click Add to add a VIO (Virtual Configured PIN) to the profile: 
 ID 

Select the VIO in the dropdown list to set its parameters; 
 Name 

Specify a name for the VIO to be displayed in the Dispatch Console. 
 Command 

Specify a signal level for the command to send to the selected VIO. 
 Click Apply to apply settings to selected outputs. 

6.4.9 GPS Profile 
The GPS Profile feature allows configuring different profiles of GPS update settings 
for built-in GPS receiver. GPS Profile overrides default GPS trigger configuration in 
Server settings. For example, fire emergency service has a number of departments in 
a city and needs to monitor current position of radio subscribers (firemen). The 
administrator can create a number of separate GPS profiles with different GPS 
tracking settings for each department. 

Note: The GPS Profile feature is available for MOTOTRBO 
Generation II radios, firmware version 2.4 or later. 

Go to Administration (1), GPS Profile (2). You can see the default GPS Profile 
settings (3) in the GPS Profile pane. 
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There is a default GPS Profile that the administrator can use and edit. 
The administrator can do the following: 

1. Use default GPS profile. 
2. Create a custom GPS profile: Add button. 
3. Edit a profile: Edit button. 

Note: In the default profile, the Name and Description cannot be 
changed. 

6.4.9.1 Adding a GPS Profile 
• In the GPS Profile pane, click the Add button. 

 

 GPS type 
Select the GPS type. 

 Profile name 
Enter a name of the profile. 
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• Name 
Specify a name for the GPS profile. 

• Description 
Add a description for the GPS profile. 

• Save GPS data to database 
Select this option so that GPS data is saved in TRBOnet database. 

• Manage trigger manually 
Select this option so that GPS triggering will be started manually by the 
dispatcher. 

• GPS channel type 
From the drop-down list, select a radio channel for sending location data to 
TRBOnet Server: 
 Non-scheduled 

This is a channel with regular GPS (Enhanced GPS not supported). 
 Scheduled 

This channel is available when the Enhanced GPS feature is configured in 
the radio system. 

 Non-scheduled with CSBK data 
This channel allows using CSBK (Control Signaling Block) while decoding. 

 Scheduled with CSBK data 
This is a channel with Enhanced GPS, which allows using CSBK (Control 
Signaling Block) while decoding. 

• GPS Priority 
This option is used when beacons are placed on the GPS maps. If the radio 
having a GPS fix enters the range of a beacon placed on the GPS map, its 
location tracking will be performed according to the selected priority. 
 Beacon 

Location tracking will be performed based only on the GPS coordinates of 
the beacons placed on the GPS map. 
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 GPS 
Location tracking will be performed based only on the GPS coordinates 
received from the radio. 

• GPS data 
Select this option to enable the user to select what GPS readings to send to 
TRBOnet Server. In the drop-down list, select which GPS data to include in a 
packet. 

• iBeacon data 
Select this option to enable sending iBeacon data to TRBOnet Server. In the 
drop-down list, select which iBeacon data to include in a packet: 
 Major, Minor (included by default and cannot be disabled) 
 UUID 

iBeacon's Universally Unique Identifier 
 TX Power, RSSI 

The strength of the beacon's signal as seen on the receiving device. 
• Periodic Trigger 

Select this option to set a periodic GPS trigger on a radio. The trigger is a 
request to the radio to send its GPS and/or iBeacon data at the specified time 
interval. 
 Interval 

Specify the update interval, in seconds. 
• Distance trigger 

Select this option to allow receiving GPS updates by a distance: 
 Distance 

A radio will send GPS updates if it exceeds a specified distance from the last 
GPS point, in meters. 

 Min. interval 
A radio will send GPS updates if it does not move within a specified period 
of time, in seconds. 

• Telemetry trigger 
Select this option so that a radio will send GPS and/or iBeacon data upon 
sending a Telemetry command. 

• Emergency Trigger 
Select this option so that a radio will send GPS and/or iBeacon data upon 
entering the emergency mode. 
 Show emergency mode for Radio when Emergency GPS message is 

received 
Select this option if you want a Dispatch Console operator to see the 
emergency status of a radio that transmitted location data. 

• Click OK to save the GPS profile settings. 
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To apply GPS Profile to a radio: 

• Go to Administration (1), Radios (2), select the radio in the table, and click 
Edit (3): 

 

 

 Click the General tab, and from the GPS Profile list select the GPS profile. 
 Select/clear the Location Enabled check box to enable/disable the location 

trigger. 

Note: The GPS Profile is only applicable when the 'Built-in GPS 
receiver' is selected in the GPS Source. 

6.4.10 Tools 
On the Tools page, you can find some useful tools. 

6.4.10.1 Swift.Tracker Configuration Tool 

Note: This tool is available only for TRBOnet Swift.Tracker v1.0 

In general, a MOTOTRBO™ portable radio comes with a standard option board 
factory-installed in the radio. 
The Generic Option Board replaces this standard option board and newer radios (for 
example, XPR 7550) are now manufactured with Generic Option Boards already 
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installed. Generic Option Boards can be flashed with custom firmware to provide 
additional functionality: Man Down, No Movement, Crash Detect, Lone Worker and 
event-driven GPS functionality. 
The Event-driven GPS feature provides a method to collect GPS data more 
frequently and to store and forward this GPS data by event. The feature also allows 
collecting and storing GPS data while the radio is out of coverage, and, upon 
request, provide the GPS data when the radio is back in coverage. 
Go to Administration (1), Tools, Swift.Tracker Configuration Tool (2) to manage 
Swift Tracker settings: 

 

Click Add (3) to add a configuration for Swift Tracker. 
• Name 

Specify a name for the configuration to apply to a radio or a group of radios. 
• Description 

Add a description for the configuration. 
• Set Defaults 

Click this button to enable default settings. 
• Import 

Click this button to import the Swift Tracker configuration from a file (*.sfc). 
• Export 

Click this button to save the Swift Tracker configuration as a file (*.sfc) to the 
PC. 
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On the General tab, set general settings for Swift Tracker: 

 

Modules 

• Enable GPS Tracker 
When the check box is selected, the GPS enabled radio will send its data to 
TRBOnet Server according to its Generic Option Board (GOB) settings. 

• Enable "No Movement" 
Select to enable No Movement feature. 

• Enable "Man Down" 
Select to enable Man Down feature. 

• Enable "Crash Detect" 
Select to enable Crash Detect feature. 

• Enable "Lone Worker" 
Select to enable Lone Worker feature. 

General Report 

• Number of Retries 
Specify the number of additional attempts to send GPS data to TRBOnet 
Server if the initial transmission fails. If the channel is busy, as data transfer is a 
high priority, then the Transmit Interrupt feature will automatically be enabled. 

• Retry Delay 
Select the time period between data transfer retries. 

Radio Settings 

• Network radio ID (CAI ID) 
Select the TRBOnet Server ID. ID = 13 is the default ID to route packets to 
TRBOnet Server. (An ID = 12 will route packets to a control station.) 

• Target Radio ID 
Select the target Radio ID for data transfer. In the case of a direct connection 
to the repeater, select the TRBOnet Server ID (TRBOnet Peer ID). 
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• Port 
Select the port number for data transfer. 

• Automatically Switch to Revert Channel 
Select this option to automatically transfer data via the revert channel. 

Note: If the radio does not have a revert channel, this option must 
be disabled. 

On the GPS Tracker tab, set GPS Tracker settings: 

 

GOB Data Storage 

• Save GPS data on passing distance every (m) 
Specify the distance a radio will travel before it saves its GPS data to the 
Generic Option Board's memory; the data is not added to the report. 

Adding Data to Report 

• Speed and Direction 
Select this options to receive radio speed and direction data. 

• Add Data to Report every (m) 
Specify the distance a radio will travel before it adds its GPS data to the report. 
The report will be sent to TRBOnet Server at the selected time (see the Report 
Period option). 

Note: The distance traveled before adding data to the report 
must exceed (greater than) the distance traveled before 
saving the data to the GOB. 

• Minimal Direction Angle 
Select the minimum direction angle to add data to the report automatically (if 
the radio reverses the direction, the current data will be added to the report 
automatically, and the next data recording will be started). 
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• Add Data to Report every (sec.) 
Specify the time period for the report. When the indicated time period is 
passed, the radio adds data to the report. 

Report Transmit Conditions 

• Report period (sec.) 
Select the time interval between the sending of GPS data to TRBOnet Server. 

• Passed distance is more than (m) 
specify the distance a radio will travel before it sends its GPS data report 
type in the distance. When the indicated distance is passed the Option Board 
sends the report. 

Note: The distance traveled before adding data to the report 
must exceed (greater than) the distance traveled before 
saving the data to the GOB. 

• Speed exceeds 
Specify the maximum speed. If the current speed is greater than the specified 
one, the radio will send data to TRBOnet Server. 

• Stop/Idle Time is more than (sec.) 
Select the stop/idle time. When the stop/idle time is greater than the indicated 
one, the radio sends data to TRBOnet Server. 

On the Tasks tab, set Man Down, No Movement, Lone Worker, and Crash Detect 
settings: 
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General 

• Activate the accelerometer on the radio switching on 
Select this option so that the accelerometer is enabled when the radio is 
turned on. 

• Disable alarm by button click 
Select this option to enable the radio to turn off the alarm notification by 
pressing any button on the radio. 

"Man Down" Settings 

• Activation angle - select activation angle to enable Man Down feature; 
• Pre-Alarm (1) Timeout (sec.) - select time period preceding pre-alarm Tone 

1; 
• Pre-Alarm tone (1) - select pre-alarm tone. All pre-alarm tones can be found 

in radio’s codeplug configuration. 

"No Movement" Settings 

• Vibration Threshold (%) - select max. vibration threshold for No Movement 
feature; 

• Pre-Alarm Timeout (sec.) - select time period preceding pre-alarm Tone 1; 
• Pre-Alarm tone - select pre-alarm tone. All pre-alarm tones can be found in 

radio’s codeplug configuration. 

"Lone Worker" Settings 

• Timeout (sec.) – select time period to enable Lone Worker alarm; 
• Pre-alarm tone - select pre-alarm tone. All pre-alarm tones can be found in 

radio’s codeplug configuration; 

Second Pre-Alarm Notification 

When pre-alarm tone (1) activates for Man Down, No Movement and Lone 
Worker, and there was no user’s activity (the radio remains unchanged), the second 
pre-alarm tone activates: 

• Timeout (sec.) - select time period preceding pre-alarm Tone 2; 
• Pre-Alarm tone - select pre-alarm tone. All pre-alarm tones can be found in 

radio’s codeplug configuration; 
• Volume Level Increase (%) - select the percentage of the Volume Level 

Increase for pre-alarm Tone 2; 
• Pre-Alarm Duration (sec.) - select pre-alarm Tone 2 duration. 

"Crash Detect" Settings 

• Crash Threshold (g) - select acceleration changing value to enable Crash 
Detect alarm notification; 

• Movement Stop Timeout – select the time period of movement stop to 
enable Crash Detect alarm notification; 
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• No Movement Timeout - select the time period of the radio without any 
movement to enable Crash Detect alarm notification; 

Emergency call 

• TRBOnet Emergency Timeout (sec.) - select time period preceding 
emergency tone to the Dispatch Console for Man Down, No Movement and 
Lone Worker options; 

• MOTOTRBO Emergency timeout (sec.) - select time period preceding 
emergency tone to the Dispatch Console. 

Note: MOTOTRBO Emergency Alarm should be set in radio’s 
codeplug. 

Sound notification after emergency call 

• Timeout (sec.) – select time period to repeat the alarm notification. To stop 
the alarm notification Dispatcher should disable alarm notification; 

• Tone – select the notification tone. All tones can be found in radio’s codeplug 
configuration. 

6.4.10.2 Templates for Extended Messages 
The Templates can be used for Extended Messages and Extended Notes. 
The Extended Messages feature is a special function allowing users to send detailed 
preconfigured templates containing necessary information to each other with the 
help of the special TRBOnet Dispatch Console application. 
This service has been created especially for clients who need to use more detailed 
and structured messages in their work. If the standard messages are not enough to 
contain all required information, you may use the Extended Messages service. 

• Go to Administration (1), Templates (2) to create a new template: 

 

• Click Add From File (3) to add a template from a file. 
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Note: Before adding a template from a file, save the created 
template to a custom directory. 

Select the directory where you saved the template and click OK to add the file. 
• Click Add (4) to create a new template: 

 

 Name (1) 
Specify a name for the template to display in the Dispatch Console (1). 

 Elements (2) 
Select elements to add to the template. Drag and drop the selected 
element to the desired place on the mail template box. 

 Template size (3) 
Specify the template dimensions and background color. 

 Click an element on the template. On the right side of the Template dialog 
box, you can see the selected element properties. 

Sending a template to a radio 

 

• Click Text Messages (1) 
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• Click the View menu, and select Show Extended Messages Tab (2) 
• In the Text Messages pane, click the Extended tab (3), and New message (4). 

 

• Select the template in the list (1). 
• From the drop-down list (2), select a radio to which to send the template. 
• Click Send to Radio (3) to send the template to a radio. 

6.4.10.3 Indoor 2D Map Converter 
TRBOnet Dispatch Console provides the Map Converter to use custom images as 
Indoor 2D Floor plans. The tool allows converting images to the BMAP format that is 
supported in Indoor Positioning. 

• Click Administration (1), Tools > Indoor 2D Map Converter (2). 

 

• Name 
Specify a name for the new Indoor 2D Map. 

• Image 
Click the ellipsis (…) button and locate the image (PNG, JPG, TIFF, GIS) on your 
computer. 
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• Directory 
Click the ellipsis (…) button and locate the folder where to save the converted 
Indoor 2D map on your computer. 

• Click Start to convert the image. 

To use the converted map 

• Click Location Tracking (1). On the Map menu, click Open New Map in Tab 
(2): 

 

 

• From the Map Type list box, select 'Beacon 2D'. 
• Click Add to and browse for the map you have converted. 
• Click OK to open the Indoor map in the Map pane. 

6.4.11 Disabled Radios 
TRBOnet Dispatch Console provides the Disable function that allows disabling a 
radio even when the radio is offline. The system will disable an offline radio as soon 
as it gets available. 



  

210 TRBOnet PLUS — User Manual 

Note: The dispatcher can disable a radio when they have relevant 
Access Rights (for more details on adding and editing 
dispatchers, see section 6.4.13, Dispatchers on page 213). 

• Go to Administration (1), Disabled Radios (2) to disable selected radio: 

 

• Click Disable Radio (3) and in the dialog box that appears: 

 

 Radio 
Select a radio from the drop-down list. 

 Unlock 
Select the time period after which the radio will be unlocked. 

 Reason 
Enter the reason for disabling the radio. 

 Click OK to disable the radio. 
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The Radio is added to the Disabled Radios list and is marked as Disabled in the 
Voice Dispatch pane: 

 

• Click Enable Radio (4) to enable selected radio. 
• Select a radio from the drop-down list and specify the reason to enable. 
• Click OK to enable the radio. 

6.4.11.1 Kill Radio 
The Kill Radio feature is available only when a Capacity Max system is used. 

Note: This operation is not reversible. If you kill a radio unit, it will be 
impossible to recover it. 

6.4.12 Dispatcher Groups 
The administrator can add, edit, and delete dispatcher groups in the system. 
Go to Administration (1), Dispatcher Groups (2) to work with dispatcher groups: 
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• Click Add (3) to add a dispatcher group. 

 

On the General tab, specify general parameters for the new dispatcher group. 
• Display Name 

Specify a name for the dispatcher group to display in the Dispatch Console. 
• Description 

Add a description for the dispatcher group. 
On the Call Group tab, specify the following parameters: 

 

• Radio ID 
Specify the Radio ID of the dispatcher group. 

Phone Call 

• SIP ID 
Enter the SIP ID that will be used by the dispatcher group. 
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• SIP Name 
Enter the SIP user name that will be used by the dispatcher group. 

• Password 
Enter the password for the dispatcher group to be authenticated by the 
telephone system. 

On the Request to Talk tab, specify the parameters that will be used by radios to 
request a call from the dispatcher group: 

 

• Automatically by receiving Text Message from a radio 
Select this option to request a call from the dispatcher group when a radio 
sends a predefined text message. If you select this option, specify a brief text 
message in the Message box. 

• Automatically by receiving Telemetry Command from a radio 
Select this option to request a call from the dispatcher group when a radio 
sends a predefined telemetry command. If you select this option, specify the 
VIO contact, and from the Command drop-down list, select the signal level at 
which the user's radio should send the telemetry command. 

• Automatically by receiving DTMF command from a radio 
Select this option to request a call from the dispatcher group when a radio 
sends the specified DTMF tones. If you select this option, specify a DTMF 
combination without the # characters in the Command box. 

• Automatically by receiving Status from a radio 
Select this option to request a call from the dispatcher group when a radio 
sends the specified Status to TRBOnet Server, for instance, 1. If you select this 
option, specify the Status. 

Once you have added the dispatcher group to the system, the appropriate PTT box 
will appear in the Radio Interface pane. 

6.4.13 Dispatchers 
The administrator can add, edit, and delete dispatchers in the system. 
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Go to Administration (1), Dispatchers (2) to work with dispatchers: 

 

• Click Add (3) to add a dispatcher. 

 

• On the General tab, specify general parameters for the new dispatcher. 
 Authentication 

Select the Authentication method from the drop-down list. 
Select TRBOnet Authentication to log on as a user registered in TRBOnet 
Dispatch Console users list. 
Select Windows Authentication to log on using the PC name. The system 
automatically shows the PC name as User Name. 

Note: The password is not required when Windows 
Authentication is used. 

Note: For more details on user access to Allocation Console, 
section see section 6.4.16, Users (page 221). 
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 User Name 
Specify a user name for the dispatcher registered in TRBOnet Dispatch 
Software users list. 

 Password 
Specify a password for the dispatcher. 

• Display Name 
Specify a name for the dispatcher to display in the Dispatch Console. 

• Description 
Add a description for the dispatcher. 

• Dispatcher Role 
Form the drop-down list, select the role of the dispatcher in the system 
(Administrator or Dispatcher). 

• Invisible to all other users 
Select this option to make the dispatcher invisible to other users. 

• Invisible to all except the assigned groups 
Select this option to make the dispatcher invisible to other users except for 
users belonging to the same group of dispatchers. 

• Allow multiple simultaneous logons  
Select this option to allow the dispatcher to use multiple instances of Dispatch 
Console simultaneously. 

On the Dispatcher Rights tab, select the available modules and specify the available 
access rights for the dispatcher. 

 

On the Radio Systems tab, specify the radio system(s) that will be available for the 
dispatcher. 
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• All Radio Systems are available 
Choose this option to make all radio systems available for the dispatcher to 
transmit and receive Voice and Data. 

• Only selected Radio Systems are available 
Choose this option and specify which radio systems will be available to the 
dispatcher. 
 Select the check box in the left column to add the corresponding radio 

system to the Radio Interface for the dispatcher. 
 Select the check box in the TX column to allow the dispatcher to make 

Voice calls using the corresponding radio system. When the check box is 
cleared in the TX column, the dispatcher cannot use the corresponding 
radio system to transmit voice and data. 

On the Radio Groups tab, specify radio groups to assign the dispatcher to. 
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• All groups are available 
Choose this option to make all groups in the system available for the 
dispatcher. 

• Only selected groups are available 
Choose this option and specify which radio groups will be available to the 
dispatcher. 
 In the list, select the groups to make them available for the dispatcher. 

On the Dispatcher Groups tab, select dispatcher groups the dispatcher will belong 
to: 

 

On the Dispatch Call tab, specify Dispatch Call and SIP call settings for the 
dispatcher: 

 

• Radio ID 
Specify the Radio ID of the dispatcher. 



  

218 TRBOnet PLUS — User Manual 

• Phone number 
Specify the dispatcher's phone number (additional data). 

• Email 
Specify the dispatcher's Email (additional data). 

Phone Call 

• SIP ID 
Enter the SIP ID that will be used by the dispatcher. 

• SIP Name 
Enter the SIP user name that will be used by the dispatcher. 

• Password 
Enter the password for the dispatcher to be authenticated by the telephone 
system. 

• SIP Profile 
From the drop-down list, select the SIP profile to use. 

On the Request to Talk tab, specify the parameters that will be used by radios to 
request a call from the dispatcher: 

 

• Automatically by receiving Text Message from a radio 
Select this option to request a call from the dispatcher when a radio sends a 
predefined text message. If you select this option, specify a brief text message 
in the Message box. 

• Automatically by receiving Telemetry Command from a radio 
Select this option to request a call from the dispatcher when a radio sends a 
predefined telemetry command. If you select this option, specify the VIO 
contact, and from the Command drop-down list, select the signal level at 
which the user's radio should send the telemetry command. 
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• Automatically by receiving DTMF command from a radio 
Select this option to request a call from the dispatcher when a radio sends the 
specified DTMF tones. If you select this option, specify a DTMF combination 
without the # characters in the Command box. 

• Automatically by receiving Status from a radio 
Select this option to request a call from the dispatcher when a radio sends the 
specified Status to TRBOnet Server, for instance, 1. If you select this option, 
specify the Status. 

On the Reports tab, specify the reports that will be available to the dispatcher. 

 

• All reports are available 
Choose this option so that all the reports will be available to the dispatcher. 

• Only selected reports are available 
Choose this option and in the list below select/deselect the reports to 
include/exclude. 

6.4.14 Email Groups 
Email Groups are used in Event/Alarm Management and Job Tickets configuration to 
send emails to dedicated recipient groups. 
Go to Administration (1), Email Groups (2) to add/edit/delete email groups in the 
system: 
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• Click Add (3) to create an email group. 

 

 Name 
Specify a name for the email group. 

 Description 
Add a description for the email group. 

 Email list 
Click Add to add an email address to the Email list. 

6.4.15 SMS Groups 
SMS Groups are used in Event/Alarm Management configuration to send SMS to 
dedicated SMS recipient groups. 
Go to Administration (1), SMS Groups (2) to add/edit/delete SMS groups in the 
system: 
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• Click Add to create a new SMS group: 

 

 Name 
Specify a name for the SMS group. 

 Description 
Add a description for the SMS group; 

 Phone Numbers 
Click Add to add a phone number to the SMS group. 

6.4.16 Users 
Go to Administration (1), Users (2) to add/edit/delete users in the system: 
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• Click Add (3) to add a new user to the system: 
• On the General tab, set general parameters for the user: 

 

 Login 
Specify the login for the user. 

 Password 
Type in the individual password for the user. 

 Display Name 
Specify a name for the user to display in the Dispatch Console. 

 Max radios count 
Select a number of radios that will be available for the user. 

 Description 
Add a description for the user. 

• On the Radios tab, specify the radios that will be available to the user. 
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 Allow all radios 
Choose this option to allow using all radios in the system. 

 Only selected radios 
Choose this option and specify which radios will be available to the user. 

• On the Advanced tab, specify settings related to taking/returning radios: 

 

 Lock radio on return 
Select this option so that a radio will be disabled after the users returns it. 

 Allow DTMF management 
Select this option to allow taking/returning radios by sending the specified 
DTMF tones. 
• Take radio 

Specify DTMF tones to be sent by the user to take a radio. 
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• Return radio 
Specify DTMF tones to be sent by the user to return a radio. 

 Allow Text Messages management 
Select this option to allow taking/returning radios by sending specified text 
messages. 
• Take radio 

Specify the text of the message to be sent by the user to take a radio. 
• Return radio 

Specify the text of the message to be sent by the user to return a radio. 
 Allow Sign In / Sign Out management 

Select this option to allow taking radios when the user signs in. 
• Sign-in ID 

Specify the password that the user enters to sign in when they take a 
radio. 

 Send notification to radio after it is taken/returned 
Select this option so that a notification is sent to a radio every time the user 
takes/returns it. 

• On the User Call tab, specify SIP Call settings for the user: 

 

 Phone number 
Specify the user's phone number (additional data). 

 Email 
Specify the user's email address (additional data). 

SIP Call 
 SIP ID 

Enter the SIP ID that will be used by the user. 
 SIP Name 

Enter the SIP user name that will be used by the user. 
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 Password 
Enter the password for the user to be authenticated by the telephone 
system 

 SIP Profile 
From the drop-down list, select the SIP profile to use. 

 Block incoming calls 
Select this option to block all incoming SIP calls for the user. 

 Block outgoing calls 
Select this option to block all outgoing SIP calls for the user. 

6.4.17 Logical Groups 
TRBOnet Dispatch Console allows adding custom logical groups in addition to radio 
groups. You can create groups and subgroups and then assign 
radios/users/dispatchers to these groups. 
Go to Administration (1), Logical groups (2) to work with Logical Groups: 

 

• Click Add (3) to add a logical group. 
 Select Add as a Root to add a logical group as a root folder. 
 Select Add as a Child to add a logical group as a child folder. 
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 Specify a Name and Description for the logical group. 
 Click OK to add the logical group. 

To display logical groups, enable the Logical Group view: 

 

All created logical groups are displayed in the list of radios. 

6.4.18 Radio Groups 
Go to Administration (1), Radio Group (2) to add/edit/delete Radio Groups in the 
system. 
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• Click Add (3) to add a radio group to the system: 

 

 Name 
Specify a name for the radio group in the system. 

 Group ID 
Specify the Radio ID for the radio group used to identify messages to/from 
the radio group. 

 MDC / Sel-5 (Hex) 
Set an ID for MDC 1200 or SELECT 5 signaling systems. This ID is used to 
identify and communicate with a target radio or group of radios depending 
on the call type. 

 Description 
Add a description for the radio group. 
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 Use custom Call Tone 
Select this option and browse for the sound file (WAV, MP3) that will be 
used as a ringtone when receiving calls from the group. 

6.4.19 Radios 
The administrator can add/edit/delete radios in the system. 

• Go to Administration (1), Radios (2). 

 

• Click Add MOTOTRBO Radio (3) to add a new radio. 
On the General tab, specify general settings for the radio: 

 

• Callsign 
Specify a descriptive name for the radio to display in the Dispatch Console. 
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• Radio ID 
Specify a Radio ID for the radio. This ID is used by other calling radios when 
addressing the radio, for instance, when making a private call or sending a text 
message. 

• MDC / Sel-5 (Hex) 
Set an ID for MDC 1200 or SELECT 5 signaling systems. This ID is used to 
identify and communicate with a target radio or group of radios depending on 
the call type. 

• Radio Groups 
In the drop-down list, select a radio group(s) to which to assign the radio. 

• Home Group 
In the drop-down list, select a home group for the radio. 

• Use icon 
From the drop-down list, select an icon for the radio. 

• Extended Device 
From the drop-down list, select the option board type the radio is equipped 
with. 

Location Service 

• GPS Source 
 Built-in GPS receiver 

Select if the radio has its own built-in GPS receiver to send GPS data. 
 Not equipped with GPS receiver 

Select if the radio cannot send GPS data. 
• GPS Profile 

From the drop-down list, select the default or preconfigured GPS Profile. For 
more details on GPS Profiles, see section 6.4.9, GPS Profile (page 196). 
 Location Enabled 

Select/clear this check box to enable/disable the location trigger. 

Telemetry Service 

• TLM Source 
 Not equipped with Telemetry 

Select if the radio cannot send Telemetry data. 
 Built-in Telemetry 

Select if the radio has its own built-in Telemetry. 
 Extended device 

Select if the radio is equipped with an extended device. 
• TLM Profile 

From the drop-down list, select the default or preconfigured Telemetry Profile. 
For more details on Telemetry Profiles, see section 6.4.8, Telemetry (page 192). 
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Text Messages Service 

• TMS Type 
 None 

Select if the radio is not equipped with a display. 
 MSI Proprietary 

Select if the radio supports Text Messaging service (equipped with Display). 
 Standard 

Select if the radio supports DMR Compatible text messages. 

Job Tickets Service 

• JTS Type 
 None 

Select if the radio is not equipped with a display. 
 MSI Proprietary 

Select if the radio supports Job Tickets service (equipped with Display). 
 Text Messages 

Select if the radio supports DMR Compatible text messages. 

Radio Status Service 

 RS Profile 
From the drop-down list, select the default or preconfigured Radio Status 
Profile. 

On the Logical Groups tab, specify logical groups for the radio: 

 

• Select a logical group in the list of available groups. 
• For more information about logical groups, see section 6.4.17, Logical Groups 

(page 225). 
On the Additional tab, specify additional information about the radio subscriber: 



TRBOnet Dispatch Console 

231 

 

• Name 
Specify a name for the radio subscriber. 

• Description 
Add a description for the radio subscriber. 

• Click the Load Image button and browse for the photo or image to assign to 
the radio subscriber. 

• Make 
Specify a make of the vehicle as additional information. 

• Plate number 
Specify a plate number of the vehicle as additional information. 

• Phone number 
Add a telephone number for the radio subscriber. 

• Email 
Add an email address for the radio subscriber. 

• Max speed 
Specify the maximum speed allowed for the vehicle, in kilometers per hour or 
in miles per hour, depending on the measurement system specified in 
TRBOnet server. 

• Route Color 
Specify a color to display the route passed by the radio on the map. 

On the SIP Call tab, specify SIP Call settings for the radio: 
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• SIP ID 
Enter the SIP ID that will be used by the radio. 

• SIP Name 
Enter the SIP user name that will be used by the radio. 

• Password 
Enter the password for the authentication. 

• SIP Profile 
From the drop-down list, select the SIP profile to use for the radio. 

• Block incoming calls 
Select this option to block all incoming SIP calls for the radio. 

• Block outgoing calls 
Select this option to block all outgoing SIP calls for the radio. 
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On the Cameras tab, select the check box beside the camera that will be associated 
with the radio: 

 

 

6.5 Voice Dispatch 
When on the Voice Dispatch tab is selected, the dispatcher can make radio and 
phone calls, send text messages to radios and phone numbers, monitor recent calls 
and events, radio state, active tasks and routes and view selected map. 

6.5.1 Radio List 
6.5.1.1 View Options 

The toolbar in the upper part of the Radio List pane provides buttons to change the 
appearance of the list: 

 

• Click  to view radios by radio groups. 

• Click  to view radios by radio list. 

• Click  to view radios by logical groups. 

• Click  to view radios by their statuses. 
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 Yellow 
A radio is online and enters the beacon coverage zone; has Indoor 
positioning lock. 

Note: When GPS location is available and the radio enters the 
beacon coverage zone, the status turns yellow from green. 

 Blue 
A radio is online; GPS data is not available. 

 Green 
A radio is online; GPS data is available. This status is shown if the Server has 
received GPS data during the last 10 minutes (the time interval is set in the 
server configuration). 

 Grey 
A radio is offline. 

• Click  to open the Settings dialog box to specify which quick buttons to 
display in the Voice Dispatch pane. 

 

• Dispatcher Buttons 
In this group, select the quick buttons to be displayed in the Radio List for 
dispatchers. 

• Radio Buttons 
In this group, select the quick buttons to be displayed in the Radio List for 
radios. 

• Radio Groups Buttons 
In this group, select the quick buttons to be displayed in the Radio List for 
radio groups. 

• Logical Group Buttons 
In this group, select the quick buttons to be displayed in the Radio List for for 
logical groups. 
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Note: For the preview, see the lower part of the Settings dialog 
box. 

• Additional Options 
 Show checkboxes 

Select this option to display check boxes next to each radio and radio 
group. Selecting/clearing a check box will display/hide the corresponding 
radio/radio group on the map. 

 Show GPS trigger state 
Select this option to display the GPS trigger state for a radio in the Radio 
List. 

 

• Grey 
A radio is offline. 

• Blue + white dish 
A radio sent ARS but didn't send GPS packets. 

• Blue + red dish 
A radio sent ARS and GPS packets without GPS data, that is the radio is 
out of GPS coverage. 

• Green 
A radio is fully online (has a GPS fix). 

Filter the Radio List 

• Click  to select which radio list elements to display in the Radio List. 

 

• Click the arrow button (1). 
• Select the object types and statuses (2) to filter radios. 
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For example, you may select to display only radios and radio groups that are 
online and have fixed GPS signal. 

• Click OK (3) to apply filter settings. 

Refresh the Radio List 

• Click  to reload the Radio List. 

6.5.1.2 Quick Filter 
Type in Radio ID or Radio name to filter the Radio List. Search results are displayed 
in the Radio List: 

 

6.5.1.3 Radio Pop-up Window 
The dispatcher can see the last received radio data in the Radio pop-up window. 
Select a radio in the Radio List and hover the mouse pointer over it: 

 

The following information on the radio is displayed on this pop-up window: 
1. The current channel the radio is on. 
2. The User Activity list the radio is assigned to, if a User Activity task is activated. 
3. The Lone Worker policy's state, if a Lone Worker task is activated. 
4. The route assigned to the selected radio, if a Route Management task is 

activated for the selected radio. 
5. The current GPS data and current location data. 
6. The current location resolved to address. 

While this pop-up is open, the dispatcher can do the following: 

• Click  to request the presence of the radio in the radio network. 
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• Click  to send a text message to the radio. 

• Click  to request the radio's location. 

6.5.1.4 Radio Shortcut Menu 
To open the radio's context menu, right-click a radio in the Radio List: 

 
This shortcut menu contains the following items: 

• Presence in Network 
Choose this menu item to send a Check Radio command. If the radio is online 
and is located in the coverage area, the dispatcher will see a message like this: 

 

• Private Call 
Choose this menu item to initiate a Private Call to the selected radio. 

• Request to Talk 
Choose this menu item to send a talk request to the selected radio. 

• Request Location 
Choose this menu item to request the location of the selected radio (for radios 
with GPS module only). 

• Send Message 
Choose this menu item to send a text message to the selected radio (for radios 
with display only). 

• Advanced > Remote Monitor (Open mic) 
Choose this menu item to activate the radio microphone in hidden mode 
(remote monitor duration – 30 sec.) 
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• Advanced > Reset GPS Trigger 
Choose this menu item to customize the GPS trigger settings. When you 
reconnect to the Server or reassign a GPS Profile to the radio, temporary 
settings will be updated to GPS Profile settings. 

 

 Reset/Stop/Start GPS Trigger 
Choose which command to send to the radio. 

 Change GPS Interval 
Select this option and specify the new GPS trigger update interval. 

• Advanced > Enable Radio 
Choose this menu item to enable the selected radio. 

• Advanced > Disable Radio 
Choose this menu item to disable the selected radio. 

• Advanced > Send Audio Record 
Choose this menu item to send an audio record to the selected radio. 

 

 Click Start and start talking to the microphone. 

 

 Click Send to send the recorded message to the radio. 
 You can also load your message from file, or from Saved Audio Files. Just 

click the Load button. 
 Or, you can send a text message converted to speech. Just click the 

Convert Text to Speech link. 



TRBOnet Dispatch Console 

239 

 

• Advanced > Send Coordinates To 
Choose this menu item to send the coordinates of the selected radio to 
selected recipients. 

 

 In the dialog box that appears, specify the radio/radio group/dispatcher to 
send the coordinates to. 

• Advanced > Send Email 
Choose this menu item to send an Email message to the selected radio 
mailbox. 

• Advanced > Hot Key - Private Call 
Choose this menu item to assign a hot key that will be used to make a private 
call to the selected radio. When the prompt appears, press the desired key or 
key combination. 

 

• Find on Google Earth 
Choose this menu item to display the selected radio location on Google Earth. 

• Show Route on Google Earth 
Choose this menu item to display a route traveled by the selected radio on 
Google Earth for the specified time period. 
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• Monitoring > Monitoring in New Window 
Choose this menu item to open a new Map window for the selected radio. 

• Monitoring > Google Street View 
Choose this menu item to open Google Street View with the latest location and 
direction of the selected radio. 

• Monitoring > Yandex Street View 
Choose this menu item to open Yandex Panorama with the latest location and 
direction of the selected radio. 

• Specify Status Colors 
Choose this menu item to select to set individual parameters for the radio 
icons. 

 

 In the Status Colors dialog box, you can specify icons for the statuses of the 
selected radio. Select icons from the drop-down list. To set a custom color 
for the radio status icon, click the + button and select a color in the uniform 
color palette. Click the – button to delete a custom color. 

 In the lower part of the dialog box, you can see the preview of the icons. 
 To set default icons for the selected radio, click the Reset button. 
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• Set Radio Channel > Radio Active 
Select/deselect this menu item to make the selected radio active/inactive. 

• Set Radio Channel > Channel 
Select the channel over which to make calls to the selected radio. 

• Cameras > 
Click this menu item and select a camera associated with the radio. As a result, 
a new window with the camera view will open. 

• Set On Duty  
Choose this menu item to assign the selected radio to the On Duty list. 
See also section 6.4.5.12, User Activity (page 173). 

6.5.2 PTT Boxes 
The dispatcher can make voice calls from the Dispatch Console by using PTT boxes: 

 

The following options available for the PTT box: 

• Click the  button to make the channel the default PTT channel. 

• Click the  (Tone and PTT) button to start transmitting after a tone sound. 

• Click the  (Solo) button to mute all channels except this one. 

• Click the  (Mute) button to mute this channel. 
Right-click the selected PTT box to display its shortcut menu: 

 
This shortcut menu contains the following items: 

• Default PTT channel 
Select this menu item to make the channel the default PTT channel. 
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• Specify Hot Key 
Choose this menu item to assign a hot key that will be used to transmit on this 
radio channel. When the prompt appears, press the desired key. 

• Add to New Group 
Choose this menu item to add the channel/group associated with the selected 
PTT box to the Cross Patch box. When two or more channels/groups are 
added to the Cross Patch box, the dispatcher can click the Create link to create 
a cross patch group for the selected channels/groups. 

• Tone and PTT 
Click this menu item to start transmitting after playing a tone sound. 

• Mute this channel 
Click to mute the selected channel. 

• Mute all channels except this 
Click to mute all channels except the selected one. 

• Volume 
Move the slider to specify the speaker volume level on the selected 
channel/group. 

• Microphone 
Move the slider to specify the microphone volume level on the selected 
channel/group. 

• Private Call Mode 
Select this mode to allow making private calls from the PTT box. 

• Select By Radio ID Mode 
Select this mode to allow making calls by entering radio IDs from the PTT box. 

• Recipient 
Select the call recipient for the PTT box. 

• Terminate Transmission 
Click this menu item to terminate the current call. 

Note: The current transmission can also be terminated by clicking 
the Terminate button in the PTT box. 

 

• Reset 
Click this menu item to reset connection to the selected channel/group. 



TRBOnet Dispatch Console 

243 

• Minimize/Maximize 
Click to minimize or maximize the PTT box. 

6.5.3 Voice Calls 
The dispatcher can make the following types of calls: 

• Private Call 
This is an individual call from the Dispatch Console to a radio via the radio 
channel. 

• All Call 
This is a call from the Dispatch Console to all radio groups registered in the 
system. 

• Group Call 
This is a call from the Dispatch Console to a selected radio group registered in 
the system. 

• Intercom Call 
This is a call from the Dispatch Console to other dispatchers. There are three 
types of Intercom Call: 
 Intercom Call to all dispatchers 
 Group Intercom Call to a group of dispatchers 
 Private Intercom Call to a selected dispatcher 

• Phone Call 
This is a call from the Dispatch Console to a selected phone number. 

In addition, the dispatcher can send voice mails to offline radios. 

6.5.3.1 Private calls 
The dispatcher can make a call to any online radio registered in the system. To make 
an individual call from the Dispatch Console to a selected radio via the radio, 
channel do the following: 

• Select the radio in the Radio List. 

• Click the  button on the right. 
Or: 

• Right-click the radio in the Radio List. 
• On the drop-down menu, click Private Call. 

To terminate a private call, do the following: 
• Click the PTT button on the PTT box. 

Or: 

• Click the  button in the Radio list. 

Note: You can also create a special PTT box for Private Calls. For more 
details, see View > Configure PTT Boxes on page 93. 
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6.5.3.2 All calls 
The dispatcher can make a call to all online radios registered in the system (for 
example, in the case of alarm). To make a call from the Dispatch Console to all radios 
registered in the system, do the following: 

• From the drop-down list, select All Call. 

 

• Click the PTT button. 

6.5.3.3 Group calls 
To make a call from the Dispatch Console to a selected radio group registered in the 
system, do the following: 

• From the drop-down list, select a group. 

 

• Click the PTT button. 

Note: You can also create a special PTT box for Group Calls. For more 
details, see View > Configure PTT Boxes on page 93. 

6.5.3.4 Intercom calls 
The dispatcher can make calls to all dispatchers or to selected dispatchers in the 
system. To make an Intercom Call to dispatchers, do the following: 

• On the Intercom PTT box, from the drop-down list, select either All Call, or a 
group of dispatchers, or an individual dispatcher. 
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• Click the PTT button. 

6.5.4 Predefined Voice Messages 
The dispatcher can send predefined voice messages (recorded or voice messages, or 
audio files) to a radio or a selected radio group: 

 

• In the Queued Messages panel, click the Voice Message button. 
• In the confirmation dialog box, click Yes. 

6.5.5 Cross Patches 
6.5.5.1 Predefined Cross Patch 

The Cross Patch function allows configuring the network to redirect calls. A 
predefined Cross Patch can be created by the administrator only and a dispatcher 
cannot configure it. A predefined Cross Patch is displayed in the Cross Patch panel 
by default. The Cross Patch feature is intended to combine different radio channels 
in a single group to make voice calls from a dispatcher to radios and from radios to 
a dispatcher (for example, to connect a dispatcher with the firemen and police). 
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6.5.5.2 Custom Cross Patch 
The dispatcher can create a custom Cross Patch to connect selected PTT boxes (for 
example, the Emergency and Firemen radio groups). In addition, you can connect 
analogue and digital radios via a Cross Patch. 

 

1. In the Radio Interface pane, select the PTT boxes you want to combine in a 
group. Drag and drop them to the empty Cross Patch box (1). 

2. Click the Create link (2) to create a custom Cross Patch. 

Note: Until you click the Create link, this cross patch will remain 
as a temporary cross patch that will be deleted after you 
reconnect to TRBOnet Server or restart TRBOnet Dispatch 
Console. 

As a result, the new cross patch will be added to the Cross Patch panel. Select the 
check box to activate the cross patch. 
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6.5.6 Quick Commands 
The dispatcher can create Quick Commands (Text Messages, Send Telemetry, 
Request Location, Send Voice Message) and display the Quick Commands panel in 
the Radio Interface pane. With these commands, the dispatcher can quickly send 
Text Message, Telemetry, Location Request, and Voice Message to a radio by 
clicking the appropriate Quick Command button. 
To configure the Quick Commands panel, do the following: 

• Make sure Show Quick Commands Panel (2) is selected under the View 
menu. 

• On the Quick Commands panel, click the Configure link (3). 

 

• In the Configure Quick Commands dialog box, click the Create link. 
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6.5.6.1 Send Text Message 

 

• Name 
Specify a name for the quick command. This name will be displayed as the 
button name in the Quick Commands panel. 

• Command 
From the drop-down list, select Send Text Message. 

• Message 
Enter the text of the message. 

• Send to radio group 
Choose this option to send the text message to radio groups registered in the 
system. In the Recipient box, select target groups. 

• Send to subscribed radio 
Choose this option to send a predefined text message to individual radios 
registered in the system. In the Recipient box, select target radios. 
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6.5.6.2 Send Telemetry 

 

• Name 
Specify a name for the quick command. This name will be displayed as the 
button name in the Quick Commands panel. 

• Command 
From the drop-down list, select Send Telemetry. 

• VIO 
Specify a VIO to which to send a telemetry command. 

• Command 
From the drop-down list, select a telemetry command for the selected VIO. 

• Send to radio group 
Choose this option to send the telemetry command to radio groups registered 
in the system. In the Recipient box, select target groups. 

• Send to subscribed radio 
Choose this option to send the telemetry command to individual radios 
registered in the system. In the Recipient box, select target radios. 
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6.5.6.3 Request Location 

 

• Name 
Specify a name for the quick command. This name will be displayed as the 
button name in the Quick Commands panel. 

• Command 
From the drop-down list, select Request Location. 

• Recipient 
Select radios to which to send a location request. 

6.5.6.4 Voice Message 

 

• Name 
Specify a name for the quick command. This name will be displayed as the 
button name in the Quick Commands panel. 
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• Command 
From the drop-down list, select Send Voice Message. 

• Load from file 
Click this link and locate the audio file on your PC. 

• Record Message 
Click this link to record a new voice message. 

• Play back message 
Click this link to play back the voice message. 

• Specify Call type, Channel, and Call Target for a voice message. 

Note: To send a Voice Message to a subscriber from the phone 
book, click the ellipsis (…) button in the Call Target column 
and select a contact from the phone book. 

• Impolite channel access 
Select this option so that the voice message will be sent regardless of whether 
the channel is busy or not. 

6.5.7 Queued Messages 
This feature enables dispatchers to send audio messages even if the channel is 
currently busy. The dispatcher records a message to be sent to a busy channel and 
then TRBOnet automatically forwards this message as soon as the channel becomes 
available: 

 

To queue an audio message for delivery to the selected recipients, first record a 
message by clicking the Record button. Alternatively, you can select an MP3 or WAV 
audio file from any storage location, or select a prerecorded message from the 
library. 

6.5.7.1 Select Audio File 
• Click File > Open Audio File and browse for the audio file on the local PC. 
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6.5.7.2 Audio Message Library 
You can select an audio file from the Voice Message templates. 

• Click File > Audio Message Library. 

 

• Select an audio file in the list and click OK to use this file as a queued Voice 
Message. 

6.5.7.3 Record Audio File 
You can record a voice message that then can be sent to selected radios. 
Click Record > Record audio to open recording tool: 

 

 Click Start and start talking to the microphone. 

 

 Click Stop to stop recording the message. 
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 Click Send to send the recorded message immediately. 
 Click Save > Save as file to save the recorded file as an audio file on the 

PC. 
Or: 
 Click Save > Save as Saved Audio File to add the recorded file to a list of 

the Saved Audio Files. 

6.5.8 Activity Monitor Panel 
While in this panel, the dispatcher can perform a wide range of tasks, including: 

• Monitoring and listening to recent calls and viewing system events 
• Monitoring selected radio state 
• Monitoring active tasks for selected radio 
• Monitoring active routes for selected radio 
• Enabling and disabling User Activity monitoring 
• Displaying selected map in a compact view mode 
• Monitoring cameras connected to Dispatch Console 

6.5.8.1 Recent Calls/Events 
In the Recent Calls/Events tab, the dispatcher can monitor recent Server events, 
view and listen to recent calls. 

 

Voice Recording 
Play back selected call(s) 

• Select the voice call recording you want to play back and click the  
button on the left of the toolbar. 
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The Audio player box will appear. 

 

 Click the Play button to play back the recording. 
Click the Pause button to make a pause. 
Click the Stop button to finish playing back the recording. 
Click the Open button to select a new audio file to play back. 

Note: You can play back multiple recordings in a row. Use the CTRL 
and/or SHIFT keys to select multiple recordings you want to play 
back. Then click the  button. 

Save selected call(s) 
• Select the voice call recording (or multiple recordings, with the help of 

CTRL/SHIFT keys) you want to save as a sound file. 
• Click Save > Save Selection as Individual Files to save selected recordings in 

separate files. 
Or 

• Click Save > Save Selection as Single File to save selected recordings in a 
single file. 

• In the 'Save As' or 'Browse For Folder' dialog box, browse for the folder where 
you want to save the file(s). 

Recent Calls/Events Toolbar 

 
Click the Pause button to pause updating the Recent Calls/Events log. 
Click the Clear button to clear the Recent Calls/Events log records. 
Click the Reload button to reload all log records. 
Click the Filter By Radio button to filter log records by a selected radio/radio group. 
In the Radio List pane (the upper-left-pane of the main window), select a radio or 
radio group. The Recent Calls and Events for a selected radio will only be displayed 
in the Recent Calls/Events pane. 
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Click the Grouping button to group log records. Select the column you want to 
group log records by. Drag and drop the selected column header to the Grouping 
field. 
Click the Auto Filter button to set a filter for the recent calls and events. You can 
filter the Recent Calls/Events list by any parameter. For example, to filter the list by a 
selected Sender, select the Sender column (1), and start typing the sender name (2). 

 

Click the Default Settings button to apply default settings to all log records. 
Click the Details button to see the talk session members: 

 

Click the Show Notes button to enable the Note column. All notes added by the 
administrator and dispatchers for the recent calls and events will be shown in the 
Notes column. So, you can mark recent calls and events to later find them by notes. 
Click the Add Note button to add a note for the selected recording and/or event. 
The notes will be displayed in the Recent Calls/Events log if the Show Notes mode 
enabled: 
Click the Add Message button to add a message for dispatchers to the Recent 
Calls/Events log. 

 

 Recipient 
Select either All or an individual dispatcher if you want to see the message. 

 Severity 
Select the severity level to inform dispatchers about the level of importance. 
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 Message 
Enter the message text. 

 Click OK. 
As a result, the message will be added an event to the Recent Calls/Events 
pane. 

6.5.8.2 Recent Calls 
On the Recent Calls tab, the dispatcher can see and configure the latest Voice calls, 
including Private, Group, and Intercom calls: 

 

• Click the Private button (1) to display the latest Private calls. 
• Click the Group button (2) to display the latest Group calls. 
• Click the All Call button (3) to display all call types, including Intercom calls. 

In a Call Box, you can see the number of calls and the last call date and time: 

 

Click the  button to start a Private call to the Sender-Radio (Radio is displayed in 
the Sender column). 

Click the  button to mark the calls as viewed. 

Click the  button to clear the recent call history. 

6.5.8.3 Request to Talk 
On the Request to Talk tab, the dispatcher can see Missed Calls and Requests to 
Talk: 

 

• Click the Missed Call button to display Missed calls. 
• Click the Request to Talk button to display Requests to talk. 
• Click the Table button to display the calls in a table view. 
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• Click the Cards button to display the calls as a set of cards. 
• Click the Clear button to clear all the records. 
• Click the Filter button to set a filter for the records. You can filter the records 

by any parameter. For example, to filter by the caller select the Caller column, 
click in the empty row and start typing the caller name. 

• Click the Options button to specify options related to Request to Talk: 

 

 Enable pop-up window to display incoming Request to Talk 
Select this option so that incoming Request to Talk messages will pop up 
over the application window. 

 

• Start the Call back when Accept button is clicked on 
Select this option so that the call back will start as soon as the Accept 
button is clicked. 

 Enable Alert Tone for incoming Request to Talk 
Select this option so that an alert tone will sound when a Request to Talk 
arrives. 

 Synchronize with other dispatchers 
Select this option so that a Request to Talk sent to one dispatcher will 
automatically be forwarded to all dispatchers. 

 Automatically delete Request to Talk record after responding 
Select this option to automatically delete the corresponding record after 
the Request to Talk call is responded. 
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 Wait for response from caller 
Select this option so that a Request to Talk will be considered responded 
only if the radio has answered to the call back. 

 Enable Responses to a Radio Group 
Select this option so that a response to a Request to Talk will be to the 
specified radio group. From the Talk Group drop-down list, select this 
radio group. 

On the Notifications tab, specify the following parameters: 

 

 Send notifications to caller 
Select this check box to notify the radio when a request is rejected, queued, 
or the dispatcher is unavailable. 
• Choose one of the option buttons below to specify the way the radio is 

notified. 
 Autodetect notification type 

Choose this option button so that the type of notification will be 
selected automatically depending on whether or not the Text 
Messages Service is enabled on the radio. 

 Send Text Message 
Choose this option button to send text notifications to the radio. 

 Send Audio Message 
Choose this option button to send voice notifications to the radio. 

• In the Notification texts boxes, enter the corresponding notification 
texts. These texts will be used when sending text notifications to the 
radio. 

6.5.8.4 Radio State 
On the Radio State tab, the dispatcher can see the log of radio states for the radio 
selected in the Radio List pane (the upper-left-pane of the main window): 
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In the Radio State pane, the dispatcher can do the following: 
Click the Show Notes button to enable the Note column. All notes added by the 
administrator and dispatchers for the radio state records will be shown in the Notes 
column. So, you can mark radio state records to later find them by notes. 
Click the Add Note button to add a note for the selected radio state record. The 
notes will be displayed in the Recent Calls/Events log if the Show Notes mode 
enabled: 
Click the Add Message button to add a message for dispatchers to the Radio State 
log. 

6.5.8.5 Active Tasks 
On the Active Tasks tab, the dispatcher can monitor all active tasks for the selected 
radio (for example, Lone Worker, Active Routes, and other tasks). 

 

The dispatcher can manage active tasks as follows: 
Click the Stop button to stop executing the selected task. 
Click the Grouping button to group the tasks. Select the column you want to group 
tasks by. Drag and drop the selected column header to the Grouping field. 
Click the Auto Filter button to set a filter for the active tasks. You can filter the tasks 
by any parameter. For example, to filter by selected radio select the Radio column, 
and start typing the radio name. 
Click the Default Settings button to apply default settings to all active tasks. 

6.5.8.6 Active Routes 
On the Active Routes tab, the dispatcher can monitor all active routes. 
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The dispatcher can manually set statuses for route checkpoints. To do this, right-
click on a route point and from the drop-down menu, select the desired status. 
 Waiting 

The checkpoint is waiting to be attended. 
 Attended 

The checkpoint has been attended on time. 
 Unattended 

The checkpoint hasn't been attended on time. 
 Alarm 

The checkpoint is in Alarm mode. 
 Note 

Click this item to add a note to the selected checkpoint. The note will be 
displayed in the pop-up window that appears when hovering the mouse 
pointer over the checkpoint. 

6.5.8.7 User Activity 
• Click the User Activity tab to monitor the activity of radio users: 

 

• Click the Configure button to configure the User Activity list: 

6.5.8.8 Map 
On the Map tab of the Activity Monitor panel, you can monitor location of radios on 
the map and simultaneously perform all available actions in the Radio Interface 
pane (make voice calls, send messages, disable and enable selected radios, and 
other actions): 

 

For more details on map options, see section 6.6, Location Tracking (page 264). 

6.5.8.9 Cameras 
On the Cameras tab of the Activity Monitor panel, you can monitor cameras 
connected to Dispatch Console. 
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• Click the Add button and select a camera to be displayed on the tab. 

Note: You can add up to four cameras to the Cameras tab view. 

6.5.9 Phone Calls 
The Telephony function allows making calls from telephones to radios and vice 
versa. 
The phone system must be previously configured by your TRBOnet administrator. 

6.5.9.1 Phone Calls from/to Dispatch Console 
To make a phone call from the Dispatch Console: 

 

• In the Telephony box, select the Line (1), enter the phone number (2) and click 

the  (3) button. 

Terminate a phone call 

• In the Telephony box, click the  button. 

Open a phone book 

• In the Telephony box, click the ellipsis (…) button (2) or click Menu > Phone 
Book (2): 
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• Click the Add button to add a new record to the phone book. 
• Click the first column, and from the drop-down list select a marker color. 
• Double-click the second column. 

 

 SIP ID 
Enter the SIP ID that is used by the user. 

 SIP Name 
Enter the SIP user name that is used by the user. 

 Display Name 
Enter the name that will be displayed for the user in the Dispatch Console. 

 Click OK to save the phone book. 
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Answer an incoming call 

 

• In the Telephony box, click the  (3) button. 

Forwarding Phone Call to a Radio 

• While in a call, click Menu > Forward Call. 

 

 

• Click the Radio tab (1), select the radio (2) and click Forward (3). 

Add call participant(s) 

• Click Conference (4). 

Note: Only one radio or radio group can participate in a conference call. 
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6.5.9.2 Making Telephone Calls from Radios 

Make a DTMF call 

Note: Only 1.07.02 and higher firmware version for all radios equipped 
with dialing keyboard support DTMF. 

To make a DTMF call, do the following: 
 Press the PTT button on a portable radio and hold it. 
 While holding the PTT button, dial a phone number and press # (For example, 

0079521112233#). 
 Release the PTT button. The server will automatically initiate a phone call. 

Call by sending Text Message 
To make a phone call, send a text message with the text PrefixN where: 

• Prefix – is a short text to define the special text message (for example, sip:); 
• N - the phone number. 

For example, to initiate a call to a phone subscriber "123 456 7890", the following 
text message must be sent to TRBOnet Server: "sip:1234567890". 

Terminate a call 
To terminate the call, press the PTT button and then press # twice on the radio. 

6.6 Location Tracking 
In the Location Tracking tab, the dispatcher can monitor selected radio location on 
supported maps, open different maps in separate tabs and toggle between map 
tabs: 

 

The main user interface elements are as follows: 
1. Radio List pane 
2. Voice panel 
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3. Map panel 
4. Objects panel 
5. Activity Monitor panel 
While in Activity Monitor panel, the dispatcher can perform a wide range of 
tasks, including: 
 Monitoring and listening to recent calls and viewing system events 
 Monitoring selected radio state 
 Monitoring active tasks for selected radio 
 Monitoring active routes for selected radio 
 Enabling and disabling User Activity monitoring 
 Monitor beacons and beacon events. 

6.6.1 Objects 
On the Objects panel, the dispatcher can view and enable/disable the following 
objects: 

• Beacons – all beacons connected to the system. 
• Map Objects – all manually created map objects and predefined objects 

created with the Map Drawing toolbar. 
• Map Regions – all map regions created with the Map Drawing toolbar (use 

the Add Polygon tool to create a map region). 
• Map Routes – all map routes created with the Map Drawing toolbar (use the 

Draw Route tool to create a map route). 

6.6.1.1 Beacons 
TRBOnet Dispatch Software provides the Indoor Positioning feature to monitor the 
location of radios inside a building where no GPS signal is available. This feature 
requires additional hardware (the beacons spread around the building and the 
option boards in radios). A radio user will be displayed on the indoor floor plan 
when the radio enters the beacon coverage area. The beacon icon on the map 
notifies on the amount of radios that are currently in the beacon coverage area. 
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Beacons are displayed on the building floor plan (1) and in the list of beacons (2) in 
the Objects panel. When a radio comes into the range of a beacon, they both are 
highlighted in yellow on the floor plan/map (3). 

Floor Plan Toolbar 
The Floor Plan pane's toolbar is located in the upper part of the Floor Plan pane: 

 

1. Zoom in/out 
Click the Zoom buttons to zoom in/out the floor plan. 

2. Default View 

Click the arrow beside  and choose Save as Default Region to save 
current floor plan as a default region. The dispatcher can save only one 
default region. 

To open the default region, click the arrow beside  and choose Show 
Default Region. 
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3. Set Location 
Click the Set Location button to manually set a beacon on the floor plan. 

4. Available beacons drop-down list 
Select a beacon from the list and click the Set Location button to put the 
selected beacon on the floor plan. If you are going to add a new beacon, 
select 'New Beacon' from the drop-down list and click the Set Location 
button to add a new beacon to the floor plan. 

5. Show Beacons 
The dispatcher can select which beacon types to display on the floor plan. 
 All – all beacons are displayed on the map. 
 With Radios – beacons with attached radios are displayed on the map. 
 Without Radios – beacons without radios are displayed on the map. 
 Alarmed - beacons in Alarm mode are displayed on the map. 
 No – all beacons are hidden on the map. 

6. Show Info 
From the drop-down list, select which information to display for beacons. 

7. Images 
From the drop-down list, select an image size for beacon icons. 

8. Route 
 Click Route > Show Route to display a route traveled by the radio for the 

selected time period. 

 

• Radio 
Select the radio to display the route for. 

• From/To 
Specify the time period to show the route for. 

• Color 
Select a color to display the route with. 

• Click OK to show the route for the selected radio. 
 Click Route > Play Back Route. 
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• Select the time period to request data for. 
• Select the radio(s) to request data for. Click Select All to display history 

for all radios registered in the system. Click Unselect All to cancel radio 
selection. 

• Click Load to load the history. 
9. Overview 

Click this button to view the entire floor plan. 
10. Select Map 

Click this button to change the map in the current tab. 

6.6.1.2 Map Objects 
The dispatcher can create custom and predefined map objects using the Drawing 
Panel. The dispatcher can attach 2D or 3D floor plans for Indoor Positioning. 
For more details on creating map objects, see section 6.6.2.7, Drawing Panel 
(page 270). 

6.6.1.3 Map Regions 
The dispatcher can create map regions that can be used for Geofencing rules. The 
map Regions can be created manually on the map (click any point on the map to 
select it as a region border) or, the dispatcher can add map points by GPS 
coordinates to create a region. 
For more details on creating map regions, see section Draw a Map Region 
(page 271). 

6.6.1.4 Map Routes 
The dispatcher can create routes on the map that can be used for Geofencing rules. 
For more details on creating map routes, see section Draw a Route (page 273). 

6.6.2 Map Tools 
The Map toolbar is located in the upper part of the Map pane: 
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6.6.2.1 Zoom in/out 

• Click  to zoom in a map. 

• Click  to zoom out a map. 

6.6.2.2 Bookmarks 

• Click  to put a bookmark on the map. 
• Click Save as Bookmark to save the map region as a bookmark. 

 

• The dispatcher can create any number of the bookmarks. To open a bookmark, 

click  and select the bookmark in the list. 

6.6.2.3 Default Region 

• Click  and choose Save as Default Region to save current map region as a 
default region. The dispatcher can save only one default region. 

To open the default region, click  and choose Show Default Region. 

6.6.2.4 Filters 
Select filters to display radios on the map: 

 - radio is online, beacons are detected; 

 - radio is online, GPS data is received; 

 - radio is online, no GPS data is received; 

 - radio off, no GPS data is received. 
All filters are enabled by default. Click the selected icon to disable selected radios on 
the map. 

6.6.2.5 Ruler 

• Click  to enable the tool to measure distances on the map. 
• Left-click a point on the map to start measuring. Left-click intermediate points 

and see the distance displayed at the mouse pointer. 
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6.6.2.6 Search by Address 
The dispatcher can search map objects by their address. 

Note: For online maps, Internet access is required! 

• Click  and choose Address to find an address on the map. 

 

• Click the address in the list to display it on the map. 

 

6.6.2.7 Drawing Panel 

• Click  to display the Drawing toolbar: 
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Draw a Map Region 
Draw a region manually 

• Click  and choose Draw on the map. 
• Left-click points on the map to create a new map region. 

 

• Click the Save link to add a new polygon region. 

 

 Name 
Specify a name for the new map region. 
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 Description 
Enter a description for the map region. 

Region tab 

 

 Color 
Select a color to display the region on the map. 

 Fill region area 
Select this check box to fill in the region area on the map. 

 Transparency 
Specify the transparency level (in percent) for the fill color. 

Draw a region by coordinates 

• Click  and choose Specify coordinates. 

 

• Click the Add link to add a point. 
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 Coordinate system 
From the drop-down list, select the convenient format (for example, 
Decimal Degrees) for the coordinates. 

 Latitude/Longitude 
Enter the coordinates of the point. 

 Click OK to add the point. 
• Click the Edit link to edit the selected point. 
• Click the Delete link to delete the selected point. 
• Click Export to save the points' coordinates in a *.csv file. 
• Click Import to add points to the region from a *.csv file. 
• Click the Save button to add a region. 

Draw a Route 

• Click  and click points on the map to draw a route. 

 

• Once you have finished drawing a route, click the Save link. 
• In the Object on Map dialog box, specify a name and description for the 

route. 
• Click the Route tab 
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 Color 
Select a color to display the route on the map. 

 Active area 
Specify the corridor width. If a radio will pass out of the active area, the 
dispatcher will receive an alarm signal. 

Add a Beacon 

• Click  and choose Place on the map. 
• Click on the map where you want to place a beacon. 
• Click the Save link. 

The Beacon properties dialog box will appear. 
On the General tab, specify the following parameters: 
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 Type 
Select the beacon type from the drop-down list. 

 Name 
Specify a name for the beacon. 

 Major ID and Minor ID 
Enter the beacon’s major and minor ID exactly as specified on the iBeacon 
device. 

 Description 
Add a description for the beacon. 

On the Logical Groups tab, select logical groups that will be associated with 
the beacon. 
On the Cameras tab, select the check box beside the camera that will be 
associated with the beacon. 

Note: You can also place a beacon by specifying its coordinates. To do 
this, click  and choose Specify coordinates. 

Add a Point of Interest 

• Click  and choose Place on the map. 
• Click on the map where you want to place a POI. 
• Click the Save link. 

The Object on Map dialog box will appear. 

 

 Name 
Specify a name for the new map region. 

 Description 
Enter a description for the map region. 
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 Bind to PTT 
Select this option to connect the POI to a radio group in your radio system. 
• System 

From the drop-down list, select the radio system. 
• Group 

From the drop-down list, select the radio group. 
On the Logical Groups tab, select logical groups that will be associated with 
the object. 
On the Cameras tab, select the check box beside the camera that will be 
associated with the object. 

 

Note: You can also place a POI by specifying its coordinates. To do this, 

click  and choose Specify coordinates. 

 

Note: Similarly, you can place other objects with predefined icons, such 
as Warning points, Police departments, Emergence departments, 
Fire departments, Houses, and Cameras. To do this, click one of the 

following icons on the toolbar: . 

 

Create a Custom Object 
In addition to objects with predefined icons, you can create your own objects to be 
then placed on the map. 

• Click  and choose Add Custom Object. 

 

 Name 
Specify a name for the object. 

 Select image 
Click the Browse button and locate the image file you want to use as an 
icon for the object. 
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Note: You can also assign different images for different icon sizes. 
Click the Advanced mode link and select images for 
different sizes (16x16, 24x24, 32x32, 48x48). 

After you create a custom object, the corresponding con will appear on the Drawing 
Panel. 

• To delete a custom object, click  and choose Delete Custom 
Object. 

6.6.2.8 Route 

Show Route 

• Click  and choose Show Route. 

 

 In the list of radios, select a radio and the color with which to display the 
route for the radio. 

 Route Type 
Select the route type, either Static or Dynamic. 

 Show Route for Last 
If the Dynamic route type is selected, specify the time period, in hours, for 
which to show the route. 

 From/To 
If the Static route type is selected, specify the start and end dates of the 
time period for which to show the route. 

 Route Style 
Select the style in which to display the route on the map. 

 Optimize Route (group all nearest points) 
Select this option to group all points in a 100-meter radius. 

 Automatic error correction 
Select this option to detect and correct invalid GPS data. Click the 
Configure link and select the maximum possible speed for your vehicles. 
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 Show events 
Select this option to display TRBOnet server events (telemetry, alarms, and 
other events). 

 Show CanLog events 
Select this option to display events that occurred in a vehicle (door 
opening, and other events). 

Export Route 
You can export the routes travelled by radio users in a GPX or KML files. To do this, 

after you have performed a Show Route command, click  and choose 
Export Route > Export to GPX file/ Export to KML file. 

Play Back Route 

• Click  and choose Play Back Route. 

 

 In the list of radios, select the radio and the color with which to display the 
route for the radio. 

 From/To 
Specify the start and end dates of the time period for which to show the 
route. 

 Click the Load button. 
 Once you have loaded the route points, click the Play button to play back 

the route on the map. 
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6.6.2.9 Geofencing 
The Geofencing feature allows controlling the location and speed of radios relative 
to manually defined regions on the map. 
The Geofencing monitoring consists of the manually defined regions and the tasks. 
The regions specify where to apply the rules, while the tasks specify how to apply 
the rules for the regions and radios. 

• On the Map toolbar, click . 
The administrator can add/disable/delete the rules for Geofencing as well as 
edit the currently selected rules: 

• For more details on configuring Geofencing rules, see section 6.4.5.6, 
Geofencing. 

• To enable Geofencing rules, go to Administration, Tasks, and in the Tasks 
pane, select the checkbox next to Geofencing. 

 

6.6.2.10 Coverage Map 
The Coverage Map option allows to see RSSI levels on the map. 

• On the Map toolbar, click . 
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For more details on configuring the Coverage Maps, see section Coverage Map 
(page 115). 

6.6.2.11 Select Map 

• On the Map toolbar, click . 

 

 Enter the Caption of the map that will be displayed in the active tab. 
 In the list of Available Maps, choose the map to be displayed. 

Note: For more details on available map types, see section Map 
Types (page 106). 

6.6.2.12 Google Earth 
To open the Google Earth application: 

• On the Map toolbar, click . 

Note: Google Earth must be previously installed on the PC. For 
more details on Google Earth, visit Google's official website: 
http://www.google.co.uk/earth 

 

6.7 Job Ticketing 
TRBOnet Dispatch Console provides the Job Ticketing feature – the integrated 
ticketing system that allows dispatchers to create, assign, and track job tickets 
through the radio network. 

Note: Before using the feature, make sure that your TRBOnet 
Dispatch Software license includes Job Ticketing. 

• Click the Job Ticketing tab, and manage Job Tickets in the Job Ticketing 
pane. 

http://www.google.co.uk/earth
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6.7.1 Adding a Status for Job Ticketing 
• In the Job Ticketing pane, click the Statuses tab to see the statuses available 

for job tickets. 

 

• Click the Add button to add a Job Ticket status. 

 

 Name 
Specify a Job Ticket status name to display in the system. 

Note: The Name value must match the value of the 
corresponding Action/Response field configured for a radio 
in MOTOTRBO CPS, Job Tickets. 

 Description 
Add a description for the job ticket status. 

 Status 
From the drop-down list, select the Job Ticket status. 
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6.7.2 Adding Custom Fields for Job Ticketing 
In addition to the default fields (Priority, Deadline, etc.), you can add custom fields 
with pre-defined values to be used in tickets/ticket templates. 

• In the Job Ticketing pane, click the Custom Fields tab to see the list of 
custom fields available for job tickets. 

 

• Click the Add button. 

 

In the Job Ticket Custom Field dialog box, specify the following: 
 Name 

Enter a name for the field. 
 Values 

Click the Add link and enter a pre-defined value for the field. 

6.7.3 Creating a Job Ticket 
• In the Job Ticketing pane, click the Job Ticketing tab to see the list of 

created job tickets. 
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• Click the Add button to create a job ticket. 

Note: To create a ticket from a template, click the arrow on the 
right of the Add button to select from the available ticket 
templates. For how to create templates, see section 6.7.4. 

 

In the Job Ticket dialog box, specify the following parameters: 
 Ticket ID 

This value will be set automatically once the ticket has been created. 
 Priority 

From the drop-down list, select the task priority. 
 Deadline 

Select this option and in the box to the right, enter a due date and time for 
the task. 

 Predefined Texts 
From the drop-down list, select a predefined text for the Job Ticket. 

• Click the  button to edit the predefined text. 
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• Click the Add link and type the text in the line that appears. 
In addition, you can also add to this text: 
 Priority 

Click this link to add the ticket priority to the text. 
 Due date 

Click this link to add the ticket due date to the text. 
 Due time 

Click this link to add the ticket due time to the text. 
 Text 

Enter the text message in this box. 
 Notify on status changes 

Select this option to send notifications to Dispatchers, Email and/or SMS 
groups when a Job Ticket status changes. 

 Notify if ticket is not accepted by 
Select this option to send notifications to dispatchers, Email and/or SMS 
groups if a radio does not accept the Job Ticket at the time specified in the 
box below. 

 Notification List 
Click this link and choose the recipients of selected notifications. 

 

You can notify dispatchers with the help of notifications in the Dispatch 
Console (on the Dispatchers tab, check Notify Dispatchers, and select 
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dispatchers), Email groups by sending Emails to dedicated Email groups 
(click the Email tab, check Notify by Email, and select Email groups) and 
phone users by sending SMS to dedicated SMS groups (clcik the SMS tab, 
check Notify by SMS, and select SMS groups). 

 Comment 
Add a comment for the ticket. 

6.7.4 Creating a Ticket Template 
You can create ticket templates in advance to then use them when creating tickets. 

 

• Click the Templates tab to see the list of templates available for job tickets. 
• Click the Add button to create a ticket template. 
• In the Job Ticket Template dialog box, fill in the desired fields, and click OK. 

Note: For information about the fields, see section 6.7.3, Creating 
a Job Ticket. 

6.7.5 Selecting Ticket Status Color 
You can also color tickets based on their statuses. 

• Click the Job Ticketing tab, and on the toolbar, click the Status Colors 
button. 

 

In the Select Job Status Color dialog box that opens: 
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• Click the arrow on the right, and from the drop-down list, pick the color for the 
selected status. 

6.7.6 Assigning a Job Ticket 
• Select a job ticket in the list, and click the Assign button. 

Or, right-click the job ticket and choose Assign. 

 

In the Assign Job Ticket dialog box that appears: 

 

• In the list, select a radio, radio group or logical group to which to assign the 
job ticket. 

• Click OK to assign the task to selected radio(s). 
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As a result, the selected radio(s) will receive the job ticket. 

6.7.7 Viewing Job Ticketing Statistics 
• On the main menu, select Tools, then click Job Ticketing Monitoring to see 

the Job Ticketing statistic diagram: 

 

For more details on the statistics, see Job Ticketing Monitoring. 

6.7.8 Viewing Job Ticketing Reports 
• To view a job ticketing report, go to Reports (1), and select Common Reports 

(2) – Job Ticketing (3). 
• On the Common reports pane, click the Query parameters tab, and specify 

the appropriate parameters and then click Generate Report. 
• Click the Job Ticketing tab to see the generated report. 
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6.8 Guard Tour / Route Management 
The Guard Tour / Route Management feature allows the user to create routes and 
assign them to selected radio subscribers or dispatchers. 

 

• Click the Route Management tab (1). 

6.8.1 Creating a Route 
• In the Route Management pane on the right, select the Management tab, 

then click the Create button (2) to create a new route. 

 

• Name 
Specify a name for the route to display in the route list. 

• Description 
Add a description for the route. 
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• Rule 
Select the type of the rule from the drop-down-list: 
 All checkpoints, strict order, strict schedule 

Checkpoints are to be attended in the specified order, each within a 
specified time range. 

 All checkpoints, strict order, loose schedule 
Checkpoints are to be attended in the specified order. The time for 
attending each checkpoint is not limited. 

 All checkpoints, loose order, loose schedule 
Checkpoints can be attended in any order, each at any time. 

• Click the Start/Stop Rules tab. 

Start Route 
Specify the rules to start the route. 

 Manually by dispatcher 
This option is enabled by default and cannot be edited. This option enables 
the dispatcher to start the route by clicking the Start button in the Route 
Management tab or in the Active Routes pane. 

 Automatically by receiving Text Message from a radio 
The route starts when the radio sends a specific text message to TRBOnet 
Server. If you select this option, then specify the text message the radio will 
send in the Message box. 

 Automatically by receiving Telemetry Command from a radio 
The route starts when the user presses a preconfigured button on the radio 
and TRBOnet Server receives a telemetry command from the user's radio. If 
you select this option, specify the VIO contact, and from the Command 
drop-down list, select the signal level at which the user's radio should send 
the telemetry command. 

 Automatically by receiving DTMF command from a radio 
The route starts when the user sends a specific DTMF command to TRBOnet 
Server, for instance, #11#. If you select this option, specify a DTMF 
combination without the # characters in the Command box. 

 Automatically by receiving Status from a radio 
The route starts when the user sends a specific Status to TRBOnet Server, 
for instance, 1. If you select this option, specify the Status. 

 Wait for confirmation from a radio 
Select this option to start the route after the TRBOnet Server receives a 
confirmation from the radio.  In this case, the route is assigned to the radio 
or user and paused.  The route will be resumed after a confirmation is 
received. 
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Pause Route 
Specify the rules to pause the route. 

Resume Route 
Specify the rules to resume the route. 

Finish Route 
Specify the rules to finish or stop the route. 

 Automatically when all points have been attended 
Select this option so that the route is finished automatically when all 
checkpoints have been attended. 

 Limit route processing time 
Select this option, and specify the maximum allowed time in the Max. Time 
box. If the time is exceeded, the route will stop automatically. All 
unattended checkpoints automatically change their statuses from 'Waiting' 
to 'Not Attended'. 

• In the Route dialog box, click the Route Points tab. 

 

 Click the GPS Points link (1) to add points to the selected map: 

 

 Select the map. For more details on map types, see section Map Types 
(page 106). 

 Click the Create link or double-click a selected point on the map to create a 
new route point: 
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 Name 
Specify a name for new point to display on the map. 

 Location 
This box displays the current GPS coordinates of new point. 

 Radius 
Specify the radius within which to consider the point as attended. 

 Intermediate way point (not served) 
Select this option to exclude the point from being used as a checkpoint. 

 Time 
Specify the time the point is to be attended at. 

 Time delta 
Specify the time accuracy to attend the point. 

 Click OK to add the new point. 
 Click the Beacons link (2) to add a beacon as a checkpoint. 

Note: To enable the Indoor feature, make sure your license 
includes Indoor Positioning (see section 5.1 License 
Information on page 13) and Indoor Service is selected in 
the list of available services (see section 5.9.2 Services on 
page 31). 

 

 Click the Create link and then click a beacon in the list. 
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 Click the Map Objects link to add a map object as a checkpoint. 

 

 Click the Create link and then click an object in the list. 

 

• In the Route dialog box, click the Checkpoint Statuses tab. 

 

• Set status to Attended 
Select this option so that TRBOnet Server will change the checkpoint status to 
'Attended' based on the information from the radio. 
 When the radio enters the point area 

Choose this option so that the radio detects the closest beacon and sends 
location data to TRBOnet Server. The respective checkpoint changes its 
status to 'Attended ' automatically. 
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 By condition when the radio is in the point area 
If this option is chosen, the radio sends a preconfigured command to 
TRBOnet Server. The last detected checkpoint changes its status to 
'Attended ' by this command. Configure the preferred command(s): 
• Automatically by receiving Text Message from a radio 

Select this option so that the checkpoint is considered to be attended 
after the dispatcher receives a specific text message from the radio. If 
you select this option, then specify the text message the radio will send 
in the Message box. 

• Automatically by receiving Telemetry Command from a radio 
Select this option so that the checkpoint is considered to be attended 
after the dispatcher receives a specific telemetry command from the 
radio. If you select this option, specify the VIO contact, and from the 
Command drop-down list, select the signal level at which the user's 
radio should send the telemetry command. 

• Automatically by receiving DTMF command from a radio 
Select this option so that the checkpoint is considered to be attended 
after the dispatcher receives a specific DTMF command from the radio, 
for instance, #11#. If you select this option, specify a DTMF combination 
without the # characters in the Command box. 

• Automatically by receiving Status from a radio 
Select this option so that the checkpoint is considered to be attended 
after the dispatcher receives a specific Status from the radio. If you select 
this option, specify the Status. 

• Statuses that can be set by dispatcher 
Select this option to allow the Dispatch Control operator to manually change 
the status of checkpoints in the Active Routes panel. 
In the drop-down list, select the checkpoint statuses to be available for the 
operator: Waiting, Attended, Unattended, and Alarm. 

• Set status to Alarm 
Select this option to allow the radio to set an alarm on the attended 
checkpoint. Configure the command(s) that can set the checkpoint status to 
'Alarm'. 
 Automatically by receiving Text Message from a radio 

Select this option to set the point to alarm mode after the dispatcher 
receives a specific text message from the radio. If you select this option, 
then specify the text message the radio will send in the Message box. 

 Automatically by receiving Telemetry Command from a radio 
Select this option to set the point to alarm mode after the dispatcher 
receives a specific telemetry command from the radio. If you select this 
option, specify the VIO contact, and from the Command drop-down list, 
select the signal level at which the user's radio should send the telemetry 
command. 



  

294 TRBOnet PLUS — User Manual 

 Automatically by receiving DTMF command from a radio 
Select this option to set the point to alarm mode after the dispatcher 
receives a specific DTMF command from the radio. If you select this option, 
specify a DTMF combination without the # characters in the Command 
box. 

 Automatically by receiving Emergency from a radio 
Select this option to set the point to alarm mode after the dispatcher 
receives an Emergency from the radio. 
• Emg. Type 

Select the Emergency type from the drop-down list. 
 Automatically by receiving Status from a radio 

Select this option to set the point to alarm mode after the dispatcher 
receives a specific Status from the radio. If you select this option, specify the 
Status. 

• In the Route dialog box, click the Notifications tab to manage notifications to 
a radio. 

 

Note: To enable an option, select the check box. The Text 
Message boxes already include text. If necessary, replace 
the text with your own text, using variables as placeholders 
that will be substituted with actual data. 

 Send a Text Message on route assign 
Select this option to inform a radio holder that the route is assigned to. 

 Send a Text Message on route start 
Select this option to inform a radio holder that the route started. 

 Send a Text Message on route suspend 
Select this option to inform a radio holder that the route is suspended. 
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 Send a Text Message on route resume 
Select this option to inform a radio holder that the route is resumed. 

 Send a Text Message on route finish 
Select this option to inform a radio holder that the route is finished. 

 Send a Text Message when approaching attendance time 
Select this option to inform a radio holder that the next checkpoint is 
expected in the time interval specified in the Time before attendance box. 
This message is only available for routes with the specified attendance time. 

 Send a Text Message after point is attended 
Select this option to confirm attending a checkpoint. 

 Send a Text Message if point is not attended 
Select this option to notify a radio holder if the point was not attended. 

 Send a Text Message if point is in alarm mode 
Select this option to notify radio holder if the point is in alarm mode. 

• In the Route dialog box, click the Logical Groups tab. 

 

 Select a logical group(s) in the list of available groups. 
 Assign Logical Groups to a radio when the route starts 

Select this check box so that when the route is assigned to a radio, the 
selected logical group(s) will automatically be assigned to the radio. 

Note: For more information about logical groups, see section 
6.4.17, Logical Groups (page 225). 

• Click OK to save settings. 
The new route is now added to the route list (1): 
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6.8.2 Starting a Route 

 

• Click the Start button (2) to start the route: 

 

In the Start Route dialog box, specify the following parameters: 
 Name 

Enter a name for the route to be started. This name will be displayed in the 
Active Routes pane. 

 Start Date 
Select a date to start the route on. 

 Route 
From the drop-down list, select the route to start. Click the Create Route 
button to create a new route based on the selected route. Click the Modify 
button to modify selected route parameters. 

 Radio 
From the drop-down list, select the radio to assign the route to. 

 Radio Owner 
From the drop-down list, select the User to assign the route to. 

Note: Select only one of the two (Radio or Radio Owner) to 
prevent an incorrect route. 
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 Dispatcher 
From the drop-down list, select the dispatcher to monitor the route. 

 Click OK to start the route. 
The active route appears (1) in the Active Routes panel. 

 

If a route point is attended in time, it is displayed in green (2) 
If a route point is not attended in time, it is displayed in red (3). 
For more operations with checkpoints, see section 6.5.8.6, Active Routes 
(page 259). 

6.8.3 Tracing Active Route on Map 
• In the Route Management pane, click the Monitoring tab (1). 

 

• In the upper-left pane, select the route (2) to be traced on the map. 
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6.8.4 Stopping a Route 
Depending on the route configuration settings, a route/guard tour can be stopped 
automatically: 

• by a command sent from the radio; 
• when all checkpoints are attended; 
• when the route time is elapsed. 

To manually stop the route: 
• Click the Stop button to stop the route. Once the route is stopped, it will 

disappear from the Active Routes panel. 
After the route is stopped, the checkpoint statuses cannot be modified neither 
automatically, nor manually. 
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6.8.5 Generating Route Reports 
The administrator can generate reports on the finished routes. 

• Click the Reports (1) tab, and in the Reports pane select Common reports > 
List Finished Routes (2): 

 

6.9 Text Messages 
In the Text Messages tab, the dispatcher can review and send text messages to other 
dispatchers, individual radio subscribers and radio groups: 
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1. Radio List 
displays dispatchers and radio subscribers available for text communication. 

Note: Radios must be equipped with a display to receive Text 
Messages. 

2. Text Messages panel 
displays the latest messages transmitted via a radio channel. 

3. New Message panel 
provides you with text sending options. 

4. Calls Panel in compact mode 
allows making voice calls. 

6.9.1 Sending Text Messages 
The dispatcher can send a text message to: 

• Selected Radio 
• Selected Radio Group 
• Selected Logical Group 
• Selected Dispatcher 
• All Online Dispatchers or a group of dispatchers 

The dispatcher can send a text message to selected subscribers from: 
• New Message panel 
• Radio List 

6.9.1.1 New Message panel 
• In the New Message panel, click the ellipsis (…) button. 

 

• In the Select Recipient dialog box, select the radio, radio group or dispatcher 
and click OK. 
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• Type the text message you want to send. 
• Click the Attach File button if you want to attach a file to the message being 

sent. 
• Click the Send button. 

The text message will be displayed in the Text Messages panel. 
The message details highlighted in red indicates that the message recipient is offline 
and the message will be delivered as soon as the recipient gets back online again. 
The message details in grey indicates that the message has been delivered. 

6.9.1.2 Radio List 
• On the Radio List, right-click the radio/radio group/dispatcher you want to 

send a text message to, and choose Send Message. 

 

• In the Send Text Message dialog box that appears, specify the following 
parameters: 

 

 Target 
This box displays the target for the message. 

 In the Text box, type the message text. You can insert a template text from 
the Templates list box. 

 In the Target list, add recipients by selecting radios/radio groups/logical 
groups/dispatchers. 

 Send to offline radios 
Select this option to store the message on the server if a radio is offline, 
and to send it as soon as the radio becomes online. 
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 Click Send. 

6.9.2 Extended Messages 
The Extended Messages service is a special function allowing users to send/receive 
detailed preconfigured templates containing necessary information. 
This service was created especially for clients who need to use more detailed and 
structured messages in their work. If the standard messages are not enough to 
contain all the information you need to send, you may use the Extended Messages 
service. 

6.9.2.1 Send Extended Text Message to a Radio 

 

• Click Text Messages (1) 
• Click the View menu, and select Show Extended Messages Tab (2) 
• In the Text Messages pane, click the Extended tab (3), and New message (4). 

 

• Select the template in the list (1). 
• From the drop-down list (2), select a radio to which to send the template. 
• Click Send to Radio (3) to send the template to a radio. 
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6.10 Voice Recording 
On the Voice Recording tab, the dispatcher can display the list of calls according to 
certain criteria, listen to the calls and save them to file. 

 

• Click the Voice Recording tab (1). 
• In the Voice Recording panel, specify criteria according to which you want to 

display call records, and click Load Data (2). 
• In the right pane, you will see the list of calls according to the criteria you have 

specified. 
• To play back a record, select it in the list and click Playback (3). 

 

6.11 Reports 
The Reports tool provides you with various printing forms with monitored radio 
network activity data. 

• Click the Reports tab (1). 
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6.11.1 Report Types 
TRBOnet Dispatch Console supports the following report types: 

• Queries – reports for a selected time period with information on Voice 
Recording and Messages displayed as an event log (non-printed format). 

• Common Reports – reports for a selected time period with information on 
messages, radio states, user messages and notes, Radio Allocation data, Radio 
disabling data, Job Ticketing and Finished routes in printed format. 

• Indoor reports - reports for a selected time period for movement details for 
Indoor Positioning in printed format. 

• GPS reports - reports for a selected time period with information on radios 
location and speed in printed format. 

• Data export - a report for a selected time period with information on 
extended notes, generated in Excel or XML formats. 

6.11.2 Main Report Parameters 
To generate a report, go to Reports section and select a report type you want to 
generate. 
When generating a report, you might need to specify the parameters listed below: 

• Start Date 
Date from which to start reporting. 

• End Date 
Date on which to finish reporting. 

• Message Type 
Select available message types from the drop-down list (All Messages, Talk 
Sessions, Text Messages, and other message types). 

• Radio System 
In the drop-down list, select the system(s) to include in a report. 

• Radio 
In the drop-down list, select the radio(s) to include in a report. 
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• Radio Group 
In the drop-down list, select the radio group(s) to include in a report. 

• Logical Group 
In the drop-down list, select the logical group(s) to include in a report. 

• Dispatcher 
In the drop-down list, select the dispatcher(s) to include in a report. 

• Radio ID 
Enter a Radio ID or multiple Radio IDs. 

• Find Text 
Enter the text to filter by. 

6.12 Radio Allocation 
The radio can be assigned to a selected employee registered in the system. 
All available radios are disabled and an employee will need to type in username and 
password to take and enable selected radio. When an employee returns allocated 
radio it gets disabled again. 

• Click the Radio Allocation tab (1) to assign radios to users: 

 

• Select the radio in the list and click the Take/Return Radio button (2): 

 

 Radio 
This box displays the selected radio. 

 User 
From the drop-down list, select the user to allocate the radio to. 
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 Password 
Enter the password for the selected user. 

Note: For more details on user access to Allocation Console, see 
section 6.4.16 Users (page 221). 

• Click the Take Radio button to assign the radio to the selected user. 
The administrator can generate reports on the allocated radios. 

• Click the Reports (1) tab, and in the Reports pane select Common reports > 
Radio Allocation (2): 

 

6.13 Beacons 
The TRBOnet Dispatch Console provides the Indoor Positioning feature to monitor 
the location of radios inside a building where GPS signals are not present. The 
feature requires additional hardware (beacons located around the building and 
Bluetooth modules/option boards installed in radios). A radio unit will be displayed 
on the indoor floor plan at the beacon location as soon as the radio enters the 
beacon's coverage area.  A beacon icon on the map will provide a count of the 
number of radios that are currently in this beacon's coverage area (for example, 
Room 1(3) - there are 3 radios in Room 1). 

Note: To enable the Indoor Location Tracking feature, your license 
must include Indoor Positioning (see section 5.1, License 
Information) and Indoor Service is selected in the list of available 
services (see section 5.9.2, Services). 

To enable the Indoor Location Tracking feature, your license must include Indoor 
Positioning (see License information page) and Indoor Service is selected in the list 
of available services (see Services). 
Click the Location Tracking tab (1), then click Map (2) and choose Open New Map 
in Tab: 
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 Map Type 
From the drop-down list, select 'Beacon 2D' to enable 2D floor plan, or 
'Beacon 3D' to enable 3D floor plan (3). 

 Click Add (4), and browse for the required map on your PC. 
 Click OK (5) to add the map. 

Add a beacon to the selected floor plan 

• Click the Set Location button (1) and then click on the map to point the 
location of a physical beacon on the floor. 

• In the dialog box that appears (2), specify the beacon properties. 

 

 Type 
Select the beacon type from the drop-down list. 

 Name 
Specify a name for the beacon. 
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 Major ID and Minor ID 
Enter the beacon’s major and minor ID exactly as specified on the iBeacon 
device. 

 Description 
Add a description for the beacon. 

Edit parameters of a beacon 

• Select a beacon in the Objects panel and double-click to edit its parameters. 

 

• In the Beacon properties dialog box that appears, edit the desired properties. 
 

Note: For more details on K-Term beacons, see the following 
article at 
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;Ite
mID=36. 

http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=36
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=36
http://kb.trbonet.com/public.pl?Action=PublicFAQZoom;ItemID=36
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7 TRBOnet Web Console 
TRBOnet Web Console is a special online application. It is an extension for TRBOnet 
Dispatch Software which allows dispatchers to get access to the system via a Web 
browser. The Web Console is the best solution for carriers, operators and systems 
with a huge number of users. 
This application allows you to monitor your system without any special software 
installed on your computer. 

7.1 Installing Web Console 
• Click Start>Control Panel>Programs and Features. 
• Click the Turn Windows features on or off link. 

 

• Go to Internet Information Services>World Wide Web 
Services>Application Development Features, and make sure all of them are 
selected: 

 

• Also, make sure that Common HTTP Features>Static Content is selected. 



  

310 TRBOnet PLUS — User Manual 

 

• Restart your PC. 
• Click Start>All Programs>Accessories>Command Prompt. 

 

• Go to This PC>Local Disk (C: )> Windows > Microsoft.NET > Framework > 
v4.0.30319/aspnet_regiis. 

 

• Drag the aspnet_regiis file into the Command Prompt then press the space 
bar and add the -i key. Then press the Enter key: 
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• Go to Control Panel > Administrative Tools. 
• Double-click the Internet Information Services (IIS) Manager shortcut and 

double-click ISAPI and CGI Restrictions. 

 

• In the Restriction column, set Allowed in all lines. 

 

• Copy the Web Site archive WebConsole to Computer > Local Disc (C: ) 
>inetpub to create a folder for the Web Console. 

• Go to Application Pools (1). Double-click DefaultAppPool (2) and check the 
.Net CLR Version (3): 
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• Click Sites (1), right-click Default Web Site (2) and choose View Applications 
(3): 

 

• Click the Add Application link. 

 

• Specify the Alias and Physical path for the application: 

 

• Browse for the folder with unarchived Web Console. 
• Click OK. 
• Select Application Pools (1) and click the Set Application Pool Defaults link 

(2): 
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• Set Enable 32-Bit Applications to True (3). 
The Web Console will be added as an application to under the Default Web 
Site: 

 

Note: Make sure your account has sysadmin privileges and the 
database connection is successful (see section 5.2, TRBOnet 
Server Database on page 15). 

To open Web Console, right-click your application, choose Manage Application > 
Browse. 

 

TRBOnet Web Console is now ready for operation: 
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• Enter the Login and Password, and click Connect. 

7.2 Configuring Web Console 
• If TRBOnet Dispatch Console is not installed on your PC, select the application 

and click Application Settings: 

 

• Specify the IP address and Port of the PC with TRBOnet Dispatch Console 
installed: 

 

• Right click TRBOnet Web Console and choose Edit Permissions. 
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• Click the Security tab and then click the Edit button to edit permissions: 

 

• Select User in the Users list. In the Allow column, select Write: 

 

• Click Apply. 
• Click OK. 



  

316 TRBOnet PLUS — User Manual 

7.3 Using Web Console 
When launching Web Console for the first time, you will see the following page: 

 

• Enter the Login and Password, and click Connect. 
Once you have connected to TRBOnet Server, you will see a window like this. 

 

7.3.1 Radio List 
The Radio List pane is located on the left and contains the list of radios. From this 
pane, you can perform the following tasks. 

Click the  button to see the selected radio in the center of the map. 

Click the  button to button to display a route traveled by the selected radio on 
the map. 
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Specify the From and To date and time. Select the Optimize Route option to group 
all points in a 100 meter radius. 

Click the  button to request a location of the selected radio. 

 

Click the  button to display the selected radio properties. 

 

7.3.2 Map 
7.3.2.1 Map Layers 

• Click the small plus button on the right of the Map pane. 
• Choose the map layer to display in the Map pane. 
• In the Overlays list, select whether to display Regions, Map Objects and Radios 

on the map. Just select/deselect the corresponding check box. 
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7.3.2.2 Zoom In/Out 
• Click the large plus button on the left of the Map pane to zoom in the map. 
• Click the large minus button on the left of the Map pane to zoom out the map. 

Or: 
• Use the mouse wheel to zoom in/out the map. 

7.3.2.3 Radio Coordinates and Address 
• In the Map pane, click the radio you want to inspect. 

As a result, a window will appear displaying the coordinates and address of the 
inspected radio. 

 

7.3.2.4 Filter Radios 
You can filter the display of radios on the map. To do this, use the colored car 
buttons at the top of the Map pane. 

• Click  to remove radios that are online and have a detected beacon 
position from the map view. Click this button again to bring them back to be 
displayed. 
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• Click  to remove radios that are online and have a detected GPS position 
from the map view. Click this button again to bring them back to be displayed. 

• Click  to remove radios that are online and have no detected GPS position 
from the map view. Click this button again to bring them back to be displayed. 

• Click  to remove radios that are offline and have no detected GPS position 
from the map view. Click this button again to bring them back to be displayed. 

7.3.2.5 Search by address 
• In the Find Address box, enter the address you want to locate on the map. 
• Click the lens button on the right. 
• In the Found addresses window, click the address to locate it on the map. 

 

7.3.3 Text Messages 
With TRBOnet Web Console, you can send text messages to radios/radio 
groups/dispatchers. 

• Click the Messages tab at the top of the window. 
• Click the Send Text button. 
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In the Send Text Message window that appears: 
 Enter the text of the message. 
 Select the radios/radio groups/dispatchers to send the message to. 
 Select the Send to Offline option to send the message to offline radios. 

7.3.4 Job Ticketing 
With TRBOnet Web Console, you can create, assign, and track job tickets through 
the radio network. 

• Click the Job Ticketing tab at the top of the window. 

 

In the upper pane, you see the list of created job tickets. In the lower pane, there are 
assigned job tickets. 

7.3.4.1 Add a Job Ticket 
• Click the Add button. 
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• Ticket ID 
This value will be set automatically once the ticket has been created. 

• Text 
Enter the text message in this box. 

• Enable Deadline 
Select this option and in the End Time box, specify a due date and time for 
the task. 

• Priority 
From the drop-down list, select the task priority level. 

• Comment 
Enter a comment for the ticket. 

• Click OK. 
Once you have added a ticket, it will appear in the list of tickets in the upper pane. 

7.3.4.2 Assign a Job Ticket 
Select the job ticket in the upper pane, and click the Assign button. 

 

• In the list, select a radio(s), radio or logical group to which to assign the job 
ticket. 

• Click OK to assign the task to selected radio(s). 
As a result, the selected radio will receive the job ticket. The assigned job ticket 
will appear in the upper pane. 
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7.3.5 Reports 
• Click the Reports tab at the top of the window. 

 

• In the right pane, select report parameters and click Generate Report. 
Once the report is generated, you will see it in a separate tab of your Web 
browser. 

 

You can print the report, save it as a file, and so forth. 
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Appendix A: Backing up and Restoring Database and Audio 
Recordings 
Configure Backup 

TRBOnet Dispatch Software has an automatic mechanism for database and audio 
recordings backup. Initially, it defaults to two paths to store database and audio 
recordings: 
%ProgramData%\Neocom Software\TRBOnet.Plus\Backups and 
%ProgramData%\Neocom Software\TRBOnet.Plus\Audio. 
For your convenience, the default paths can be changed: 

• Open TRBOnet Server and stop the TRBOnet Server service. 

 

• To customize these backup folders, on the Configuration pane, select 
Database, then select the Specify the path for database archives and Use 
custom folder for audio files options. Next, enter the new (custom) folder for 
the backup database (for example, C:\TRBOnet\Backup\DB) and custom 
folder for the audio files (for example, C:\TRBOnet\Backup\Audio). The 
database and audio backups will be stored in the selected directories. 
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• Save your changes and restart the service. 

Back up Database and Audio Recordings 
To back up the database and audio recordings, do the following: 

• In the Dispatch Console go to Administration section and select Database in 
the Navigation tree. 

• Click the Backup button: 

 

• Specify the backup details: 

 

 Backup audio 
Select to back up audio recordings. 

 Remove 
Select to remove audio files and data from the database. 

 Remove all data older than date 
Specify the date to remove data older than that specified date. 

 Audio Files 
Select to remove audio files. 

 Data 
Select to remove data. 

 Click OK to run the backup procedure. 
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The Backup progress bar will be displayed in the lower-right corner. 
1. In a while, a ZIP archive will be created in two possible directories: 

• The default directory is %ProgramData%\Neocom 
Software\TRBOnet.Plus\Audio for Audio files and 
%ProgramData%\Neocom Software\TRBOnet.Plus\Backups for 
backup files. 

• The custom directory is specified in TRBOnet Server settings. 
2. The archive includes the database backup file and audio recordings files. The 

archive name contains the date of backup. New backup files will be placed in 
the same directory. 

 

Restore Database 
To restore the database 

• Open TRBOnet Server and stop the TRBOnet Server service. 
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• Unzip the backup archive and open the folder: 

 

 
• Run SQL Server Management Studio Express with sufficient rights to 

manage databases. 

 

• Select Database in the navigation tree (for example, TRBOnet): 
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• Right-click the selected database, and go to Tasks/Restore/Database: 

 

Select Database backup properties: 
• In the Destination group, type in or select Database name to back up to from 

the drop-down list (for example, TRBOnet). 
• In the Source group, click Device. 
• Click the ellipsis (…) button to select the directory with database backup: 
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• Click Add and select the directory to which you unarchived the database 
backup (for example, C:\TRBOnet\Backup\DB). 

 

Note: Select the *.bak file type. 

• Click OK to add the directory. 

 

• Click OK. 
The database is added to the list of restored databases. 

 

• Select the check box and click OK to restore the database. 
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• In the Configuration pane, select Database. 
• From the Database drop-down list, select the restored database. 

 

• Click Test Connection to check the connection to the database. 
• Click Upgrade Database to upgrade the database if the current database was 

restored from the database version lower than current. 
• Click the Save changes and restart service link. 

 

Restore Audio Recordings 
To restore the audio file: 

• Launch TRBOnet Server and stop the TRBOnet Server service. 
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• Go to Database section in the navigation tree and specify custom directory for 
audio files (C:\TRBOnet.Plus\Backup\Audio). 

 

• Go to the directory you specified to store backup audio files. 
• Unzip the backup archive: 
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• Copy unarchived audio files to the folder specified in TRBOnet Server settings 
(for example, C:\ProgramData\TRBOnet Dispatch Software \Audio): 

 

• Click the Save changes and restart service link. 

 

Thus, the audio files will be restored. 

Schedule Backups 
To set a scheduled backup for the database and audio recordings, do the following: 

• In the Dispatch Console, go to Administration section and select Database in 
the Navigation tree: 

• Click the Schedule button: 
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• In the dialog box that appears, specify the Backup details: 

 

• Enable scheduler 
Check to enable the database backup scheduler. 

• Days of week 
Select the days of the week on which to back up the database. 

• Start time 
Enter the start time for database backup. 

• Backup data 
Check to back up data. 

• Backup audio 
Check to back up audio recording. 

• Remove 
Check to remove audio files and data from the database. 
 Remove all data older than [X] days 

Select the number of days to remove all data. 
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 Audio Files 
Check to remove audio files. 

 Data 
Check to remove data. 

• Click OK to run the backup procedure. 
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Appendix B: SIP Setup for Motorola Phone System 
The native MOTOTRBO phone system is supported in the case of a direct IP 
connection to the repeater. MOTOTRBO Phone system is recommended for IP Site 
Connect mode. 

Note: No extra license per repeater is required for Digital Phone Patch 
from Motorola. 

TRBOnet Software and Repeaters 
TRBOnet Server requires a specific setup for a repeater in the IP Site Connect mode 
as well as for SIP in order to make the phone system work properly. 

Note: MOTOTRBO Phone System is available for repeaters in IP Site 
Connect mode. For a system based on the control stations, use 
TRBOnet Phone System. 

Launch MOTOTRBO CPS and go to Repeater's General Settings page: 

 

The Radio ID of actual repeaters in CPS must differ from the TRBOnet Peer ID. 
TRBOnet Dispatch Console acts as another virtual peer repeater with Peer ID (for 
example, IPSC network consists of 1 master and 3 peers. The repeaters' IDs (Radio 
IDs in CPS codeplugs for repeaters) in this case would be 1, 2, 3, 4. The TRBOnet 
Peer ID must differ from all the repeaters (the master and all peers, otherwise a 
conflict will happen in the network as peers have the same ID). The TRBOnet Radio 
ID is 64250. 

• Open TRBOnet Dispatch Console. Go to Administration (1), Telephony (2), 
Radio calls configuration (3) – Configure (4) and set DTMF Access and 
DTMF Deaccess codes (5) to 0 and #, respectively: 
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Programming Radios 
A special setup is required for radios in MOTOTRBO CPS. 

• Read a subscriber's radio in CPS and go to Phone Systems (1):  

 

• Make sure that Gateway ID (2) is equal to repeater Slot IDs in TRBOnet Server 
as well as to TRBOnet Peer ID in TRBOnet Server. 

• Set DTMF Access Code to 0 and DTMF Deaccess Code to #, respectively (3). 
• Go to Repeater/Channels (1) and specify the phone system you have set up 

(2): 
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